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概要概要

このガイドでは、Red Hat Fuse Tooling の使用方法について説明します。Fuse Tooling は、統合ア
プリケーションの設計、開発、テスト、およびデバッグを実行する際の生産性向上を目的として設
計された開発者ツールを提供します。
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はじめに

Red Hat Fuse Tooling は、Red Hat CodeReady Studio 内で統合アプリケーションを開発するプロセス
を簡素化および合理化する Eclipse ベースの IDE です。Fuse Tooling は、以下で動作するように特別に
設計された一連の開発者ツールを提供します。

Red Hat Fuse

Red Hat JBoss EAP

Apache Camel

Apache CXF

Apache Karaf

Spring Boot

このガイドでは、FuseTooling を使用して以下を行う方法について説明します。

Maven 依存関係を含むアプリケーションのプロジェクトを作成する

エンタープライズ統合パターンを接続および設定してルートを構築する

エンドポイントとルートを参照する

実行中のルートにメッセージをドラッグアンドドロップする

JMX を介してランタイムプロセスを参照および可視化する

ローカルで実行されている Camel コンテキストとルートをデバッグする

以下の方法でアプリケーションをテストする

Apache Camel ルートで JUnit テストケースを作成および使用する

JMX を使用して実行中のコンポーネントを分析する

Apache Camel ルートを介してメッセージをトレースする

アプリケーションをデプロイする

新規ユーザーの場合、Tooling Tutorials は、サンプル Camel アプリケーションを作成、デバッグ、テス
ト、およびデプロイする方法に関する段階的な手順を提供します。
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第1章 新しい FUSE INTEGRATION プロジェクトの作成

概要

新しい Fuse Integration プロジェクトの作成には、次の主な手順が含まれます。

プロジェクト名とワークスペースの指定

プロジェクトデプロイメント環境の設定

プロジェクトテンプレートの選択

必要な場合: Maven 依存関係エラーの解決

ツールは、プロジェクトを設定した後、必要なすべての Maven 依存関係をダウンロードし、プロジェ
クトの実行と公開に必要な POM ファイルを作成します。

注記注記

CodeReady Studio で初めて Fuse プロジェクトをビルドする場合、リモート Maven リ
ポジトリーから依存関係をダウンロードするため、ウィザードがプロジェクトの生成を
完了するまで数分かかることがあります。

作業を開始する前に

新しい Fuse Integration プロジェクトを作成する前に、次の情報が必要です。

ターゲットランタイム環境: OpenShift 上の Fuse またはスタンドアロンの Fuse (Spring Boot、
Karaf 上の Fuse、または EAP 上の Fuse)

Camel バージョン (ツールでデフォルト以外が使用される場合)

プロジェクト名とワークスペースの指定

新しい Fuse Integration プロジェクトを作成するには、次の手順を実行します。

1. New → Project → Red Hat Fuse → Fuse Integration Project を選択して、New Fuse
Integration Project ウィザードを開きます。
ウィザードが開き、Location ペインの Use default workspace location オプションが選択され
ています。

Red Hat Fuse 7.7 Tooling ユーザーガイドユーザーガイド
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2. Project Name に、新規プロジェクトの名前を入力します (例: MySampleProject)。

3. プロジェクトのデータを保存するワークスペースの場所を指定します。

デフォルトのワークスペースを使用するには、Use default workspace location オプショ
ンを有効のままにします。

別の場所を使用するには、Use default workspace location オプションをオフにし、Path
フィールドで場所を指定します。

 をクリックし、簡単に別のワークスペースを検索して選択します。

4. Next をクリックして Select a Target Environment ページを開きます。

プロジェクトデプロイメント環境の設定

新規プロジェクトを作成する際に、プロジェクトのターゲットデプロイメント環境を指定して、プロ
ジェクトが実行時に必要なリソースを確保します。デプロイメントプラットフォームと Camel バー
ジョンを選択する必要があります。オプションで、ランタイム設定を指定できます。

Select a Target Environment ページを開いた状態で、次の操作を行います。

1. プロジェクトを、Kubernetes/OpenShift と Standalone のどちらのプラットフォーム上にデ
プロイするか選択します。
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デプロイメントプラットフォームに Kubernetes/OpenShift を選択すると、Sprint Boot ラン
タイムが自動的に選択されます。その場合、ステップ 3 に進みます。

2. デプロイメントプラットフォームに Standalone を選択した場合、以下を実行します。

a. ターゲットランタイム環境を選択します。

Spring Boot

Karaf/Karaf 上の上の Fuse

Wildfly/EAP 上の上の Fuse

b. Karaf および EAP スタンドアロンランタイム環境の場合、ランタイム設定として次のいず
れかのオプションを選択します。

None selected オプションを選択します (後でランタイム設定を定義できます)。

ドロップダウンメニューから既存のランタイム設定を選択します。

「新しいターゲットランタイムの作成 (オプション)」 の説明に従って、新規ランタイ
ム設定を作成します。

3. Select the Camel version for your new project ペインで、ランタイムに関連付けられているデ
フォルトの Camel バージョンを選択するか、次の方法でデフォルトを変更します。

ドロップダウンリストから Camel バージョンを選択します。Fuse Tooling は、リストされ
ている製品化バージョンをサポートしています。

Red Hat Fuse 7.7 Tooling ユーザーガイドユーザーガイド
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製品化されていない (サポートされていない) バージョンを試す場合は、別の Camel バー
ジョンを入力します。
Verify ボタンをクリックすると、ツールが指定したバージョンにアクセスできるか確認で
きます。そうでない場合は、次の例のような通知が Select a Target Runtime ページの
ヘッダーに表示されます。

注記注記

プロジェクトを作成、設定、および保存した後、Camel のバージョンを変更
できます。12章Camel バージョンの変更を参照してください。

4. 新しい Fuse Integration プロジェクトのベースとなるランタイム環境と Camel バージョンを選
択したら、Next をクリックしてウィザードの Advanced Project Setup ページを開き、「プロ
ジェクトテンプレートの選択」 の手順に従います。

新しいターゲットランタイムの作成 (オプション)

Karaf および EAP スタンドアロンランタイム環境の場合、オプションで、New Fuse Integration
Project ウィザードから新しいランタイム設定を作成できます。

1. ウィザードの Select a Target Runtime ページで、New をクリックして New server runtime
environment ページを開きます。
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2. Red Hat JBoss Middleware フォルダーを展開し、Red Hat Fuse のランタイム環境を選択しま
す。
Create a new local server オプションをオフのままにします。プロジェクトを公開する準備が
できたら、後でローカルサーバーを作成できます (「サーバーの追加」 を参照)。

注記注記

Create a new local server オプションをオンにすると、New Fuse Integration
Project ウィザードに Fuse サーバーランタイムを定義および設定するための追
加手順の説明が表示されます (「サーバーの追加」 の説明を参照)。次に、プロ
ジェクトをビルドするときに、Fuse Integration パースペクティブの Servers
ビューにもサーバーランタイムが追加されます。

3. Next をクリックして、サーバーの New Server Runtime Environment ページを開きます。
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4. サーバーランタイムの Name、Home Directory、Execution Environment を指定します。

Name — デフォルトを使用するか、ランタイム環境の新しい名前を入力します。

Home Directory — Browse ボタンをクリックして、サーバーランタイムのインストール
ディレクトリーを見つけて選択します。

注記注記

サーバーがマシンにインストールされていない場合は、ここで Download
and install runtime リンクをクリックし、サイトのダウンロード手順に従っ
てサーバーをインストールできます。サイトによっては、ダウンロードプロ
セスを続行する前に、有効なクレデンシャルの提供が必要なこともありま
す。

Runtime JRE: Execution Environment — デフォルトを使用するか、ドロップダウンリスト
から別の JavaSE バージョンを選択します。
目的のバージョンがリストに表示されない場合は、Environments ボタンをクリックして、
そのリストからバージョンを選択します。選択した JRE バージョンがマシンにインストー
ルされている必要があります。

注記注記

Fuse 7.x には JRE バージョン 1.8 が必要です。
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Runtime JRE: Alternate JRE - プロジェクトで異なるバージョンの Java が必要な場合は、
このオプションを使用できます。

5. Finish をクリックして、New Fuse Integration Project ウィザードの Select a Target Runtme
ページに戻ります。
新しく設定されたターゲットランタイムが Target Runtime ペインのドロップダウンメニュー
に表示され、ランタイムでサポートされている Camel バージョンが Camel Version ペインに
グレー表示されます。

Fuse Integration プロジェクトを作成した後は、Camel のバージョンを変更できます。12
章Camel バージョンの変更を参照してください。

6. Next をクリックして、「プロジェクトテンプレートの選択」 で説明されているようにプロ
ジェクトのテンプレートを指定します。

プロジェクトテンプレートの選択

Advanced Project Setup ページには、新しいプロジェクトの開始点として使用できるテンプレートの
リストが表示されます。テンプレートは一般的なユースケースに基づいており、サンプルコードとデー
タが提供されているため、すぐに使い始めることができます。使用可能なテンプレートのリストは、前
のページで選択したランタイム環境によって異なります。テンプレートを選択すると、右側のペインに
その説明が表示されます。

注記注記

要件を満たすテンプレートが表示されない場合は、Where can I find more examples to
use as templates? をクリックすると情報ダイアログボックスが開き、さらに多くの例を
含む URL リストが表示されます。

これらの例の 1 つを使用するには、以下を実行します。

1. Cancel を選択して、New Fuse Integration Project ウィザードを終了します。

2. リストされた URL の 1 つからリポジトリーのクローンを作成します。

3. 13章既存 Maven プロジェクトのインポート で説明されているとおり、サンプル
プロジェクトを CodeReady Studio にインポートします。
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Fuse on OpenShift には、Spring XML 設定ファイルを使用して Spring Boot で Camel ルート
を設定する方法を示すテンプレートが 1 つあります。このテンプレートは Fuse Integration プロ
ジェクトを作成します。また、2.18.1.redhat-000012 より新しい Camel バージョンが必要で
す。
このテンプレートは、OpenShift サーバーで実行されるプロジェクトを作成し、Spring DSL の
みサポートします。このテンプレートの使用の詳細については、7章Fuse on OpenShift の使用
を参照してください。

Wildfly または Fuse on EAP の場合、こんにちはと言うために Bean サービスを呼び出すサン
プル Camel ルートを提供するテンプレートが 1 つあります。このテンプレートは、Red Hat
EAP サーバーで実行されるプロジェクトを作成し、Spring DSL のみサポートします。
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Karaf または Fuse on Karaf の場合、テンプレートを選択できます。サポートされている 3 つ
のドメイン固有言語 (DSL) のいずれかに基づいてスケルトン Camel コンテキストのルーティン
グファイルを作成する空のプロジェクトを作成するか、事前定義されたテンプレート (それぞれ
一般的なユースケースに基づく) を使用できます。個々のテンプレートがすべての DSL オプ
ションをサポートしているとは限りません。

注記注記

Java DSL の場合、ツールはツールの Java エディターで編集することができる 
CamelRoute.java ファイルを生成しますが、グラフィカルダイアグラム表現を
生成しません。

Content Based Router — 特定の場所からファイルを読み取り、メッセージの内容に応じて
異なる出力フォルダーにルーティングするサンプル Camel ルートを提供します。
このテンプレートは、Red Hat Fuse サーバーで実行されるプロジェクトを作成し、3 つの
DSL をすべてサポートします。

CXF code first — CXF Web サービス呼び出しによって開始されるサンプル Camel ルートを
提供します。
このテンプレートは、Red Hat Fuse サーバーで実行されるプロジェクトを作成し、Spring
および Java DSL のみサポートします。
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1. リストからテンプレートを選択します。

2. Finish をクリックします。
ツールはプロジェクトの構築を開始し、それを Project Explorer ビューに追加しま
す。

Fuse Integration パースペクティブがまだ開いていない場合、ツールは今すぐそれに切
り替えるかどうかを尋ねます。

3. Yes をクリックして、Fuse Integration パースペクティブで新しいプロジェクトを開き
ます。
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プロジェクトが Project Explorer ビューに表示されます。デフォルトでは、プロジェ
クトには Apache Camel コンテキスト (XML) ファイルが含まれています。

4. キャンバスの下部にある Source タブをクリックして、生成された Camel コンテキス
トファイルを表示します。

注記注記

プロジェクトに別の新しい Camel コンテキストファイルを追加する場合は、11章新規
Camel XML ファイルの作成 を参照してください。

CXF を使用するプロジェクトをビルドする場合、Java ファイルでビルドプロセスが自動
的に実行されて WSDL ファイルが生成されるようにできます。そのためには、プロジェ
クトの .pom ファイルで java2ws Maven プラグインを設定します。Apache CXF
Development Guide の Maven Tooling Reference、java2ws を参照してください。

MAVEN 依存関係エラーの解決

新しい Fuse Integration プロジェクトを作成した後、Maven 依存関係エラーが発生することがありま
す。
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他の場合でも発生する可能性はありますが、通常は、プロセスが完了する前にプロジェクトのビルドを
キャンセルした場合に発生します。この方法でプロセスを中断すると、プロジェクトのすべての依存関
係が Maven リポジトリーからダウンロードできなくなることがよくあります。これには時間がかかる
場合があります。

多くの場合、これらの依存関係エラーは、Maven 依存関係を次のように更新することで解決できます。

1. Project Explorer ビューで、ルートプロジェクトを右クリックしてコンテキストメニューを開
きます。

2. Maven → Update Project を選択します。

3. Update Maven Project ウィザードで、以下を実行します。

ウィザードのリストに複数のプロジェクトが表示されている場合は、更新するプロジェク
トを選択します。

Force Update of Snapshots/Releases オプションをクリックして有効にします。

4. OK をクリックします。
欠落している依存関係が Maven リポジトリーからダウンロードされる際に、ワークベンチの右
下隅に進行状況を示すバーが表示されます。
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第2章 ルートエディターを使用したルーティングコンテキストの編
集

The following sections describe how to edit a routing context.

2.1. ルートへのパターンの追加

ルートは、接続されたパターンのシーケンスで設定されます。これは、Route コンテナーノード内の
キャンバスに配置されると ノードノード と呼ばれます。完全なルートは通常、開始エンドポイント、一連の
処理ノード、および 1 つ以上の宛先エンドポイントで設定されます。

キャンバス上のルートコンテナーにパターンを追加すると、パターンはノードのタイプを示す色になり
ます。

青: コンテキストファイルのルート要素に対応するルートコンテナー、および when やロジック
を完了する他の EIP が含まれる otherwise EIP 等の他のコンテナーノード

緑: ルートに入力するデータを入力するコンシューマーエンドポイント

オレンジ: データ転送ルートのフローをルーティング、変換、処理、または制御する EIP

紫: ルートを出るデータを出力するプロデューサーエンドポイント

手順

ルートにパターンを追加するには、以下を実行します。

1. Palette で、ルートに追加するパターンを見つけます。

2. 以下の方法のいずれかを使用します。

Palette でパターンをクリックしてから、キャンバスでルートコンテナーをクリックしま
す。

パターンをターゲット Route コンテナーにドラッグし、ドロップする。
または、発信接続がない既存のノード、または 2 つのノード間に存在する接続にパターン
を追加して、ツールが関係するすべてのノード間の接続を自動的にワイヤリングするよう
にもできます。

ツールは、その結果として得られる接続が有効かどうかをチェックし、ターゲットにパ
ターンを追加することを許可または禁止します。有効な接続の場合、ターゲットがノード
であるか接続であるかによって、ツールの動作が異なります。

既存ノード既存ノード の場合、ツールは新しいノードをターゲットノードの発信側 (エディターの
設定方法 に応じてその下または右側) に追加し、それらの間の接続を自動的にワイヤリ
ングします。

既存の接続既存の接続 の場合、ツールは接続された 2 つのノードの間に新しいノードを挿入し、3
つのノード間の接続を自動的に再度ワイヤリングします。

3. オプションで、2 つのノードを手動で接続できます。

a. キャンバスの Route コンテナーで、ソースノードを選択して、そのコネクター矢印を表示
します。
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b. ソースノードのコネクター矢印 (  ) をターゲットノードにドラッグし、マウスボタン
を解放してコネクターをドロップします。

注記注記

すべてのノードを接続できるわけではありません。ソースノードを無効な
ターゲットノードに接続しようとすると、ツールは  シンボルをマウスカー
ソルに付けて表示し、コネクターをターゲットノードに付ける操作に失敗し
ます。

4. ルートコンテナー内にパターンを追加した後、有効な接続を確立できる限り、ルートコンテ
ナー内の別の場所またはキャンバス上の別のルートコンテナーにパターンをドラッグできま
す。移動によって別の有効な接続を確立できる限り、すでに接続されている既存のノードを再
配置することもできます。
こちら をクリックすると、エンドポイントを再配置する方法を説明する短い動画を閲覧できま
す。

5. File → Save を選択します。ツールは、ルートが完全であるかどうかに関係なく、ルートをコン
テキストファイルに保存します。

Route コンテナーのキャンバスに新しいパターンが表示され、選択したノードになります。Properties
ビューには、編集可能な新しいノードのプロパティーのリストが表示されます。

レイアウト方向の変更

あるノードを別のノードに接続すると、ツールはルートエディターのレイアウト設定に従ってレイアウ
トを更新します。デフォルトは Down です。

ルートエディターのレイアウト設定にアクセスするには、以下を実行します。

Linux および Windows マシンでは、Windows → Preferences → Fuse Tooling → Editor →
Choose the layout direction for the diagram editor を選択します。

OS X では、CodeReady Studio → Preferences → Fuse Tooling → Editor → Choose the
layout direction for the diagram editor を選択します。

関連トピック

「パターンの設定」

「ルートからパターンを削除」

2.2. パターンの設定

概要

ほとんどのパターンでは、明示的な設定が必要です。たとえば、エンドポイントには明示的に URI を入
力する必要があります。

ツールの Properties ビューには、特定のパターンがサポートするすべての設定詳細を一覧表示する
フォームがあります。Properties ビューには、次の便利な機能もあります。
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すべての必須プロパティーに値があることを検証する機能

指定された値がプロパティーの正しいデータ型であることを検証する機能

値のセットが固定されているプロパティーのドロップダウンリスト

Apache Camel Spring 設定から利用可能な Bean 参照が入力されたドロップダウンリスト

手順

パターンを設定するには、以下を実行します。

1. キャンバスで、設定するノードを選択します。
Properties ビューには、選択したノードのすべてのプロパティーが一覧表示され、編集できま
す。EIP の場合、Details タブには、パターンのプロパティーがすべて一覧表示されま
す。Components ドロワーのコンポーネントの場合、Details タブには一般的なプロパティー
と値が必要なプロパティーが一覧表示され、Advamced タブには機能ごとにグループ化された
追加のプロパティーが一覧表示されます。

Documentation タブには、パターンとそのそのプロパティーが記載されています。

2. Properties ビューのフィールドを編集して、ノードを設定します。

3. 完了したら、メニューバーから File → Save を選択して作業を保存します。

2.3. ルートからパターンを削除

概要

ルートを開発および更新するときに、ルートのノードを 1 つ以上削除する必要がある場合があります。
ノードの  アイコンを使用すると、これを簡単に実行できます。キャンバスからノードを削除する
と、ルート内の他のノードとの接続もすべて削除され、そのノードはコンテキストファイル内の対応す
るルート要素から削除されます。

注記注記

ノードのコンテキストメニューを開いて Remove を選択しても、ノードを削除できま
す。

手順

ルートからノードを削除するには、以下を実行します。

1. 削除するノードを選択します。

2. その  アイコンをクリックします。

3. この要素を削除するかどうかを確認するメッセージが表示されたら、Yes をクリックします。

ノードとそのすべての接続がキャンバスから削除され、ノードがコンテキストファイルの対応するルー
ト要素から削除されます。

関連トピック
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「ルートへのパターンの追加」

2.4. ルーティングコンテキストへのルートの追加

概要

XML コンテキストファイル内の camelContext 要素は、ルーティングコンテキストを作成します。
camelContext 要素には 1 つ以上のルートが含まれ、キャンバスに Route コンテナーノードとして表示
される各ルートは、生成された camelContext 要素のルート要素にマッピングされます。

手順

camelContext に別のルートを追加するには、以下を実行します。

1. Design タブで、次のいずれかを実行します。

Palette の Routing ドロワーで Route パターンをクリックし、ルートを配置するキャンバ
スをクリックする。

Palette の Routing ドロワーから Route パターンをドラッグしてキャンバスにドロップす
る。
Properties ビューには、編集可能な新しいルートのプロパティーのリストが表示されま
す。

2. Properties ビューで、以下を入力します。

ルートの Id フィールドの新しいルートの ID (例: Route2)

注記注記

ツールは、キャンバスにドロップされた EIP およびコンポーネントパターン
に ID を自動的に割り当てます。これらの自動生成された ID を独自の ID に
置き換えて、プロジェクト内のルートを区別することができます。

Description フィールドのルートの説明

必要に応じて、その他のプロパティーの値。必要なプロパティーはアスタリスク (*) で示さ
れます。

3. メニューバーで、File → Save を選択して、ルーティングコンテキストファイルに加えた変更を
保存します。

4. 複数のルートを切り替えるには、Project Explorer ビューでプロジェクトの Camel Contexts
フォルダーにあるエントリーをクリックして、キャンバスで表示するルートを選択します。
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5. スペースが許す範囲でコンテキスト内のすべてのルートを表示するには、Project Explorer
ビューでコンテキストファイルエントリーをクリックします。

6. キャンバスにルートを追加するときにツールによって生成されたコードを表示するに
は、Source タブをクリックします。

注記注記

また、camelContext 要素内の既存リストに <route/> 要素を追加する
と、Source タブでルートを追加できます。

2.5. ルートの削除

概要

場合によっては、ルーティングコンテキストからルート全体を削除する必要があります。Route コンテ
ナーの  アイコンを使用すると、これを簡単に実行できます。ルートを削除すると、ルートコンテ
ナー内のすべてのノードも削除され、コンテキストファイル内の対応するルート要素が削除されます。

注記注記

ルートコンテナーのコンテキストメニューで Remove を選択しても、ルートを削除でき
ます。

重要重要

この操作を元に戻すことはできません。
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手順

ルートを削除するには、以下を実行します。

1. ルーティングコンテキストに複数のルートが含まれている場合は、最初に Project Explorer
ビューで削除するルートを選択します。

2. キャンバスで Route コンテナーの  アイコンをクリックします。

3. この要素を削除するかどうかを確認するメッセージが表示されたら、Yes をクリックします。

キャンバス、コンテキストファイル、および Project Explorer ビューからルートが削除されます。

2.6. グローバルエンドポイント、データ形式、BEAN の追加

概要

一部のルートは、グローバルエンドポイント、グローバルデータ形式、またはグローバル Bean によっ
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一部のルートは、グローバルエンドポイント、グローバルデータ形式、またはグローバル Bean によっ
て提供される共有設定に依存しています。ルートエディターの Configurations タブを使用して、プロ
ジェクトのルーティングコンテキストファイルにグローバル要素を追加できます。

ルーティングコンテキストファイルにグローバル要素を追加するには、以下を実行します。

1. ルートエディターでルーティングコンテキストファイルを開きます。

2. グローバル設定がある場合は、ルートエディターの下部にある Configurations タブをクリック
してそれを表示します。

3. Add をクリックして、Create a new global element ダイアログボックスを開きます。
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オプションは次のとおりです。

エンドポイント: 「グローバルエンドポイントの追加」 を参照してください。

データ形式: 「グローバルデータ形式の追加」 を参照してください。

Bean: 「グローバル Bean の追加」 を参照してください。

グローバルエンドポイントの追加

1. Create a new global element ダイアログボックスで Endpoint を選択し、OK をクリックして
Select component ダイアログボックスを開きます。
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注記注記

デフォルトでは、Select component ダイアログボックスが開き、Show only
palette components オプションが有効になっています。使用可能なすべてのコ
ンポーネントを表示するには、このオプションのチェックを外します。

注記注記

Grouped by categories オプションは、コンポーネントをタイプ別にグループ化
します。

2. Select component ダイアログで Camel コンポーネントのリストをスクロールして、コンテキ
ストファイルに追加するコンポーネントを見つけて選択し、次に Id フィールドにその ID を入
力します。
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この例では、JMS コンポーネントが選択され、myJMS が Id の値になります。

3. Finish をクリックします。
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これで、必要に応じて Properties ビューでプロパティーを設定できるようになりました。

ツールによって、[globalEndptSelect]でコンポーネントの Id フィールドに入力した値が Id に
自動入力されます。この例では、Camel はコンポーネントのスキーマ (ここでは jms:) で始ま
る uri (必須フィールド) を構築しますが、destinationName と destinationType を指定してコ
ンポーネントの uri を完了する必要があります。

注記注記

JMS コンポーネントの場合、宛先のタイプはデフォルトで queue に設定されま
す。このデフォルト値は、Destination Name (必須フィールド) に値を入力する
まで、Details ページの uri フィールドに表示されません。

4. コンポーネントの URI を完了するには、Advanced をクリックします。

5. Destination Name フィールドに、宛先エンドポイントの名前を入力します (例: 
FOO.BAR)。Destination Type フィールドにエンドポイント宛先のタイプを入力します (例: 
queue、topic、temp:queue、または temp:topic)。
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Properties ビューの Details タブと Advanced タブから、特定のコンポーネントの設定に使用
できるすべてのプロパティーにアクセスできます。

6. Consumer (advanced) タブをクリックします。

プロパティーの Eager Loading Of Properties と Expose Listener Session を有効にします。

7. ルートエディターで Source タブに切り替えて、最初のルート要素の前にツールがコンテキス
トファイル (この例では、設定された JMS エンドポイント) に追加したコードを確認します。

8. 完了したら、メニューバーで File → Save を選択して変更を保存します。

グローバルデータ形式の追加

1. Create a new global element ダイアログボックスで、Data Format を選択し、OK をクリック
して Create a global Data Format ダイアログボックスを開きます。
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データフォーマットのデフォルトは、利用可能なフォーマットリストの一番上の avro です。

2. Data Format ドロップダウンメニューを開き、xmljson などの形式を選択します。

3. Id フィールドに、フォーマットの名前を入力します (例: myDataFormat)。

4. Finish をクリックします。
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5. Properties ビューで、プロジェクトに応じてプロパティー値を設定します。以下はその例で
す。
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6. ルートエディターで、Source タブをクリックして、ツールがコンテキストファイルに追加した
コードを確認します。この例では、設定された xmljson データ形式は最初のルート要素の前に
あります。

7. 完了したら、メニューバーで File → Save を選択して変更を保存します。

グローバル Bean の追加

グローバル Bean は、ルート内のどこからでも参照できるルート外の Bean 定義を有効にします。Bean
コンポーネントをパレットからルートにコピーすると、Properties ビューの Ref ドロップダウンで定
義済みのグローバル Bean を見つけることができます。Bean コンポーネントが参照するグローバル
Bean を選択します。

グローバル Bean 要素を追加するには、以下を実行します。

1. Create a new global element ウィンドウで、Bean を選択し、OK をクリックして Bean
Definition ダイアログボックスを開きます。
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2. Id フィールドに、グローバル Bean の ID (例: TransformBean) を入力します。ID は、設定内で
一意である必要があります。

3. Bean クラスまたはファクトリー Bean を識別します。
ファクトリー Bean を指定するには、ファクトリークラスが指定された別のグローバル Bean を
すでに追加している必要があります。次に、そのグローバル Bean を選択して、グローバル
Bean ファクトリーとして宣言できます。Bean ファクトリークラスの 1 つのインスタンスがラ
ンタイムにあります。他のグローバル Bean は、そのクラスのファクトリーメソッドを呼び出
して、他のクラスの独自のインスタンスを作成できます。
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Class フィールドに入力するには、次のいずれかを実行します。

プロジェクトまたは参照プロジェクトにあるクラスの名前を入力します。

… をクリックして、プロジェクトまたは参照されるプロジェクトのクラスに移動し、選択
する。

+ をクリックして新しい Bean クラスを定義し、それをグローバル Bean として追加しま
す。

4. 追加する Bean で 1 つ以上の引数が必要な場合、Constructor Arguments セクションで各因数
に対して以下を実行します。

a. Add をクリックします。

b. 必要に応じて、Type フィールドに引数のタイプを入力します。デフォルトは 
java.lang.String です。

c. Value フィールドに、引数の値を入力します。

d. OK をクリックします。

5. オプションで、グローバル Bean にアクセス可能な 1 つ以上のプロパティーを指定しま
す。Bean Properties セクションで、プロパティーごとに以下を実行します。

a. Add をクリックします。

b. Name フィールドにプロパティー名を入力します。

c. Value フィールドに、プロパティーの値を入力します。

d. OK をクリックします。

6. Finish をクリックして、グローバル Bean を設定に追加します。指定したグローバル Bean ID
は、次のように Configurations タブに表示されます。

7. Source タブに移動し、ツールがコンテキストファイルに追加した bean 要素を表示します。以
下に例を示します。
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8. Configurations タブをクリックしてグローバル要素のリストに戻り、グローバル Bean を選択
して、その標準プロパティーを Properties 次に例を示します。

注記注記

グローバル Bean を追加したときに指定したプロパティーを表示または編集する
には、Configurations タブで Bean を選択し、Edit をクリックします。

9. 必要に応じてグローバル Bean プロパティーを設定します。

Depends-on は、このグローバル Bean の前に作成する必要がある Bean を識別するために
使用できる文字列です。依存 Bean の ID (名前) を指定します。たとえば、TransformBean
を追加し、Depends-on を ChangeCaseBean に設定すると、ChangeCaseBean を作成す
る必要があり、TransformBean を作成できます。Bean が破棄されると、TransformBean
が最初に破棄されます。

Factory-method は、グローバル Bean がファクトリークラスである場合にのみ役立ちま
す。この状況では、Bean が参照されるときに呼び出される静的ファクトリーメソッドを指
定または選択します。

スコープスコープは singleton または prototype です。デフォルトは singleton で、Bean が呼び出
されるたびに Camel が同じ Bean のインスタンスを使用することを示します。Bean が呼び
出されるたびに Camel が Bean の新規インスタンスを作成するようにするには、prototype
を指定します。

init-method: Bean の参照時に呼び出す Bean の init() メソッドを指定または選択できま
す。

Destroy-method を使用すると、Bean によって実行される処理が完了したときに呼び出す
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Destroy-method を使用すると、Bean によって実行される処理が完了したときに呼び出す
Bean の破棄メソッドを指定または選択できます。

10. 完了したら、メニューバーで File → Save を選択して変更を保存します。

グローバル要素の削除

以前にルーティングコンテキストに追加されたエンドポイント、データ形式、または Bean を削除する
場合でも、手順は同じです。

注記注記

グローバル要素の削除を元に戻す操作は実行できません。設定に保持したいグローバル
要素を誤って削除した場合、保存せずにコンテキストファイルを閉じることで削除を元
に戻すことができる場合があります。これが不可能な場合は、誤って削除したグローバ
ル要素を再度追加してください。

1. Configurations タブで、削除するグローバル要素を選択します。
たとえば、「グローバルデータ形式の追加」で追加したデータフォーマット myDataFormat を
削除する場合は、以下のようになります。

2. Delete をクリックします。
グローバル要素 myDataFormat は Configurations タブから消えます。

3. Source タブに切り替えて、ツールがルーティングコンテキストから XML コードを削除したこ
とを確認します。
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4. 完了したら、メニューバーで File → Save を選択して変更を保存します。

グローバル要素の編集

手順は、ルーティングコンテキストに追加したエンドポイント、データ形式、または Bean のプロパ
ティーを変更する場合でも同じです。

通常、グローバル要素の ID は変更しません。グローバル要素が実行中のルートですでに使用されてい
る場合、ID を変更すると、グローバル要素への参照が壊れることがあります。

1. Configurations タブで、編集するグローバル要素を選択します。
たとえば、「グローバルエンドポイントの追加」で追加したエンドポイント myJMS を編集す
るには、以下のように選択します。
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2. Edit をクリックします。
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Properties ビューで、必要に応じて要素のプロパティーを変更します。

3. たとえば、Advanced → Consumer タブを開き、Concurrent Consumers の値を 2 に変更しま
す。
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4. ルートエディターで、Source タブをクリックして、ツールがプロパティー 
concurrentConsumers=2 をルーティングコンテキストに追加したことを確認します。

5. 完了したら、メニューバーで File → Save を選択して変更を保存します。

2.7. ルートエディターの設定

概要

Fuse 設定を使用して、ルートエディターの動作とユーザーインターフェイスのオプションを指定でき
ます。

エンタープライズ統合パターン (EIP) の式に使用するデフォルト言語

ルートを作成するときにデザインキャンバス上でパターンが流れる方向 (右または下)

デザインキャンバスがキャンバスの背景にグリッドオーバーレイを表示するかどうか

デザインキャンバス上のノードにラベルを付ける方法

手順

ルートエディターを設定するには、以下を実行します。

1. Editor 設定ウィンドウを開きます。

Linux および Windows マシンでは、Windows → Preferences → Fuse Tooling → Editor を
選択します。

OS X では、CodeReady Studio → Preferences → Fuse Tooling → Editor を選択します。
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2. エンタープライズ統合パターン (EIP) コンポーネントの式に使用するデフォルトの言語を選択
するには、ドロップダウンリストから言語を選択します。デフォルトは Simple です。

3. ルートエディターでルート内のパターンを整列させる方向を指定するには、Down または
Right を選択します。デフォルトは Down です。

4. キャンバスの背景でグリッドオーバーレイの表示を有効または無効にするには、Show diagram
grid in Routes Editor の横のチェックボックスをオンにします。デフォルトは enabled です。

5. ルートエディターの Design タブでコンポーネント ID をラベルとして使用することを有効また
は無効にするには、Use ID values for component labels の横のチェックボックスをオンにしま
す。デフォルトは disabled です。
このオプションをチェックし、コンポーネントに使用するラベルを指定すると (手順 6 を参
照)、ID 値の代わりに指定したラベルがそのコンポーネントに使用されます。

6. ルートエディターの Design タブで、コンポーネント (File ノードなどのエンドポイントを除
く) のラベルとしてパラメーターを使用するには、次の手順に従います。

a. Preferred labels セクションで、Add をクリックします。New Preferred Label ダイアロ
グボックスが開きます。
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b. Component を選択してから、コンポーネントのラベルとして使用する Parameter を選択
します。

c. OK をクリックします。コンポーネントとパラメーターのペアは、エディターの設定ウィン
ドウに一覧表示されます。

オプションで、コンポーネントラベルを 編集編集 および 削除削除 できます。

注記注記

Use ID values for component labels オプションをオンにすると、Preferred
labels セクションにリストされているコンポーネントを除くすべてのコン
ポーネントに適用されます。

7. Apply and Close をクリックして変更を Editor 設定に適用し、Preferences ウィンドウを閉じ
ます。

注記注記
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注記注記

Editor 設定ダイアログボックスに戻って Restore Defaults をクリックすると、いつでも
ルートエディターの元のデフォルトに戻すことができます。
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第3章 REST DSL コンポーネントの表示と編集
Apache Camel は、REST サービスを定義するために複数のアプローチをサポートします。特に、
Apache Camel は REST DSL (Domain Specific Language) を提供します。これは、REST コンポーネン
トを抽象化でき、OpenAPI 2.0 specification とも統合できるシンプルながらも強力な API です。
OpenAPI (以前の Swagger) は、ベンダーに依存しない、移植可能な API サービスのオープン記述形式
です。

Camel Rest DSL の使用に関する詳細は、Apache Camel Development Guide  のDefining REST services
の章を参照してください。

Fuse Tooling を使用すると、Camel コンテキストファイルにある Rest DSL コンポーネントを表示およ
び編集できます。

https://access.redhat.com/articles/4296981 で説明されているように、REST API を OpenAPI クライ
アントに公開するように Fuse Integration プロジェクトを設定することもできます。

3.1. REST DSL コンポーネントのグラフィック表現の表示

Camel コンテキストファイルの REST DSL コンポーネントをグラフィカルモードで表示するには、以
下を実行します。

1. ルートエディターで Camel コンテキストファイルを開きます。

2. REST タブをクリックして、Rest DSL コンポーネントを表示します。

REST Configuration セクションには、次の設定オプションが表示されます。

Component — REST トランスポートに使用する Camel コンポーネント。

Context Path — REST サービスの主要なコンテキストパス。このオプションは、サーブ
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Context Path — REST サービスの主要なコンテキストパス。このオプションは、サーブ
レットのように、Web アプリケーションがコンテキストパスを使用してデプロイされるコ
ンポーネントに使用できます。

Port — REST サービスを公開するポート番号。

Binding Mode — JSON または XML 形式のメッセージのバインディングモード。可能な値
は、off (デフォルト)、auto、json、xml、または json_xml です。

Host  —  REST サービスの公開に使用するホスト名。

3. REST 要素をクリックして、REST Operations セクションで関連する操作 (例: 
GET、POST、PUT、および DELETE) を表示します。

4. REST 要素または REST 操作をクリックして、Properties ビューにそのプロパティーを表示し
ます。

3.2. グラフィカルビューでの REST DSL コンポーネントの編集

REST タブで、プロジェクトの Camel コンテキストファイルの REST 要素を 追加、編集、または削除
できます。

新しい REST 要素を追加するには、以下を実行します。

1. REST elements セクションで、+ ボタンをクリックします。REST 要素が REST elements
のリストに追加されます。

2. Properties ビューで、REST 要素のプロパティーを編集します。
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REST オペレーションを REST 要素に追加するには、以下を実行します。

1. REST elements のリストで、REST 要素を選択します。

2. REST operations セクションで、+ ボタンをクリックします。
Add REST Operation ダイアログボックスが開きます。

3. ID、URI、および Operation Type を指定します。必要に応じて、Referenced Route ID を
選択します。

4. Finish をクリックします。新しいオペレーションは、選択した REST 要素の REST オペ
レーションリストに表示されます。

REST 要素またはオペレーションを編集するには、REST タブでそれらを選択し、Properties
タブでそのプロパティー値を編集します。

選択した REST 要素またはオペレーションを削除するには、x ボタンをクリックします。

3.3. REST DSL ソースコードの表示と編集
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Source タブで、Rest DSL コンポーネントを表示および編集することもできます。

1. ルートエディターで Camel コンテキストファイルを開きます。

2. ルートエディターの Source タブをクリックして、コードを編集します。

3. 必要に応じて、REST タブをクリックして、グラフィカルビューで変更を確認します。

4. 変更を保存するには、File → Save を選択します。
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第4章 SOAP アプリケーションを RESTFUL WEB サービスに移行
WSDL-to-Camel Rest ウィザードを使用して、既存の JAX-WS SOAP Web サービス実装から、既存の
WSDL を使用する RESTful Web サービス実装に移行できます。このウィザードは Fuse Tooling の一部
として利用でき、Github wsdl2rest project  で利用可能な wsdl2rest ユーティリティーに基づいていま
す。

次の仕様/設定をサポートします。

Document/literal (doc/lit)

Document/literal Wrapped (doc/lit wrap)

RPC/literal (rpclit)

4.1. ウィザードのワークフロー

ウィザードは、有効な URL (file:// URL 形式) またはリモート URL (http もしくは https を使用) である
WSDL パスおよび選択した Fuse プロジェクトを使用します。ウィザードでは、生成された Java コー
ド、生成された Camel 設定ファイル、生成された Camel エンドポイントのターゲットアドレス、およ
び Bean 実装クラスのパスを指定します。

ウィザードは、プロジェクトに基づいて宛先 Java および Camel パスを生成します。生成された Java
コードは src/main/java に、Camel ファイルは Spring や Blueprint の適切な場所 (例: 
src/main/resources/META-INF/spring) にあります。

生成されたクラスを変更して、特定のポイントに設定できます。

4.2. 前提条件

作業を開始する前に、次の前提条件を満たしている必要があります。

既存の Fuse Integration プロジェクト。File→ New→ Fuse Integration Project ウィザードを使
用して、新しいプロジェクトを作成できる。

URL を介して WSDL ファイルにアクセスできる。これは、ローカル (file:// url) またはリモー
ト (http もしくは https) にすることができます。

4.3. サンプル SOAP アプリケーションを RESTFUL WEB サービスに移行

ウィザードを実行するには、次の手順に従います。

1. CodeReady Studio の Project Explorer ビューで Fuse プロジェクトを選択します。

2. Fuse プロジェクトを右クリックし、 New → Camel Rest DSL from WSDL を選択します。
Select Incoming WSDL and Project for Generated Output ページが開きます。Destination
Project フィールドには、プロジェクトエクスプローラーで選択した Fuse プロジェクトが自動
的に事前入力されます。このプロジェクトは、ウィザードが生成するアーティファクトの宛先
です。
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3. WSDL File には、処理する元の SOAP サービスを指定します。

4. Next をクリックします。Specify Advanced Options for WSDL-to-REST Processing ページ
が表示されます。

a. Destination Java Folder には、CXF で生成された Java クラスの場所を指定します。

b. Destination Camel Folder には、生成された Camel Rest DSL 設定ファイルの場所を指定
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b. Destination Camel Folder には、生成された Camel Rest DSL 設定ファイルの場所を指定
します。

注記注記

生成された Camel ファイルのパスと名前は、Camel プロジェクトのタイプ
によって異なります。

Spring プロジェクトの場合:src/main/resources/META-INF/rest-camel-
context.xml

Spring Boot プロジェクトの場合:src/main/resources/spring/rest-
springboot-context.xml

Blueprint プロジェクトの場合:src/main/resources/OSGI-INF/rest-
blueprint-context.xml

c. オプションで、Target Service Address に、WSDL バインディングで指定された SOAP ア
ドレスを指定します。このオプションを変更して、WSDL によって参照される SOAP サー
ビスの実際のアドレスと一致させることができます。

d. オプションで、Target REST Service Address に、REST サービスにアクセスするための
URL を指定します。この URL は Rest DSL の <restConfiguration> および <rest> タグに
分解され、SOAP サービスにマッピングされた REST オペレーションの完全な URL を指定
します。

5. Finish をクリックして、出力として 2 つのファイルを作成します。

Rest DSL を使用する Camel 設定。

SOAP サービスをラップする CXF の Java クラス。
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第5章 新しい APACHE CAMEL JUNIT テストケースの作成

概要

ルートをテストする一般的な方法は、JUnit を使用することです。デザインタイムツールには、ルート
の JUnit テストケースの作成を簡素化するウィザードが含まれています。ウィザードは、指定したエン
ドポイントを使用して、テストの開始点コードと設定を生成します。

注記注記

boilerplate JUnit テストケースを作成したら、それを変更して、作成または変更した
ルートに固有の期待値とアサーションを追加する必要があります。これにより、テスト
はルートに対して有効になります。

前提条件

新しい JUnit テストケースを作成する前に、予備的なタスクを実行する必要があります。

既存の JUnit テストケースを置き換える場合は、新しいテストケースを作成する前にそれを削
除する必要があります。「既存の JUnit テストケースの削除」を参照してください。

テストケースのないプロジェクトに新しい JUnit テストケースを作成する場合には、まずビル
ドパスに含まれるテストケースの project_root/src/test/java フォルダーを作成する必要があり
ます。「src/test/java フォルダーの作成およびビルドパスへの追加」を参照してください。

既存の JUNIT テストケースの削除

1. Project Explorer ビューでプロジェクトのルートノードを展開
し、<root_project>/src/test/java フォルダーを表示します。

2. /src/test/java フォルダーで JUnit テストケースファイルを見つけます。
プロジェクトがベースとする DSL に応じて、JUnit テストケースファイルには 
BlueprintXmlTest.java または CamelContextXmlTest.java という名前が付けられます。

3. JUnit テストケースの .java ファイルを右クリックしてコンテキストメニューを開き、Delete
を選択します。
JUnit テストケースの .java ファイルは、Project Explorer ビューから消えます。

これで 新しい JUnit テストケースの作成  が可能になります。

SRC/TEST/JAVA フォルダーの作成およびビルドパスへの追加

1. Project Explorer ビューで、プロジェクトのルートを右クリックしてコンテキストメニューを
開きます。

2. New → Folder を選択して Create a new folder resource ウィザードを開きます。

3. ウィザードのプロジェクトツリーペインで、プロジェクトのルートノードを展開し、src フォ
ルダーを選択します。
<project_root>/src が Enter or select the parent folder フィールドに表示されるのを確認して
ください。

4. Folder name に /test/java を入力します。このフォルダーには、作成した新しい JUnit テスト
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4. Folder name に /test/java を入力します。このフォルダーには、作成した新しい JUnit テスト
ケースが格納されます。

5. Finish をクリックします。
Project Explorer ビューでは、新しい src/test/java フォルダーが src/main/resources フォル
ダーの下に表示されます。このフォルダーがクラスパス上にあることを確認するには、コンテ
キストメニューを開き、Build Path を選択します。Remove from Build Path がメニューオプ
ションである場合は、src/test/java フォルダーがクラスパスにあります。

これで 新しい JUnit テストケースの作成  が可能になります。

JUNIT テストケースの作成

ルートの新しい JUnit テストケースを作成するには、以下を実行します。

1. Project Explorer ビューで、プロジェクトのルーティングコンテキスト .xml ファイルを選択し
ます。

2. 右クリックしてコンテキストメニューを開き、New → Camel Test Case を選択して、図
5.1「新しい Camel JUnit テストケースウィザード」 で示すとおり New Camel JUnit Test
Case ウィザードを開きます。

図図5.1 新しい新しい Camel JUnit テストケースウィザードテストケースウィザード

または、メニューバーから File → New → Other > Fuse > Camel Test Case を選択して、ウィ
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または、メニューバーから File → New → Other > Fuse > Camel Test Case を選択して、ウィ
ザードを開くこともできます。

3. Source folder で、テストケースのソースコードのデフォルトの場所を受け入れるか、別の場所
を入力します。

 をクリックして場所を検索できます。

4. Package で、生成されたテストコードのデフォルトのパッケージ名を受け入れるか、別のパッ
ケージ名を入力します。

 をクリックしてパッケージを検索できます。

5. Camel XML file under test で、テストするルートを含むルーティングコンテキストファイルの
デフォルトのパス名を受け入れるか、別のパス名を入力します。

 をクリックしてコンテキストファイルを検索できます。

6. Name に、生成されたテストクラスのデフォルトの名前を受け入れるか、別の名前を入力しま
す。

7. 生成されたコードに含めるメソッドスタブを選択します。

8. 生成されたコードにデフォルトの生成されたコメントを含める場合は、Generate comments
ボックスをオンにします。

9.  をクリックし、Test Endpoints ページを開きます。例えば、図5.2「新しい
Camel JUnit のテストケースページ」は、選択されたルートの入力ファイルと出力ファイルの
エンドポイントを示しています。

図図5.2 新しい新しい Camel JUnit のテストケースページのテストケースページ
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10. Available endpoints で、テストするエンドポイントを選択します。選択したエンドポイントの
横にあるチェックボックスをクリックして、選択を解除します。

11.  をクリックします。

注記注記

プロンプトが表示されたら、ビルドパスに JUnit を追加します。

テストのアーティファクトはプロジェクトに追加され、Project Explorer ビューで src/test/java の下に
表示されます。テストケースを実装するクラスが Java エディターで開きます。
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第6章 RED HAT FUSETOOLING 内でのルートの実行
ツールを使用してルートを実行するには、次の 2 つの方法があります。

「ローカル Camel コンテキストとしてルートを実行」

「Maven を使用したルートの実行」

6.1. ローカル CAMEL コンテキストとしてルートを実行

概要

Apache Camel ルートを実行する最も簡単な方法は、Local Camel Context として実行する方法です。
この方法では、Project Explorer ビューのコンテキストメニューから直接ルートを起動できます。コン
テキストメニューからルートを実行すると、ツールによってランタイムプロファイルが自動的に作成さ
れます。ルートを実行するためのカスタムランタイムプロファイルを作成することもできます。

ルートは、コマンドラインから直接呼び出されたかのように実行され、Apache Camel の埋め込み
Spring コンテナーを使用します。ランタイムプロファイルを編集して、いくつかのランタイムパラメー
ターを設定できます。

手順

ローカル Camel コンテキストとしてルートを実行するには、以下の手順に従います。

1. Project Explorer ビューで、ルーティングコンテキストファイルを選択します。

2. それを右クリックしてコンテキストメニューを開き、Run As → Local Camel Context を選択し
ます。

注記注記

Local Camel Context (without tests) を選択すると、ツールは検証テストを実
行せずにプロジェクトを実行するように指示されます。こちらの方が速い場合が
あります。

結果

Console ビューには、ルートの実行から生成された出力が表示されます。

関連トピック

「ローカル Camel コンテキストランタイムプロファイルの編集」

6.2. MAVEN を使用したルートの実行

概要

ルートを含むプロジェクトが Maven プロジェクトの場合、m2e プラグインを使用してルートを実行で
きます。このオプションを使用すると、ルートが実行される前に Maven の目標を実行できます。

手順
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Maven を使用してルートを実行するには、以下を行います。

1. Project Explorer ビューで、プロジェクトのルートを選択します。

2. それを右クリックしてコンテキストメニューを開き、Run As → Maven build を選択します。

a. Maven を使用してプロジェクトを初めて実行すると、Edit Configuration and launch エ
ディターが開き、Maven ランタイムプロファイルを作成できます。
ランタイムプロファイルを作成するには、Maven タブで次の手順を実行します。

i. Apache Camel プロジェクトのルートディレクトリーが Base directory: フィールドに
表示されていることを確認します。
たとえば、Linux では、プロジェクトのルートは ~/workspace/simple-router のように
なります。

ii. Goals: フィールドに camel:run を入力します。

重要重要

Java DSL を使用してプロジェクトを作成した場合は、Goals: フィール
ドに exec:java を入力します。

iii. Apply、Run の順にクリックします。

b. 実行の間で変更しない限り、後続の Maven 実行ではこのプロファイルが使用されます。

結果

Console ビューには、Maven 実行からの出力が表示されます。

関連トピック

「Maven ランタイムプロファイルの編集」

6.3. ランタイムプロファイルの操作

Red Hat Fuse Tooling は、各プロジェクトのランタイム環境に関する情報を ランタイムプロファイルランタイムプロファイル
に保存します。ランタイムプロファイルは、呼び出す Maven の目標、使用する Java ランタイム環境、
設定する必要のあるシステム変数などの情報を追跡します。プロジェクトには、複数のランタイムプロ
ファイルを含めることができます。

6.3.1. ローカル Camel コンテキストランタイムプロファイルの編集

概要概要

Local Camel Context ランタイムプロファイルは、ルートを実行するために Apache Camel を呼び出す
方法を設定します。Local Camel Context ランタイムプロファイルは、ルートが定義されているコンテ
キストファイルの名前、呼び出す main の名前、JVM に渡すコマンドラインオプション、使用する
JRE、使用するクラスパス、設定する必要のある環境変数、その他の情報などを保存します。

Local Camel Context ランタイムプロファイルのランタイム設定エディターには、次のタブが含まれて
います。

Camel Context File — 新しい設定の名前とルートを含むルーティングコンテキストファイルの
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Camel Context File — 新しい設定の名前とルートを含むルーティングコンテキストファイルの
フルパスを指定します。

JMX — JMX URI と、それにアクセスするために使用するユーザー名とパスワード (オプション)
を含む、JMX 接続の詳細を指定します。

Main — プロジェクトのベースディレクトリーの完全修飾名、ベースディレクトリーを見つける
ためのいくつかのオプション、ルートを実行する前に実行する必要のある目標、使用する
Maven ランタイムのバージョンを指定します。

JRE — JVM の起動時に使用する JRE およびコマンドライン引数を指定します。

Refresh — 実行が終了した後に Maven がプロジェクトのリソースファイルを更新する方法を指
定します。

Environment — 設定する必要のある環境変数を指定します。

Common — プロファイルの保存方法と出力の表示方法を指定します。

Apache Camel ルートが Local Camel Context として初めて実行されるとき、Red Hat Fuse Tooling は
ルーティングコンテキストファイル用に、編集を必要としないデフォルトのランタイムプロファイルを
作成します。

Local Camel Context のランタイム設定エディターへのアクセスのランタイム設定エディターへのアクセス

1. Project Explorer ビューで、カスタムランタイムプロファイルを編集または作成する Camel コ
ンテキストファイルを選択します。

2. それを右クリックしてコンテキストメニューを開き、Run As → Run Configurations を選択し
て Run Configurations ダイアログボックスを開きます。

3. コンテキスト選択コンテキスト選択 ペインで、Local Camel Context を選択してから、コンテキスト選択コンテキスト選択 ペイン
の左上にある  をクリックします。

4. Name フィールドに、ランタイムプロファイルの新しい名前を入力します。

図図6.1 Loca Camel Context のランタイム設定エディターのランタイム設定エディター
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図図6.1 Loca Camel Context のランタイム設定エディターのランタイム設定エディター

camel コンテキストファイルの設定コンテキストファイルの設定

Camel Context File タブには 1 つのフィールド Select Camel Context file… があります。ルート定義
を含むルーティングコンテキストファイルへのフルパスを入力します。

Browse ボタンは、Open Resource ダイアログボックスにアクセスします。これにより、ターゲット
ルーティングコンテキストファイルを簡単に見つけることができます。このダイアログボックスは、
Apache Camel ルートを含むファイルを検索するように事前設定されています。

コマンドラインオプションの変更コマンドラインオプションの変更

デフォルトでは、JVM には以下のコマンドラインオプションのみ渡されます。

-fa context-file

カスタムメインクラスを使用している場合は、別のオプションを渡す必要がある場合があります。そう
するには、Main タブで Add ボタンをクリックして、パラメーターの名前と値を入力します。Add
Parameter ダイアログボックスの Variables…  ボタンをクリックして、選択可能な変数のリストを表示
できます。

JVM 固有の引数を追加または変更するには、JRE タブの VM arguments フィールドを編集します。

出力の送信先の変更出力の送信先の変更

デフォルトでは、ルートの実行から生成された出力は Console ビューに送信されます。ただし、これ
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デフォルトでは、ルートの実行から生成された出力は Console ビューに送信されます。ただし、これ
をファイルにリダイレクトすることもできます。

出力をファイルにリダイレクトするには、以下を実行します。

1. Common タブを選択します。

2. Standard Input and Output ペインで、Output File: フィールドの横にあるチェックボックス
をクリックし、出力送信先のファイルへのパスを入力します。
Workspace ボタン、File System ボタン、および Variables ボタンを使用すると、出力ファイ
ルへのパスを簡単に構築できます。

関連トピック関連トピック

「ローカル Camel コンテキストとしてルートを実行」

6.3.2. Maven ランタイムプロファイルの編集

概要概要

Maven ランタイムプロファイルは、Maven が Apache Camel を呼び出す方法を設定します。Maven ラ
ンタイムプロファイルには、実行する Maven 目標、使用する Maven プロファイル、使用する Maven
のバージョン、使用する JRE、使用するクラスパス、設定する必要のある環境変数、およびその他のい
くつかの情報が格納されています。

重要重要

Maven を使用して Apache Camel ルートを初めて実行するときは、そのデフォルトラン
タイムプロファイルを作成する必要があります。

Fuse ランタイムプロファイルのランタイム設定エディターには、次のタブが含まれています。

Main — 新しい設定の名前、プロジェクトのベースディレクトリーの完全修飾名、ベースディレ
クトリーを見つけるためのいくつかのオプション、ルートを実行する前に実行する必要のある
目標、使用する Maven ランタイムのバージョンを指定します。

JRE — JVM の起動時に使用する JRE およびコマンドライン引数を指定します。

Refresh — 実行が終了した後に Maven がプロジェクトのリソースファイルを更新する方法を指
定します。

Source — プロジェクトに必要な追加のソースの場所を指定します。

Environment — 設定する必要のある環境変数を指定します。

Common — プロファイルの保存方法と出力の表示方法を指定します。

Maven ランタイム設定エディターへのアクセスランタイム設定エディターへのアクセス

1. Project Explorer ビューで、カスタムランタイムプロファイルを編集または作成するプロジェ
クトのルートを選択します。

2. それを右クリックしてコンテキストメニューを開き、Run As → Run Configurations を選択し
て Run Configurations ダイアログボックスを開きます。

3. コンテキスト選択コンテキスト選択 ペインで、Maven Build を選択してから、コンテキスト選択コンテキスト選択 ペインの左上に
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3. コンテキスト選択コンテキスト選択 ペインで、Maven Build を選択してから、コンテキスト選択コンテキスト選択 ペインの左上に
ある  をクリックします。

図図6.2 Maven のランタイム設定エディターのランタイム設定エディター

Maven ゴールの変更ゴールの変更

ルートを実行するときに最も一般的に使用されるゴールは、camel:run です。これは、独自の JVM で
実行されている Spring コンテナーにルートをロードします。

Apache Camel プラグインは、Maven が使用するのと同じ JVM に Spring コンテナーをロードする
camel:embedded ゴールもサポートしています。これの利点は、ルートのブートストラップが速くな
ることです。

Java DSL に基づくプロジェクトは、exec:java ゴールを使用します。

POM に他のゴールが含まれる場合、Main タブの Maven Runtime フィールドの横にある Configure…
ボタンをクリックして、使用する Maven ゴールを変更できます。Installations ダイアログボックス
で、Global settings for <selected_runtime> installation フィールドを編集します。

Maven バージョンの変更バージョンの変更

デフォルトでは、Red Hat Fuse Tooling for Eclipse は Eclipse に組み込まれている m2e を使用します。
別の Maven バージョンを使用する場合、または開発マシンに新しいバージョンをインストールする場
合は、Main タブの Maven Runtime ドロップダウンメニューから選択できます。
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出力送信先の変更出力送信先の変更

デフォルトでは、ルート実行からの出力は Console ビューに送信されます。ただし、これをファイル
にリダイレクトすることもできます。

出力をファイルにリダイレクトするには、以下を実行します。

1. Common タブを選択します。

2. Output File: フィールドの横にあるチェックボックスをクリックして、出力を送信するファイ
ルへのパスを入力します。
Workspace ボタン、File System ボタン、および Variables ボタンを使用すると、出力ファイ
ルへのパスを簡単に構築できます。

関連トピック関連トピック

「Maven を使用したルートの実行」
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第7章 FUSE ON OPENSHIFT の使用
Fuse on OpenShift (Fuse Integration Services 7.0 以降の名称) は、Fuse アプリケーションを
OpenShift Container Platform にデプロイすることができます。

重要重要

Fuse Integration プロジェクト (Fuse on OpenShift プロジェクト) の場合、Fuse Tooling
では Red Hat Container Development Kit (CDK) v3.x をインストールする必要がありま
す。手順については、スタートガイド を参照してください。このガイドで指定されてい
る前提条件に加えて、Red Hat アカウントを持っていない場合は、それを確立する必要
があります。Red Hat Container Development Kit で提供される仮想 OpenShift インスタ
ンスを開始するには、Red Hat ユーザー名とパスワードが必要です。

Red Hat Customer Portal  に登録することで、簡単にアカウントを取得できます。ホワイ

トバナーの右上隅にある  をクリックし、ご自身のご自身の Red Hat アカウントにログイアカウントにログイ

ンン ページの  をクリックします。

Fuse Tooling を使用すると、s2i バイナリーワークフローを使用して Fuse Integration プロジェクトを開
発および展開できます。このワークフローでは、ツールがプロジェクトをローカルでビルドし、それを
イメージストリームにアセンブルしてから、そのイメージストリームを OpenShift にプッシュし、そこ
で Docker コンテナーのビルドに使用します。Docker コンテナーがビルドされると、OpenShift はそれ
を Pod にデプロイします。

重要重要

Fuse Tooling は、S2I バイナリーワークフローでのみ機能し、SpringBoot フレームワー
クに基づくプロジェクトでのみ機能します。

注記注記

Fuse Tooling はツールを使用して作成された Fuse Integration プロジェクトをリモート
OpenShift サーバーにデプロイできますが、この章では、Red Hat Container
Development Kit (CDK) v3.x を使用してローカルにインストールされた仮想 OpenShift
インスタンスに Fuse Integration プロジェクトを作成およびデプロイする方法について
説明します。

次のセクションでは、最初の Fuse Integration プロジェクトを作成してデプロイする方法について説明
します。

「Red Hat Container Development Kit サーバーの追加」

「Container Development Environment (CDE) および仮想 OpenShift サーバーの起動」

「新しい OpenShift プロジェクトの作成」

「新規 Fuse Integration プロジェクトの作成」

「Fuse Integration プロジェクトの OpenShift へのデプロイ」

注記注記
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注記注記

Fuse Integration プロジェクトをローカル Camel コンテキストとして実行し、「ローカ
ル Camel コンテキストとしてルートを実行」 を参照してから、JMX Navigator ビュー
に接続できます。このビューでは、ルーティングコンテキストを関しおよびテストでき
ます。Fuse Integration プロジェクトで Camel デバッガーを実行し (パートII「ルーティ
ングコンテキストのデバッグ」)、ルーティングコンテキストの論理エラーを公開して修
正することもできます。

7.1. RED HAT CONTAINER DEVELOPMENT KIT サーバーの追加

Red Hat Container Development Kit を Servers ビューに追加するには、以下を実行します。

1. 必要に応じて、Window → Perspective → Open Perspective → Fuse Integration の順に選択
して Fuse Integration パースペクティブに切り替えます。

注記注記

この手順で説明されているビューが開かない場合は、Window → Show View →
Other を選択し、開くビューの名前を選択します。

2. Servers ビューで No servers are available. Click this link to create a new server… のリンクを
クリックし、Define a New Server ウィザードを開きます。このリンクは、Servers ビューに
サーバーエントリーが含まれない場合にのみ表示されます。
それ以外の場合は、Servers ビューを右クリックしてコンテキストメニューを開き、New →
Server を選択して Define a New Server ウィザードを開きます。
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3. Red Hat JBoss Middleware → Red Hat Container Development Kit 3.2+ を選択します。
次のデフォルト値を受け入れます。

Server's hostname: localhost

Server name: Container Development Environment

4. Next をクリックして Red Hat Container Development Environment ページを開きます。

5. MiniShift Binary の横にある Browse をクリックして、Red Hat Container Development Kit 3. x
をインストールした場所に移動し、Open をクリックします。

6. Username の横にある Add をクリックし、Add a Credential ページを開きます。

7. クレデンシャルを次のように設定します。

Username  —  Red Hat アカウントへのログインに使用する名前を入力します。

Always prompt for password  — そのままにします (無効)。
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Password  —  Red Hat アカウントへのログインに使用するパスワードを入力します。

8. OK をクリックして、Red Hat Container Development Environment ページに戻ります。この
ページにデータが入力されています。以下に例を示します。

9. Finish をクリックします。Container Development Environment 3.2+ [Stopped,
Synchronized] が Servers ビューに表示されます。Container Development Environment
3.2+ は、CDK 3. x サーバーを追加する場合のデフォルトサーバー名です。

7.2. CONTAINER DEVELOPMENT ENVIRONMENT (CDE) および仮想
OPENSHIFT サーバーの起動

Container Development Environment (CDE) を起動すると、仮想 OpenShift サーバーも起動します。
CDE を停止すると、仮想 OpenShift サーバーも停止します。

1. Servers ビューで Container Development Environment 3 [stopped, Synchronized] を選択

し、Servers メニューバーの  をクリックします。
Console ビューが開き、起動プロセスのステータスが表示されます。
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注記注記

CDE は、最初の起動時に、信頼できない SSL 証明書を受け入れるかどうかを尋
ねます。Yes をクリックします。

起動プロセスが終了すると、Servers ビューに次のように表示されます。

2. OpenShift Explorer ビューに切り替えます。
仮想 OpenShift サーバーインスタンス developer も実行されています。

https://192.168.99.100:8443 は、OpenShift 開発者 Web コンソールの URL の例です。インス
トールにより、インスタンスの URL が表示されます。詳細については 「OpenShift Web コン
ソールへのアクセス」 を参照してください。

7.3. 新しい OPENSHIFT プロジェクトの作成

Fuse Integration プロジェクトを OpenShift にデプロイすると、ここで作成した OpenShift プロジェク
トに公開されます。

1. OpenShift Explorer ビューで、developer エントリーを右クリックして、コンテキストメ
ニューを開きます。

2. New → Project を選択して、New OpenShift Project ウィザードを開きます。

3. 新規プロジェクトのプロパティーを以下のように設定します。
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Project Name フィールドに、仮想 OpenShift サーバーにおけるプロジェクトの
namespace の名前を入力します。
小文字、数字、ダッシュのみ有効です。

Display Name フィールドに、仮想 OpenShift Web コンソールの Overview ページに表示
する名前を入力します。

Description フィールドはそのままにしておきます。
以下に例を示します。

4. Finish をクリックします。
新しい OpenShift プロジェクト (この例では New FIS Test newtest) は、OpenShift Explorer
タブの、この例では developer https://192.168.99.100:8443 の下に表示されます。

注記注記

MyProject myproject は、OpenShift に含まれている初期サンプルプロジェクト
です。

OpenShift Explorer ビューで New FIS Test newtest を選択すると、Properties ビューにプロ
ジェクトの詳細が表示されます。以下に例を示します。
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注記注記

プロジェクトを OpenShift にデプロイすると、Properties ビューは OpenShift
Web コンソールが行うのと同じプロジェクトに関する情報を収集して表示しま
す。

7.4. 新規 FUSE INTEGRATION プロジェクトの作成

新規 Fuse Integration プロジェクトを作成する前に、ステージングリポジトリーを有効にする必要があ
ります。一部の Maven アーティファクトはデフォルトの Maven リポジトリーにないため、この設定が
必要です。ステージングリポジトリーを有効にするには、Window → Preferences → Fuse Tooling →
Staging Repositories の順に選択します。

Fuse Integration プロジェクトを作成するには、Spring Boot on OpenShift テンプレートを使用しま
す。

1. Project Explorer ビューで右クリックしてコンテキストメニューを開き、New → Fuse
Integration Project を選択してウィザードの Choose a project name ページを開きます。
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2. Project Name フィールドに、使用しているワークスペースに固有の名前を入力します (例:
myFISproject)。
他のオプションでデフォルト値を使用します。

3. Next をクリックして、Select a Target Runtime ページを開きます。
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Target Runtime (No Runtime selected) および Camel Version はデフォルト値をそのまま使
用します。

4. Next をクリックして Advanced Project Setup ページを開きます。
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5. Simple log using Spring Boot - Spring DSL テンプレートを選択します。
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6. Finish をクリックします。

注記注記

初めての Fuse Integration プロジェクトでダウンロードされる依存関係の数が多
いため、プロジェクトのビルドには時間がかかる場合があります。

Fuse Integration パースペクティブがまだ開いていない場合、Developer Studio
により、ここで開くかどうかを示すようにプロンプトが表示されます。Yes をク
リックします。

ビルドが完了すると、Fuse Integration パースペクティブにプロジェクトが表示されます。以下はその
例です。
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この時点で、以下を実行できます。

OpenShift へのプロジェクトのデプロイ

「ローカル Camel コンテキストとしてルートを実行」ルーティングコンテキストがローカルマ
シンで正常に実行されていることの確認
JMX Navigator ビューで実行中のコンテキスト (「ローカル JMX サーバーでのプロセスの表
示」 を参照) に接続すると、ルートコンポーネントを監視し、ルートが想定どおりに実行され
るかどうかをテストできます。

ルートコンポーネントの JMX 統計の表示 (21章コンポーネントの JMX 統計情報の表示  を
参照)

実行中のルートの表示 (25章ルーティングエンドポイントの管理)

実行中のルートの一時停止/再開 (27章ルーティングコンテキストの管理)

実行中のルートでのトレースの開始/停止 (23章ルートのトレース)

ロジックエラーの検出と修正を目的とした、プロジェクトの camel-context.xml ファイルでの
Camel デバッガーの実行 (パートII「ルーティングコンテキストのデバッグ」 を参照)

7.5. FUSE INTEGRATION プロジェクトの OPENSHIFT へのデプロイ

1. Project Explorer ビューで、プロジェクトのルート (この例では myFISproject) を右クリック
して、コンテキストメニューを開きます。

2. Run As → Run Configurations の順に選択し、Run Configurations ウィザードを開きます。

3. サイドバーメニューで、Maven Build → Deploy <projectname> on OpenShift (この例では
Deploy myFISproject on OpenShift) を選択し、プロジェクトのデフォルトラン設定を開きま
す。
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Main タブのデフォルト設定をそのまま使用します。

4. JRE タブを開いて、VM 引数にアクセスします。
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5. VM arguments ペインで、-Dkubernetes.namespace=test 引数の値を変更して、OpenShift
プロジェクトの作成時に使用したプロジェクト名 (「新しい OpenShift プロジェクトの作
成」の OpenShift のプロジェクト名) に一致させます。
この例では、デフォルト値の test を newtest に変更します。

OpenShift の設定によっては、それをサポートするために他の VM 引数を変更する必要がある
場合があります。

-Dkubernetes.master=https://192.168.99.1:8443
複数の OpenShift インスタンスを実行する場合、またはリモートインスタンスを使用する
場合は、デプロイメントの対象となる OpenShift インスタンスの URL を指定する必要があ
ります。上記の URL はその例です。

-Dkubernetes.trust.certificates=true
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CDK を使用する場合、この引数は必須です。true に設定したままにしてください。

有効な SSL 証明書を持つ OpenShift インスタンスを使用している場合は、この引数の
値を false に変更します。

6. Apply をクリックしてから、Run をクリックします。
ダウンロードする依存関係の数が多いため、初回の展開には時間がかかる場合があります。コ
ンピューターの速度とインターネット接続が要因になっています。通常、初回の展開が完了す
るまでに 25〜35 分かかります。

Console ビューでは、デプロイプロセスの進行状況を追跡できます。以下の出力のエントリー
Pushing image 172.30.1 … * は、プロジェクトが正常にビルドされ、アプリケーションイメージ
が OpenShift にプッシュされて Docker コンテナーのビルドに使用されることを示します。

デプロイメントが正常に完了すると、Console ビューに BUILD SUCCESS が表示されます。

7. OpenShift Explorer ビューに切り替えて、New FIS Test newtest を選択します。
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Properties ビューの Details ページには、プロジェクトのプロパティー値がすべて表示されま
す。

他のタブ (Builds、Build Configs、Deployments …) を開き、プロジェクトの他のプロパティー
を表示します。Properties ビューには、OpenShift Web コンソールと同じ情報が表示されま
す。

8. OpenShift Explorer ビューで camel-ose-springboot-xml を選択し、Properties ビューでそ
の詳細を表示します。

他のタブをスクロールして、デプロイメント設定の他のプロパティーを表示します。
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9. OpenShift Explorer ビューで camel-ose-springboot-xml-1-mdmtd Pod Running を選択
し、Properties ビューで実行中のインスタンスの詳細を表示します。

10. OpenShift Explorer ビューで camel-ose-springboot-xml-1-mdmtd Pod Running を右クリッ
クし、続いてPod Logs… を選択します。

注記注記

プロンプトが表示されたら、インストールされた oc 実行可能ファイルへのパス
を入力します。Pod ログを取得する必要があります。

Console ビューが自動的に開き、実行中の Pod からのログが表示されます。
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Console ビューのメニューバーの  をクリックしてセッションを終了し、コンソールの出力
をクリアします。

7.6. OPENSHIFT WEB コンソールへのアクセス

注記注記

この情報は、Red Hat Container Development Kit のインストールにのみ適用されます。

OpenShift Web コンソールにアクセスするには、ブラウザーを開き、インスタンスとマシンに固有の
OpenShift サーバーの URL を入力します。たとえば、ブラウザーのアドレスフィールドに 
https://192.168.99.100:8443 を入力します。

デフォルトのクレデンシャルを使用して、開発者または管理者として Web コンソールにログインでき
ます。

デフォルトの開発者ロール
開発者ユーザーは、自分のプロジェクトと、OpenShift v3 の機能を示す提供された OpenShift
サンプルプロジェクトのみを表示できます。開発者ユーザーは、OpenShift にデプロイされて
いる、自分が所有する任意のプロジェクトを作成、編集、および削除できます。

Username: developer

Password: developer

デフォルトの管理者ロール
管理者ユーザーは、OpenShift (CDK) 上のすべてのプロジェクトを表示およびアクセスできま
す。管理者ユーザーは、OpenShift にデプロイされた任意のプロジェクトを作成、編集、およ
び削除できます。

Username: admin

Password: admin
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OpenShift Web コンソールの使用に関する詳細は、スタートガイド を参照してください。
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第8章 RED HAT FUSE SAP TOOL SUITE の使用
Red Hat Fuse SAP Tool Suite を使用すると、Camel ルートをリモートの SAP アプリケーション・サー
バーと統合できます。リモート機能呼び出し (RFC) および中間文書 (IDoc) の送受信をサポートするた
めに、さまざまな SAP コンポーネントが提供されています。SAP Tool Suite は、SAP の JCo および
IDoc クライアントライブラリーに依存しています。これらのライブラリーをインストールして使用す
るには、SAP Service Marketplace アカウントが必要です。

8.1. RED HAT FUSE SAP TOOL SUITE のインストール

概要

Red Hat Fuse SAP Tool Suite には、Edit SAP Connection Configuration ダイアログボックスがあり、
SAP アプリケーションサーバーと宛先接続を作成および管理するのに役立ちます。このスイートは、
SAP によって個別にライセンスされているサードパーティーの JCo および IDoc クライアントライブラ
リーを必要とするため、デフォルトではインストールされていません。

SAP ツールのプラットフォーム制限

SAP ツールスイートはサードパーティーの JCo 3.0 および IDoc 3.0 ライブラリーに依存しているた
め、これらのライブラリーがサポートするプラットフォームにのみインストールできます。SAP ツール
のプラットフォーム制限の詳細は、Red Hat Fuse でサポートされる設定  を参照してください。

前提条件

Fuse SAP Tool Suite をインストールする前に、以下の場所から JCo および IDoc ライブラリーをダウ
ンロードする必要があります。

http://service.sap.com/connectors

これらのライブラリーをダウンロードするには、SAP Service Marketplace アカウントが必要です。
operationg システムに適した JCo および IDoc ライブラリーを必ず選択してください。また、以下の点
にも注意してください。

JCo ライブラリーのバージョン 3.0.11 以降のみがサポートされます。

IDoc ライブラリーのバージョン 3.0.10 以降のみがサポートされます。

このインストール手順では、ダウンロードしたファイルをアーカイブ形式のままにしておくことができ
ます。内容を抽出する必要はありません。

手順

Fuse SAP Tool Suite を Red Hat CodeReady Studio にインストールするには、次の手順を実行します。

1. Red Hat CodeReady Studio で、File → Import を選択して、Import ウィザードを開きます。

2. Import ウィザードの Select 画面で Fuse → Install Fuse SAP Tool Suite を選択し、Next をク
リックします。

3. Install the Red Hat Fuse SAP Tool Suite 画面が開き、SAP Service Marketplace から JCo ライ
ブラリーおよび IDoc ライブラリーをダウンロードする手順が表示されます。Next をクリック
します。
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4. Select JCo3 およびおよび IDoc3 Archive to Import 画面が開きます。JCo Archive File フィールドの
横にある Browse ボタンを使用して、SAP Service Marketplace からダウンロードした JCo
アーカイブを選択します。JCo アーカイブを選択すると、Archive Version と Archive OS
Platform フィールドが自動的に入力されるため、インストールしているライブラリーに正しい
バージョンと OS プラットフォームがあるかどうかを確認できます。
IDoc3 Archive File フィールドの横にある Browse ボタンを使用して、SAP Service Marketplace
からダウンロードした IDoc アーカイブを選択します。

両方のアーカイブファイルを選択したら、Finish をクリックします。

5. 新しい Install ウィザードが (Eclipse プラグインをインストールするために) 自動的に開きま
す。このウィザードは、次の情報をインストールするプラグインに表示します。

Fuse SAP Tool Suite

SAP JCo3 および IDoc3 ライブラリー
これらのプラグインの両方が選択されていることを確認してください。Next をクリックし
ます。

注記注記

SAP JCo3 およびおよび IDoc3 ライブラリーは、ライブラリーは、  選択した JCo および IDoc ライ
ブラリーから動的に構築されます。

6. Install Details 画面では、インストールされるプラグインを確認できます。Next をクリックし
ます。

7. Review Licenses ダイアログボックスが開きます。I accept ラジオボタンオプションを選択
し、Finish をクリックします。

8. Security Warning ダイアログボックス (署名なしコンテンツの警告) が表示された場合は、OK
をクリックして警告を無視し、インストールを続行します。

9. Restart Eclipse ダイアログボックスが開きます。OK をクリックして Eclipse を再起動します。

8.2. SAP 宛先接続の作成とテスト

概要

Fuse SAP Tool スイートでは、Edit SAP Connection Configuration ダイアログボックスを使用して、
SAP アプリケーション宛先接続を作成および管理できます。このセクションでは、SAP 宛先接続を作
成およびテストする方法について説明します。

手順

SAP 宛先接続を作成してテストするには、次の手順を実行します。

1. ルートエディターのグローバル Configurations タブに移動し、Add をクリックします。
Create new global element ビューが表示されます。

2. SAP で、作成する接続のタイプを選択します。SAP Connection を選択し、OK をクリックし
ます。
Edit SAP Connection Configuration ダイアログボックスが表示されます。これにより、宛先
およびサーバー接続設定を作成、編集、削除できます。
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3. 新しい Destination Data Store を作成するには、Add Destination タブをクリックします。
Create Destination ダイアログボックスが表示されます。

4. Destination Name フィールドに宛先の名前を入力し、Ok をクリックします。

5. Properties ダイアログボックスで以下を実行します。

a. Basic タブをクリックして、SAP 宛先への接続に必要な基本プロパティーを設定します。
このタブで、次のプロパティーフィールドに入力して接続を設定します。

SAP Application Server

SAP System Number

SAP Client

Logon User

Logon Password

Logon Language

b. Connection タブをクリックして、SAP 宛先への接続に必要な値を追加します。次のプロ
パティーフィールドに入力して、接続を設定します。

SAP System Number

SAP Router String

SAP Application Server

SAP Message Server

SAP Message Server Port

Gateway Host

Gateway Port

SAP System ID

SAP Application Server Group

c. Authenticate タブをクリックして、SAP 宛先の検証に必要な値を追加します。次のプロパ
ティーフィールドに入力して、接続を設定します。

SAP Authentication type

SAP Client

Logon User

Logon User Alias

Logon Password

SAP SSO Logon Ticket

SAP X509 Login Ticket
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Logon Language

d. Special タブをクリックします。このタブで、次のプロパティーフィールドに入力して接続
を設定します。

Select CPIC Trace

Initial Codepage

e. Pool タブをクリックし、次のプロパティーフィールドに入力して接続を設定します。

Connection Pool Peak Limit

Connection Pool Capacity

Connection Pool Expiration Time

Connection Pool Expire Check Period

Connection Pool Max Get Client Time

f. SNC タブをクリックし、次のプロパティーフィールドに入力して接続を設定します。

SNC Partner Name

SNC Level of Security

SNC Name

SNC Library Path

g. Repository タブをクリックし、次のプロパティーフィールドに入力して接続を設定しま
す。

Repository Destination

Repository Logon User

Repository Logon Password

注記注記

これらの設定について詳しい情報が必要な場合は、SAP のドキュメント
を参照してください。

6. これで、宛先接続をテストする準備が整いました。Edit SAP Connection Configuration ダイ
アログボックスで宛先名を右クリックし、Test を選択します。
Test Destination Connection ダイアログボックスが開きます。

7. ダイアログボックスでは、現在の宛先設定を使用して SAP Destination Data Store に接続しま
す。テストが成功すると、ステータス領域に次のメッセージが表示されます。

Connection test for destination 'YourDestination' succeeded.

それ以外の場合は、ステータス領域にエラーレポートが表示されます。

8. Close をクリックして、Test Destination Connection ダイアログボックスを閉じます。
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9. Finish をクリックします。新しく作成された SAP Destination Connection が SAP の下に表示
されます。

8.3. SAP サーバー接続の作成とテスト

概要

Fuse SAP Tool スイートでは、Edit SAP Connection Configuration ダイアログボックスを使用して、
SAP アプリケーションサーバー接続を作成および管理できます。このセクションでは、SAP サーバー
接続を作成およびテストする方法について説明します。

手順

SAP サーバー接続を作成してテストするには、次の手順を実行します。

1. ルートエディターのグローバル Configurations タブに移動し、Add をクリックします。
Create new global element ビューが表示されます。

2. SAP で、作成する接続のタイプを選択します。SAP Connection を選択し、OK をクリックし
ます。
Edit SAP Connection Configuration ダイアログボックスが表示されます。これにより、宛先
およびサーバー接続設定を作成、編集、削除できます。

3. 新しい Server Data Store を作成するには、Add Server タブをクリックします。
Create Server ダイアログボックスが表示されます。

4. Server Name フィールドにサーバーの名前を入力し、Ok をクリックします。

5. Properties ダイアログボックスで以下を実行します。

a. Mandatory タブをクリックして、SAP サーバーへの接続に必要な基本プロパティーを設定
します。このタブで、次のプロパティーフィールドに入力して接続を設定します。

Gateway Host

Gateway Port

Program ID

Repository Destination

Connection Count

b. Optional タブをクリックし、次のプロパティーフィールドに入力して接続を設定します。

SAP Router String

Worker Thread Count

Minimum Worker Thread Count

Maximum Startup Delay

Repository Map

c. SNC タブをクリックし、次のプロパティーフィールドに入力して接続を設定します。
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SNC Level of Security

SNC Name

SNC Library Path

注記注記

設定の詳細については、SAP のドキュメントを参照してください。

6. これで、サーバー接続をテストする準備が整いました。Edit SAP Connection Configuration
ダイアログボックスでサーバー名を右クリックし、Test を選択します。
Test Server Connection ダイアログボックスが開きます。

7. ダイアログボックスでは、現在のサーバー設定を使用して SAP Server Data Store に接続しま
す。テストが成功すると、ステータス領域に次のメッセージが表示されます。

Server state: STARTED
Server state: ALIVE

テストが失敗した場合、サーバーのステータスは DEAD として報告されます。

8. Stop をクリックして、テストサーバーをシャットダウンします。

9. Close をクリックして、Test Server Connection ダイアログボックスを閉じます。

10. Finish をクリックします。新しく作成された SAP Server Connection が SAP の下に表示され
ます。

8.4. 宛先接続およびサーバー接続の削除

概要

このセクションでは、Edit SAP Connection Configuration ダイアログボックスで SAP 宛先接続および
サーバー接続を削除する方法について説明します。

手順

宛先接続とサーバー接続を削除する場合は、次の手順を実行します。

1. ルートエディターのグローバル Configurations タブに移動し、Add をクリックします。
Create new global element ビューが表示されます。

2. SAP で SAP Connection を選択し、Ok をクリックします。
Edit SAP Connection Configuration ダイアログボックスが表示されます。これにより、宛先
およびサーバー接続設定を作成、編集、削除できます。

3. Edit SAP Connection Configuration ダイアログボックスで、削除する Destination and Server
Data Stores を選択します。

4. Delete をクリックします。選択した接続が削除されます。
最後に、Finish をクリックします。すべての変更が保存されます。
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8.5. 新規 SAP エンドポイントの作成

概要

ルートエディターのコンポーネントパレットを使用して、Edit SAP Connection Configuration ダイアロ
グで SAP コンポーネントをルートに追加できます。

注記注記

SAP Connection ビューを使用している場合は、必ず必要な SAP 接続設定データを
Blueprint XML または Spring XML コードに貼り付けてください。

前提条件

Edit SAP Connection Configuration ダイアログを使用して、いくつかの SAP 宛先接続またはサーバー
接続 (あるいはその両方) が作成済みである必要があります。

注記注記

SAP Connection ビューを使用している場合は、この設定を適切なタイプ (Blueprint XML
または Spring XML) のファイルにエクスポートします。

手順

新しい SAP エンドポイントを作成するには、次の手順を実行します。

1. 使用する Fuse プロジェクトと Camel XML ファイル (Blueprint XML または Spring XML 形式の
いずれか) が既に存在することを前提としています。

2. ルートエディターで Camel XML ファイルを開きます。Red Hat Fuse SAP Tool Suite をすでに
インストールしている場合は、ルートエディターの Components パレットの下に SAP コン
ポーネントが表示されるはずです。次の SAP コンポーネントは、ツールスイートによって提供
されます。

SAP IDoc Destination

SAP IDoc List Destination

SAP IDoc List Server

SAP qRFC Destination

SAP Queued IDoc Destination

SAP Queued IDoc List Destination

SAP sRFC Destination

SAP sRFC Server

SAP tRFC Destination

SAP tRFC Server
ルートエディターの Design タブで、これらのコンポーネントのいずれかをキャンバスにド
ラッグし、現在の camelContext に新しい SAP エンドポイントを作成します。

注記注記
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注記注記

SAP Netweaver コンポーネントは、Red Hat Fuse SAP Tool Suite に属して
いません。Apache Camel プロジェクトでホストされています。

3. キャンバスの下部にある Source タブをクリックして、ルートエディターの Source タブに移動
します。ルートの XML ソースが表示されます。

4. SAP エンドポイント URI を指定する場合、宛先名またはサーバー接続名のいずれかを URI 形式
で埋め込む必要があります。たとえば、sap-srfc-destination コンポーネントの URI 形式は以
下のとおりです。

sap-srfc-destination:destinationName:rfcName

特定の宛先を参照するには、関連する entry 要素の key 属性の値をこの URI の 
destinationName として使用します。
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第9章 データ変換のスタートガイド
システムとデータのインテグレーションに伴う課題の 1 つは、コンポーネントシステムがさまざまな
データ形式で動作することが多いことです。つまり、受信システムが認識できる形式 (または言語) に
メッセージを変換しなければ、システムから別のシステムにメッセージを送信できません。データ変換
とは、この変換を表す用語です。

この章では、事前定義された Camel ルートにデータ変換を含める方法を説明します。Camel ルート
は、XML データを生成するソースエンドポイントから JSON データを消費するターゲットエンドポイ
ントにメッセージを送信します。ソースの XML データ形式をターゲットの JSON データ形式にマップ
するデータ変換コンポーネントを追加して定義します。

9.1. データ変換サンプルプロジェクトの作成

1. 新規 Fuse Integration プロジェクトを作成します (File → New → Fuse Integration Project を選
択します)。
ウィザードで次の情報を入力します。

プロジェクト名: starter

デプロイメントプラットフォーム: Standalone

ランタイム環境: Karaf/Fuse on Karaf

Camel バージョン: デフォルトを使用

テンプレート: Empty - Blueprint DSL

2. 準備済みデータサンプルを https://github.com/FuseByExample/fuse-tooling-
tutorials/archive/user-guide-11.1.zip からダウンロードします。

3. data フォルダーとそこに含まれる 3 つのファイルを、user-guide-11.1.zip アーカイブから
Fuse Integration プロジェクトの src ディレクトリー (starter/src/data) に展開します。

4. Project Explorer ビューで、スタータープロジェクトを展開します。

5. Camel Contexts → src/main/resources/OSGI-INF/blueprint/blueprint.xml をダブルクリック
して、ルートエディターの Design タブでルートを開きます。

6. Source タブをクリックして基礎となる XML を表示します。

7. <route id="_route1"/> を以下のコードに置き換えます。

<route id="_route1">
  <from id="_from1" uri="file:src/data?fileName=abc-order.xml&amp;noop=true"/>
  <setHeader headerName="approvalID" id="_setHeader1">
    <simple>AUTO_OK</simple>
  </setHeader>
  <to id="_to1" uri="file:target/messages?fileName=xyz-order.json"/>
</route>

8. Design タブをクリックして、ルートのグラフィカル表示に戻ります。
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9.2. CAMEL ルートへのデータ変換ノードの追加

1. Palette で、Transformation ドロワーを展開します。

2. Data Transformation パターンをクリックし、キャンバスで SetHeader _setHeader1 と 
To_to1 ノード間の矢印をクリックします。
New Transformation ウィザードが開き、Dozer File Path フィールドが自動入力されます。
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3. 残りのフィールドに入力します。

Transformation ID フィールド: xml2json を入力します。

Source Type は、ドロップダウンメニューから XML を選択します。

Target Type は、ドロップダウンメニューから JSON を選択します。

4. Next をクリックします。
Source Type (XML) 定義ページが開き、XML Schema (デフォルト) または XML Instance
Document の例を指定して、ソースデータのタイプ定義を指定します。
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5. XML Schema は有効のままにします。

6. Source file での場合は、ソースデータの種類定義に使用する XML スキーマファイルまたは
XML インスタンスファイルの場所を参照して、選択します (ここでは abc-order.xsd)。
XML Structure Preview ペインには、XML 構造のプレビューが表示されます。

7. Element root フィールドに ABCOrder を入力します。
ツールはこのテキストを使用して、マップするソースデータ項目を表示するペインにラベルを
付けます。

Source Type (XML) 定義ページは以下のようになります。
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8. Next をクリックして Target Type (JSON) 定義ページを開きます。ここで、ターゲットデー
タのタイプ定義を指定します。
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9. JSON Instance Document をクリックします。
Target File フィールドに、xyz-order.json インスタンスドキュメントへのパスを入力します。
または、このドキュメントを参照します。JSON Structure Preview ペインには、JSON デー
タ構造のプレビューが表示されます。
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10. Finish をクリックします。

変換エディターが開きます。ここで、XML ソースのデータ項目を JSON ターゲットのデータ項目に
マップできます。

変換エディターは、次の 3 つのパネルで設定されています。

Source —ソ ースの利用可能なデータ項目が一覧表示されます

Mappings — ソースとターゲットのデータ項目間のマッピングが表示されます
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Target — ターゲットの利用可能なデータ項目が一覧表示されます

さらに、エディターの 3 つのパネルのすぐ下にあるエディターの詳細ペイン (最初のマッピングが作成
されると表示) には、現在選択されているマッピング済みのソースデータ項目とターゲットデータ項目
の両方の階層先がグラフィカル表示されます。以下に例を示します。

詳細ペインを使用して、選択したソースおよびターゲットのデータ項目のマッピングをカスタマイズで
きます。

Set property — 既存のマッピングを変更するか、単純なデータ項目をコレクション内の 1 つに
マップします (「単純なデータ項目をコレクションのデータ項目にマッピング」 を参照)。

Set variable — データ項目の定数値を指定します (「定数変数のデータ項目へのマッピング」 を
参照)。

Set expression — データ項目を指定された式の動的評価にマップします (「式のデータ項目へ
のマッピング」 を参照)。

Add transformation — ビルトイン関数を使用して、マップされたデータ項目の値を変更します
(「マップされたデータ項目へのビルトイン関数の追加」 を参照)。

Add custom transformation — 作成した Java メソッドまたは以前に作成したメソッドを使用
して、マップされたデータ項目の値を変更します (「マップされたデータ項目へのカスタム変換
の追加」 を参照)。

9.3. ソースデータ項目をターゲットデータ項目にマッピング

1. Mappings パネルの左右にある Source パネルおよび Target パネルのすべての項目を展開しま
す。

2. Source パネルからデータ項目をドラッグし、Target パネルの対応するデータ項目にドロップ
します。
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たとえば、Source パネルから customerNum データ項目をドラッグし、Target パネルの 
custId データ項目にドロップします。

マッピングは Mappings パネルに表示され、Source と Target の両方のデータ項目の詳細が下
の詳細ペインに表示されます。

3. すべての基本的なマッピングが完了するまで、ソースデータ項目を対応するターゲットデータ
項目にドラッグアンドドロップします。
starter の例では、マッピングする残りのデータ項目は以下のようになります。

ソースソース ターゲットターゲット

orderNum orderId

status priority

id itemId

price cost

quantity amount

注記注記

コレクション (リストまたはセットを含むデータ項目) を非コレクションデータ
項目にマップしたりその逆にマップしたりすることは可能ですが、コレクション
を他のコレクションにマップすることはできません。

4. Source パネルと Target パネルの両方で  をクリックし、すべてのデータ項目がマッピン
グされているかどうかを素早く判別します。
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マッピングされていないデータ項目のみが Source および Target パネルに表示されます。

starter の例では、マッピングされていない残りの Target 属性は approvalCode および origin
です。

5. blueprint.xml タブをクリックして、ルートのグラフィカル表示に戻ります。

6. File → Save をクリックします。

変換テストを作成した後、変換ファイルに対して JUnit テストを実行できます。詳細は、「変換テスト
ファイルの作成と JUnit テストの実行」 を参照してください。この時点でこれを行うと、Console
ビューに次の出力が表示されます。
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ソース XML データの場合:

<?xml version="1.0" encoding="UTF-8"?>
<ABCOrder xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:java="http://java.sun.com">
    <header>
        <status>GOLD</status>
        <customer-num>ACME-123</customer-num>
        <order-num>ORDER1</order-num>
    </header>
    <order-items>
        <item id="PICKLE">
            <price>2.25</price>
            <quantity>1000</quantity>
        </item>
        <item id="BANANA">
            <price>1.25</price>
            <quantity>400</quantity>
        </item>
    </order-items>
</ABCOrder>

ターゲット JSON データの場合:

{"custId":"ACME-123","priority":"GOLD","orderId":"ORDER1","lineItems":[{"itemId":"PICKLE",
"amount":1000,"cost":2.25},{"itemId":"BANANA","amount":400,"cost":1.25

9.4. 変換テストファイルの作成と JUNIT テストの実行

1. Project Explorer ビューで starter プロジェクトを右クリックし、New → Other → Fuse
Tooling → Fuse Transformation Test の順に選択します。

2. Next を選択して New Transformation Test ウィザードを開きます。

3. New Transformation Test ウィザードで、以下の値を設定します。

フィールドフィールド 値値

Package example

Camel File Path OSGI-INF/blueprint/blueprint.xml

Transformation ID xml2json

4. Finish をクリックします。

5. Project Explorer ビューで starter/src/test/java/example に移動し、TransformationTest.java
ファイルを開きます。

6. 以下のコードを transform メソッドに追加します。

startEndpoint.sendBodyAndHeader(readFile("src/data/abc-order.xml"), "approvalID", 
"AUTO_OK");
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7. File → Save をクリックします。
これで、チュートリアルの任意の時点で、変換ファイルに対して JUnit テストを実行できま
す。

8. Project Explorer ビューで、starter プロジェクトを展開し
て、/src/test/java/example/TransformationTest.java ファイルを公開します。

9. それを右クリックしてコンテキストメニューを開き、Run as JUnit Test を選択します。
JUnit Test ペインが開き、テストのステータスが表示されます。ワークスペースが乱雑になる
のを防ぐには、Console ビューの近くにある下部パネルでペインをドラッグアンドドロップし
ます。

10. Console ビューを開き、ログ出力を表示します。

9.5. 定数変数のデータ項目へのマッピング

ソース/ターゲットデータ項目に対応するターゲット/ソースデータ項目がない場合は、定数変数を既存
のデータ項目にマップできます。

starter の例では、ターゲットデータ項目 origin には対応するソースデータ項目がありません。origin
属性を定数変数にマッピングするには、以下を実行します。

1. Source パネルで Variables ビューをクリックします。

2. Variables ビューで  をクリックし、Enter a new variable name ダイアログを開きます。
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3. 作成する変数の名前を入力します。
starter の例では、ORIGIN と入力します。

4. OK をクリックします。
新規作成された変数 ORIGIN は、Variables ビューの Name 列および Value 列のデフォルト値 
ORIGIN に表示されます。

5. デフォルト値をクリックして編集し、値を Web に変更します。

6. Enter キーを押します。

7. 新しい変数 ORIGIN を Target パネルの origin データ項目にドラッグしてドロップします。

変数 $(ORIGIN) の新しいマッピングが Mappings パネルと、詳細ペインに表示されます。

8. TransformationTest.java ファイルで JUnit テストを実行します。詳細は、「変換テストファ
イルの作成と JUnit テストの実行」 を参照してください。
Console ビューには、JSON 形式の出力データが表示されます。

{"custId":"ACME-123","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"itemId":"PICKLE","amount":1000,"cost":2.25},
{"itemId":"BANANA","amount":400,"cost":1.25}]}

9.6. 式のデータ項目へのマッピング
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この機能により、ターゲットデータ項目を Camel 言語式の動的評価にマップできます。

対応するソースデータアイテムがないターゲット approvalCode データアイテムを使用します。

1.  をクリックし、空の変換マッピングを Mappings パネルに追加します。

2. Target パネルから、approvalCode データ項目を Mappings パネルで新しく作成されたマッピ
ングのターゲットフィールドにドラッグアンドドロップします。
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詳細ペインのターゲットボックスにも、approvalCode データ項目が表示されます。

3. 詳細ペインで、ABCOrder ソースボックスの  をクリックして、ドロップダウンメニューを開
きます。

メニューオプションは、選択したデータ項目のデータタイプによって異なります。利用可能な
オプションは太字になっています。

4. Set expression を選択して、Expression ダイアログボックスを開きます。
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5. Language で、利用可能な言語の一覧から使用する式言語を選択します。利用可能なオプショ
ンは、データ項目のデータタイプによって異なります。
starter の例では、Header を選択します。

6. 詳細ペインで、使用する式のソースを選択します。
オプションは Value および Script です。

starter の例では、Value をクリックしてから ApprovalID を入力します。

7. OK をクリックします。
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Mappings パネルと詳細ペインの両方に、ターゲットデータ項目 approvalCode の新しいマッ
ピングが表示されます。

8. TransformationTest.java ファイルで JUnit テストを実行します。詳細は、「変換テストファ
イルの作成と JUnit テストの実行」 を参照してください。
Console ビューには、JSON 形式の出力データが表示されます。

{"custId":"ACME-123","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"itemId":"PICKLE","amount":1000,"cost":2.25},
{"itemId":"BANANA","amount":400,"cost":1.25}]}

9.7. マップされたデータ項目へのカスタム変換の追加

ターゲットシステムの要件を満たしていなければ、ソースデータアイテムのフォーマットを変更する必
要がある場合もあります。

たとえば、すべての顧客 ID を括弧で囲むというターゲットシステムの要件を満たすには、以下を実行
します。

1. Mappings パネルで customerNum マッピングを選択し、詳細ペインに反映させます。

2. 詳細ペインで、ABCOrder ソースボックスの  をクリックして、ドロップダウンメニューを開
きます。
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3. Add custom transformation を選択して、Add Custom Transformation ページを開きます。

4. Class フィールドの横にある  をクリックして、Create a New Java Class ウィザードを
開きます。
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5. 以下のフィールドを変更します。

Package: example を入力します。

Name: MyCustomMapper を入力します。

Method Name: map を brackets に変更します。
その他のフィールドはすべてそのままにします。

6. Finish をクリックします。
Add Custom Transformation ページが開き、Class および Method フィールドが自動的に入力
されます。
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7. OK をクリックして Java エディターで MyCustomMapper.java ファイルを開きます。

8. brackets メソッドを編集して、最後の行 return null; を以下のように変更します。

return "[" + input + "]";

9. transformation.xml タブをクリックし、変換エディターに戻ります。
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詳細ペインは、brackets メソッドが customerNum のデータ項目に関連付けられていることを
示しています。

この brackets メソッドは、ターゲットシステムに送信される前にソース入力で実行されます。

10. TransformationTest.java ファイルで JUnit テストを実行します。詳細は、「変換テストファ
イルの作成と JUnit テストの実行」 を参照してください。
Console ビューには、JSON 形式の出力データが表示されます。

{"custId":"[ACME-123]","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"itemId":"PICKLE","amount":1000,"cost":2.25},
{"itemId":"BANANA","amount":400,"cost":1.25}]}

9.8. 単純なデータ項目をコレクションのデータ項目にマッピング

このチュートリアルでは、Source のすべての id を Target の itemId にマッピングする既存のマッピン
グを変更します。新しいマッピングは、Source の customerNum データ項目を、Target の lineItems
コレクションの 2 番目の項目である itemId にマッピングします。

この変更により、ソースの id は Target の itemId にマッピングされません。

1. Mappings パネルでマッピング id - > itemId を選択し、詳細ペインにマッピングを表示しま
す。
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2. Source ボックスで  をクリックし、ドロップダウンメニューを開き、Set property を選択し
ます。

3. Select a property ページで header ノードを展開し、customerNum を選択します。OK をク
リックして変更を保存します。
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4. 詳細ペインには、XyzOrder に lineItems フィールドがあることが表示されるようになりまし
た。lineItems の横にあるトグルボタンをクリックして、その値を 1 に増やします。

注記注記

インデックスはゼロがベースであるため、1 の値はコレクション内の 2 番目のイ
ンスタンスである itemId を選択します。

詳細ペインには、lineItems コレクションの 2 番目の項目である itemId にマッピングされた 
customerNum が表示されます。

5. TransformationTest.java ファイルで JUnit テストを実行します。詳細は、「変換テストファ
イルの作成と JUnit テストの実行」 を参照してください。
Console ビューには、JSON 形式の出力データが表示されます。

{"custId":"[ACME-123]","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"amount":1000,"cost":2.25},
{"itemId":"ACME-123","amount":400,"cost":1.25}]}

9.9. マップされたデータ項目へのビルトイン関数の追加

ビルトインの文字列関連関数を使用して、マップされたデータ項目に変換を適用できます。

1. Transformations パネルで status から priority へのマッピングを選択し、詳細ペインに反映さ
せます。

2. Source ボックスで  をクリックし、ドロップダウンメニューを開き、Add transformation を
選択します。
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3. Transformations ペインで append を選択し、Arguments ペイン で suffix の値に -level を入
力します。
この append 関数は、status 文字列をターゲットの priority データ項目にマッピングする前
に、指定された接尾辞を文字列の最後に追加します。
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4. OK をクリックします。
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デフォルトでは、詳細ペインには、append 関数を status データ項目に追加した結果がユー
ザーフレンドリーな形式で表示されます。このフォーマットを変更するには、Source ボックス
の右端の  をクリックし、Show standard format を選択します。

5. TransformationTest.java ファイルで JUnit テストを実行します。詳細は、「変換テストファ
イルの作成と JUnit テストの実行」 を参照してください。
Console ビューには、JSON 形式の出力データが表示されます。

{"custId":"[ACME-123]","priority":"GOLD-level","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"amount":1000,"cost":2.25},{"itemId":"ACME-123",
"amount":400,"cost":1.25}]}

9.10. データ変換を使用して FUSE INTEGRATION プロジェクトを RED
HAT FUSE サーバーに公開

データ変換プロジェクトを Fuse サーバーに公開する前に (29章Fuse Integration プロジェクトのサー
バーへの公開を参照)、Fuse ランタイムに以下の機能をインストールする必要があります。

camel-dozer

camel-jackson

camel-jaxb

Fuse ランタイムに必要な機能をインストールするには、以下を行います。

1. まだの場合は Fuse Integration パースペクティブに切り替えます。

2. 必要な場合は、Fuse サーバーを Servers リストに追加します (「サーバーの追加」 を参照)。

3. Fuse Server (「サーバーの起動」 を参照) を起動し、JBoss Fuse シェルが Terminal ビューに
表示されるまで待ちます。

4. 必要な camel- 関数ごとに、JBossFuse:admin@root> のプロンプトで以下を入力します。
features:install camel-<featureName>

ここで、featureName は、dozer、jackson、または jaxb のいずれかです。

5. 各機能が正常にインストールされていることを確認するには、JBossFuse:admin@root> のプ
ロンプトで以下のコマンドを入力します。
features:list --ordered --installed

出力一覧に先ほどインストールした camel 機能が表示されるはずです。
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第10章 FUSE ONLINE インテグレーション用エクステンションの
開発

Fuse Online は、アプリケーションを統合するための Web インターフェイスを提供する Red Hat Fuse
機能です。ビジネスエンジニアは、コードを作成せずに、Fuse Online を使用してアプリケーションに
接続し、任意で異なるアプリケーションへのコネクション間のデータで操作できます。インテグレー
ターが必要とする機能を Fuse Online が提供しない場合、開発者は必要な動作を定義するエクステン
ションを作成できます。

Fuse Tooling を使用して、Fuse Online で使用する機能を提供するエクステンションを開発できます。
エクステンションは、以下を定義します。

インテグレーションでコネクション間のデータを操作する 1 つ以上のカスタム ステップステップ
または

1 つのカスタム コネクターコネクター

Fuse Online では、コネクターコネクター はデータの取得元または送信先となる特定のアプリケーションを表しま
す。各コネクターは、その特定のアプリケーションへの接続を作成するためのテンプレートです。たと
えば、Salesforce コネクターは Salesforce への接続を作成するためのテンプレートです。Fuse Online
で Fuse Online ユーザーが必要とするコネクターが提供されていない場合、カスタムコネクターを定義
するエクステンションを開発できます。

Fuse Online では、インテグレーションのコネクション間で発生するデータ操作を ステップステップ と呼びま
す。Fuse Online は、データのフィルターリングやマッピングなどの操作のステップを提供します。
Fuse Online のビルトインステップでは提供されない方法で接続間のデータを操作するために、1 つ以上
のカスタムステップを定義する Fuse Online エクステンションを開発できます。

注記注記

任意の IDE でエクステンションを開発することもできます。Fuse Tooling と別の IDE の
どちらを使用するかは、完全に個人が選択できます。IDE でのエクステンションの開発
に関する情報は、Integrating Applications with Fuse Online を参照してください。

10.1. タスクの概要

以下は、Fuse Online エクステンションを開発するためのタスクの概要です。

1. Red Hat CodeReady Studio で、Fuse Online エクステンションプロジェクトを作成し、エクス
テンションタイプとして Custom Connector または Custom Step を選択します。

2. エクステンションのタイプに応じて、エクステンションのコードを記述します。

Custom Connector: ベース Camel コンポーネント、コネクターアイコン、グローバルコネ
クタープロパティー、およびコネクターアクションを定義します。

Custom Step: ルートの追加、アクションの定義、および依存関係の指定を行います。

3. .jar ファイルをビルドします。

4. .jar ファイルを Fuse Online ユーザーに提供します。

Fuse Online ユーザーは .jar ファイルを Fuse Online にアップロードし、カスタムコネクターまたはカ
スタムステップを使用できるようにします。Fuse Online とインテグレーションの作成方法
は、Integrating Applications with Fuse Online を参照してください。
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10.2. 前提条件

開始する前に、以下の情報および知識が必要です。

Fuse Online カスタムコネクターまたはステップに必要な機能の説明 (Fuse Online ユーザーか
ら)。

エクステンションの Fuse Online バージョン番号。

カスタムコネクターの場合、PNG または SVG 形式のアイコンイメージファイル。Fuse Online
は、このアイコンをインテグレーションのフローを表示するときに使用します。アイコンを指
定しない場合、エクステンションが含まれる .jar がアップロードされると Fuse Online が 1 つ作
成します。

以下に精通している必要があります。

Fuse Online

Spring Boot XML または Java

Apache Camel ルート (ルートベースのステップエクステンションを作成する場合)

JSON

Maven

10.3. カスタムコネクターの作成

Fuse Online では、カスタムコネクターは 1 つ以上の接続設定パラメーター、1 つ以上の接続アクショ
ン、およびアクションの任意の設定パラメーターで設定されます。

カスタムコネクターを開発するためのタスクの概要を以下に示します。

1. Red Hat CodeReady Studio で、Fuse Online エクステンションプロジェクトを作成し、エクス
テンションタイプとして Custom Connector を選択します。

2. エクステンションのコードを記述します。ベース Camel コンポーネント、コネクターアイコ
ン、グローバルコネクタープロパティー、およびコネクターアクションを定義します。

10.3.1. カスタムコネクターの Fuse Online Extension プロジェクトの作成

Fuse Tooling Fuse Online エクステンションプロジェクトは、カスタムコネクターの開始点を提供しま
す。

Fuse Tooling Fuse Online エクステンションプロジェクトを作成するには、以下の手順に従います。

1. Red Hat CodeReady Studio で New → Project → Red Hat Fuse → Fuse Online Extension
Project を選択します。
New Fuse Online Extension Project ウィザードが開きます。
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2. プロジェクトの名前と場所を入力してから Next をクリックします。
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3. Fuse Online のバージョンを選択します。

4. 以下のエクステンションの詳細を指定します。

ID  — Fuse Online 環境で定義される一意の値。この値は、Fuse Online ユーザーがエクステ
ンションの .jar ファイルをインポートする際に Fuse Online に表示されます。

Name  — エクステンションの名前。この値は、Fuse Online にエクステンション名として表
示されます。Fuse Online の Customizations → Extensions タブで、ユーザーは Fuse
Online にアップロードされたエクステンションの名前と説明を一覧表示できます。

Description  —  オプションの、エクステンションコンテンツの説明。

Version  —  エクステンションのバージョン。たとえば、これが最初のバージョンの場
合、1.0 を入力します。バージョンを更新する場合は、1.1 または 2.0 を入力します。

5. 作成する Fuse Online エクステンションの種類として Custom Connector を選択します。
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6. Finish をクリックします。

新しいプロジェクトが Red Hat CodeReady Studio の Project Explorer ビューに表示されます。これに
は、カスタムコネクターエクステンションの以下のファイルが含まれます。

src/main/resources/META-INF/syndesis フォルダー:

記述子ファイル: syndesis-extension-definition.json
このファイルを編集します。* 最上位のグローバルプロパティー、コネクターアクション、最上位のグローバルプロパティー、コネクターアクション、
アクションプロパティーを追加します。アクションプロパティーを追加します。* エクステンション Id、名前、バージョン、または
説明の値を変更します。

デフォルトのアイコンイメージファイル: icon.png
オプションで、このファイルを独自のアイコンイメージ (PNG または SVG) ファイルに置
き換えることができます。

Maven Project Object Model ファイル: pom.xml
このファイルには、Maven がプロジェクトをビルドするために使用されるプロジェクトおよび
設定詳細に関する情報 (デフォルトのエクステンション依存関係を含む) が含まれます。この
ファイルを編集してカスタム依存関係を追加します。Red Hat が出荷する依存関係のスコープ
が提供されます。以下はその例です。

<dependency>
    <groupId>io.syndesis.extension</groupId>
    <artifactId>extension-api</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.apache.camel</groupId>
    <artifactId>camel-core</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.springframework.boot</groupId>
    <artifactId>spring-boot-starter</artifactId>
    <scope>provided</scope>
</dependency>

10.3.2. カスタムコネクターのコードの記述

Fuse Online エクステンションプロジェクトを作成した後、Fuse Online ユーザーによって提供される必
要な機能の説明を基にして、カスタムコネクター要素を定義するコードを記述します。表10.1「カスタ
ムコネクター要素」 の表は、Fuse Tooling で作成したカスタムコネクター要素が Fuse Online 要素にど
のように対応するか示しています。
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表表10.1 カスタムコネクター要素カスタムコネクター要素

Fuse Tooling 要素要素 Fuse Online 要素要素 説明説明

グローバル (最上位) プロパティー 接続設定パラメーター Fuse Online ユーザーがこのコネ
クターから接続を作成すると、
ユーザーは接続設定の一部として
このプロパティーの値を指定しま
す。

Action 接続アクション Fuse Online では、Fuse Online
ユーザーはこのコネクターから作
成された接続に対して、アクショ
ンの 1 つを選択します。

アクションで定義されたプロパ
ティー

アクション設定パラメーター Fuse Online ユーザーが接続で実
行するアクションを設定する場
合、Fuse Online ユーザーはこの
プロパティーの値をアクション設
定の一部として指定します。

Fuse Online のカスタムコネクターを実装するコードを記述するには、以下を実行します。

1. エディタービューで syndesis-extension-definition.json ファイルを開き、グローバルプロパ
ティー、カスタムコネクターが実行できるアクション、および各アクションのプロパティーを
定義するコードを記述します。
各 グローバルプロパティーグローバルプロパティー は Fuse Online の接続設定パラメーターに対応します。各アクショ
ンプロパティーは Fuse Online コネクションアクション設定パラメーターに対応します。Fuse
Online では、ユーザーがカスタムコネクターを選択すると、Fuse Online が各接続設定パラ
メーターの値を要求します。カスタムコネクターは、OAuth プロトコルを使用するアプリケー
ションのカスタムコネクターであることがあります。この場合、OAuth クライアント ID のグ
ローバルプロパティーと OAuth クライアントシークレットの別のグローバルプロパティーを指
定するようにしてください。Fuse Online ユーザーは、このコネクターから作成された接続が機
能するように、これらのパラメーターの値を指定する必要があります。

各 コネクターアクションコネクターアクション はベース Camel コンポーネントスキームを宣言します。

New Fuse Online Extension Project ウィザードによって提供される例では、telegram Camel コ
ンポーネントスキームを使用します。

{
  "schemaVersion" : "v1",
  "name" : "Example Fuse Online Extension",
  "extensionId" : "fuse.online.extension.example",
  "version" : "1.0.0",
  "actions" : [ {
    "id" : "io.syndesis:telegram-chat-from-action",
    "name" : "Chat Messages",
    "description" : "Receive all messages sent to the chat bot",
    "descriptor" : {
      "componentScheme" : "telegram",
      "inputDataShape" : {
        "kind" : "none"
      },
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      "outputDataShape" : {
        "kind" : "java",
        "type" : "org.apache.camel.component.telegram.model.IncomingMessage"
      },
      "configuredProperties" : {
        "type" : "bots"
      }
    },
    "actionType" : "connector",
    "pattern" : "From"
  }, {
    "id" : "io.syndesis:telegram-chat-to-action",
    "name" : "Send a chat Messages",
    "description" : "Send messages to the chat (through the bot).",
    "descriptor" : {
      "componentScheme" : "telegram",
      "inputDataShape" : {
        "kind" : "java",
        "type" : "java.lang.String"
      },
      "outputDataShape" : {
        "kind" : "none"
      },
      "propertyDefinitionSteps" : [ {
        "description" : "Chat id",
        "name" : "chatId",
        "properties" : {
          "chatId" : {
            "kind" : "parameter",
            "displayName" : "Chat Id",
            "type" : "string",
            "javaType" : "String",
            "description" : "The telegram's Chat Id, if not set will use CamelTelegramChatId from 
the incoming exchange."
          }
        }
      } ],
      "configuredProperties" : {
        "type" : "bots"
      }
    },
    "actionType" : "connector",
    "pattern" : "To"
  } ],
  "properties" : {
    "authorizationToken" : {
      "kind" : "property",
      "displayName" : "Authorization Token",
      "group" : "security",
      "label" : "security",
      "required" : true,
      "type" : "string",
      "javaType" : "java.lang.String",
      "secret" : true,
      "description" : "Telegram Bot Authorization Token"
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    }
  }
}

2. カスタムコネクターに追加の依存関係が必要な場合は、その依存関係をプロジェクトの 
pom.xml ファイルに追加します。依存関係のデフォルトのスコープは runtime です。Red Hat
が出荷する依存関係を追加する場合は、指定されたとおりスコープを定義します。以下はその
例です。

<dependencies>
    <dependency>
          <groupId>org.apache.camel</groupId>
          <artifactId>camel-telegram</artifactId>
          <scope>provided</scope>
    </dependency>
      </dependencies>

カスタムコネクターのコードの作成が終了したら、「Fuse Online エクステンション JAR ファイルのビ
ルド」の説明に従って .jar ファイルをビルドします。

10.4. カスタムステップの作成

Fuse Online エクステンションプロジェクトを作成した後、Fuse Online ユーザーによって提供される必
要な機能の説明を基にして、カスタムステップを定義するコードを記述します。1 つのエクステンショ
ン内では、複数のカスタムステップを定義できます。また、各カスタムステップを Camel ルートまた
は Java Bean で定義できます。

10.4.1. カスタムステップの Fuse Online Extension プロジェクトの作成

Fuse Tooling Fuse Online エクステンションプロジェクトを作成するには、以下の手順に従います。

1. Red Hat CodeReady Studio で New → Project → Red Hat Fuse → Fuse Online Extension
Project を選択します。
New Fuse Online Extension Project ウィザードが開きます。
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2. プロジェクトの名前と場所を入力してから Next をクリックします。
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3. Fuse Online のバージョンを選択します。

4. 以下のエクステンションの詳細を指定します。

ID  — Fuse Online 環境で定義される一意の値。この値は、Fuse Online ユーザーがエクステ
ンションの .jar ファイルをインポートする際に Fuse Online に表示されます。

Name  — エクステンションの名前。この値は、Fuse Online にエクステンション名として表
示されます。Fuse Online の Customizations → Extensions タブで、ユーザーは Fuse
Online にアップロードされたエクステンションの名前と説明を一覧表示できます。

Description  —  オプションの、エクステンションコンテンツの説明。

Version  —  エクステンションのバージョン。たとえば、これが最初のバージョンの場
合、1.0 を入力します。バージョンを更新する場合は、1.1 または 2.0 を入力します。

5. 作成する Fuse Online エクステンションの種類として Custom Step を選択します。

6. カスタムステップのテンプレートを選択します。
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Camel route  —  サンプル Camel ルートを提供します。

Java bean  —  サンプル Java Bean を指定します。

注記注記

選択するテンプレートは、プロジェクトの開始点を提供します。Camel ルー
トと、同じエクステンション内の Java Bean をベースとする 1 つ以上の他の
カスタムステップを作成する場合は、いずれかのテンプレートから開始し、
他のタイプのカスタムステップに必要なファイルおよび依存関係を追加しま
す。

7. Finish をクリックします。

新しいプロジェクトが Red Hat CodeReady Studio の Project Explorer ビューに表示されます。これに
は、カスタムステップ用に選択したテンプレートに応じて、以下のファイルが含まれます。

src/main/resources/META-INF/syndesis フォルダー:

記述子ファイル: syndesis-extension-definition.json
このファイルを編集します: * 1 つ以上のアクションを追加します。つ以上のアクションを追加します。'.json' ファイルのアクファイルのアク
ションはションは Fuse Online のカスタムステップになります。アクション要素では、のカスタムステップになります。アクション要素では、'.json' ファイファイ
ルのプロパティーはルのプロパティーは Fuse Online のステップ設定パラメーターになります。のステップ設定パラメーターになります。* エクステン
ション Id、名前、バージョン、または説明の値を変更します。

Camel ルートテンプレートの場合、Camel コンテキストファイル extensions/log-body-
action.xml
このファイルには、ログコンポーネントを含むサンプルルートが含まれています。この
ファイルで Camel ルートをカスタマイズします。

Java Bean テンプレートの場合、Java ファイル extensions/extension.java
このファイルには、POJO ベースのロギングエクステンションのサンプルが含まれていま
す。

Maven Project Object Model ファイル: pom.xml
このファイルには、Maven がプロジェクトをビルドするために使用されるプロジェクトおよび
設定詳細に関する情報 (デフォルトのエクステンション依存関係を含む) が含まれます。この
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ファイルを編集してカスタム依存関係を追加します。Red Hat が出荷する依存関係のスコープ
が提供されます。以下はその例です。

<dependency>
    <groupId>io.syndesis.extension</groupId>
    <artifactId>extension-api</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.apache.camel</groupId>
    <artifactId>camel-core</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.springframework.boot</groupId>
    <artifactId>spring-boot-starter</artifactId>
    <scope>provided</scope>
</dependency>

10.4.2. カスタムステップのコードの記述

Fuse Online エクステンションプロジェクトを作成した後、Fuse Online ユーザーによって提供される必
要な機能の説明を基にして、カスタムステップを定義するコードを記述します。

表10.2「カスタムステップ要素」 は、Fuse Tooling で作成したカスタムステップ要素が Fuse Online 要
素にどのように対応するか示しています。

表表10.2 カスタムステップ要素カスタムステップ要素

Fuse Tooling 要素要素 Fuse Online 要素要素 説明説明

Action カスタムステップ Fuse Online では、ユーザーがス
テップエクステンションをイン
ポートした後、Choose a step
ページにカスタムステップが表示
されます。

アクションで定義されたプロパ
ティー

カスタムステップ設定パラメー
ター

Fuse Online では、ユーザーがカ
スタムステップを選択すると、
Fuse Online が設定パラメーター
の値を要求します。

Fuse Online のカスタムステップを実装するコードを記述するには、以下を実行します。

1. Camel ルートベースのステップの場合、extension.xml ファイルで、エクステンションの目的
に対応するルートを作成します。各ルートのエントリーポイントは、ステップ 2 で説明されて
いるように、syndesis-extension-definition.json ファイルで定義するエントリーポイントと
一致する必要があります。
Java Bean ベースのステップの場合は、java ファイルを編集します。

2. syndesis-extension-definition.json ファイルで、アクションとそのプロパティーを定義する
コードを作成します。各エントリーポイントに新しいアクションが必要です。

作成する各アクションは Fuse Online のカスタムステップに対応します。アクションごとに、

第第10章章 FUSE ONLINE インテグレーション用エクステンションの開発インテグレーション用エクステンションの開発

129



作成する各アクションは Fuse Online のカスタムステップに対応します。アクションごとに、
異なるタイプのコードを使用できます。つまり、あるアクションに Camel ルートを、別のアク
ションに Java Bean を使用することができます。

各プロパティーは Fuse Online のステップ設定パラメーターに対応します。Fuse Online では、
ユーザーがカスタムステップを選択すると、Fuse Online が設定パラメーターの値を要求しま
す。たとえば、カスタムログステップにはログに送信する情報量を示す level パラメーターが含
まれる場合があります。

エクステンションをアップロードし、そのカスタムステップをインテグレーションに追加した
後に Fuse Online でユーザーが入力するプロパティーを含むエクステンションメタデータが含
まれる .json ファイルのテンプレートは次のとおりです。

{
  "actions": [
    {
      "actionType": "extension",
      "id": "${actionId}",
      "name": "Action Name",
      "description": "Action Description",
      "tags": [
           "xml"
      ],
      "descriptor": {
        "kind": "ENDPOINT|BEAN|STEP",
        "entrypoint": "direct:${actionId}",
        "inputDataShape": {
          "kind": "any"
        },
        "outputDataShape": {
          "kind": "any"
        },
        "propertyDefinitionSteps": []
      }
    }
  ],
  "tags": [
    "feature",
    "experimental"
  ]
}

注記注記

このリリースではタグは無視されます。これらは今後使用するために予約されて
います。

3. エクステンションの依存関係を編集するには、エディターで 'pom.xml' ファイルを開きます。
依存関係を追加する場合は、そのスコープを定義する必要があります。

カスタムステップのコード作成が終了したら、「Fuse Online エクステンション JAR ファイルのビル
ド」の説明に従って .jar ファイルをビルドします。

10.5. FUSE ONLINE エクステンション JAR ファイルのビルド
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エクステンションの .jar ファイルをビルドするには、以下を行います。

1. Project Explorer ビューで、プロジェクトを右クリックします。

2. コンテキストメニューから Run As → Maven clean verify と選択します。

3. Console ビューでは、ビルドの進捗を監視できます。

4. ビルドが完了したら、Project Explorer ビューのターゲットフォルダーを更新します (プロジェ
クトを選択し、F5 を押します)。

5. Project Explorer ビューでターゲットフォルダーを開き、生成された .jar ファイルを確認しま
す。
.jar ファイルの名前は Maven のデフォルト ${artifactId}-${version}.jar に従います。

例: custom:step-camel-1.0.0.jar

この .jar ファイルは、エクステンション、必要な依存関係、そのメタデータ (Extension Id、
Name、Version、Tags、および Description) を定義します。以下に例を示します。

{
    "schemaVersion" : "v1",
    "name" : "Example Fuse Online Extension",
    "description" : "Logs a message body with a prefix",
    "extensionId" : "fuse.online.extension.example",
    "version" : "1.0.0",
    "actions" : [ {
        "id" : "Log-body",
        "name" : "Log Body",
        "description" : "A simple xml Body Log with a prefix",
        "descriptor" : {
            "kind" : "ENDPOINT",
            "entrypoint" : "direct:log-xml",
            "resource" : "classpath:META-INF/syndesis/extensions/log-body-action.xml",
            "inputDataShape" : {
                "kind" : "any"
            },
            "outputDataShape" : {
                "kind" : "any"
            },
            "propertyDefinitionSteps" : [ {
                "description" : "Define your Log message",
                "name" : "Log Body",
                "properties" : {
                    "prefix" : {
                        "componentProperty" : false,
                        "deprecated" : false,
                        "description" : "The Log body prefix message",
                        "displayName" : "Log Prefix",
                        "javaType" : "String",
                        "kind" : "parameter",
                        "required" : false,
                        "secret" : false,
                        "type" : "string"
                    }
                }
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            } ]
        },
        "tags" : [ "xml" ],
        "actionType" : "step"
    } ],
    "dependencies" : [ {
        "type" : "MAVEN",
        "id" : "io.syndesis.extension:extension-api:jar:1.3.0.fuse-000014"
    } ],
    "extensionType" : "Steps"
}

10.6. JAR ファイルを FUSE ONLINE ユーザーに提供

以下を Fuse Online ユーザーに提供します。

.jar ファイル

エクステンションを説明するドキュメント。ステップエクステンションでは、ステップエクス
テンションの各アクションが入力として必要とする、または出力として提供する (データマッピ
ング用) データ形状に関する情報を含めます。

Fuse Online では、ユーザーは Integrating Applications with Fuse Online の説明どおりに .jar ファイル
をアップロードします。
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第11章 新規 CAMEL XML ファイルの作成

概要

Apache Camel は、camelContext 要素が含まれる XML ファイルにルートを保存します。新しい Fuse
Integration プロジェクトを作成する場合、ツールはデフォルトでプロジェクトの一部として Apache
Camel コンテキスト (XML) ファイルを提供します。

必要な事前設定済み namespace およびテンプレート camelContext 要素が含まれる新しい Camel XML
ファイルを追加することもできます。

手順

新しい Apache Camel コンテキストファイルをプロジェクトに追加するには、以下を実行します。

1. 図11.1「Camel XML ファイルウィザード」 に示されるように、メインメニューから File → New
→ Camel XML File を選択し、Camel XML File ウィザードを開きます。

図図11.1 Camel XML ファイルウィザードファイルウィザード

2. RouteContainer で、新規ファイルの場所を入力するか、デフォルトを使用します。
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 をクリックして、適切な場所を検索できます。

重要重要

Spring フレームワークと OSGi Blueprint フレームワークでは、すべての Apache
Camel ファイルをプロジェクトの META-INF または OSGI-INF フォルダーの特
定の場所に配置する必要があります。

Spring - projectName/src/main/resources/META-INF/spring/

OSGi Blueprint - projectName/src/main/resources/OSGI-INF/blueprint/

3. File Name に、新しいコンテキストファイルの名前を入力するか、デフォルト
(camelContext.xml) を受け入れます。
ファイル名にはスペースや特殊文字を含めることはできません。また、JVM 内で一意でなけれ
ばなりません。

4. Framework では、デフォルトを使用するか、ルートが使用するフレームワークを選択します。

Spring  —  Spring コンテナーや OSGi 以外のコンテナーでデプロイされるか、スタンドアロ
ンアプリケーションとしてデプロイされるルート用の [default]

OSGi Blueprint  —  OSGi コンテナーにデプロイされるルート用

Routes: 読み込み既存の camelContext に追加できるルート用

5. Finish をクリックします。
新しいコンテキストファイルがプロジェクトに追加され、ルートエディターで開かれます。
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第12章 CAMEL バージョンの変更
Fuse ツールプロジェクトで作業する場合、使用する Camel のバージョンを変更することをお勧めしま
す。そうすると、たとえば、より新しいバージョンの Camel でサポートされる機能を使用する場合
や、コミュニティーバージョンを使用する場合に役に立ちます。

プロジェクトが使用する Camel バージョンを変更するには、以下を実行します。

1. Project Explorer で、Camel バージョンを変更するプロジェクトを右クリックし、Configure
→ Change Camel Version を選択します。

2. Change Camel Version ウィンドウで、Camel Version フィールドの右側にある下矢印をク
リックし、利用可能な Camel バージョンを表示します。
コミュニティーバージョンの Apache Camel を使用するには、そのバージョン番号 (例: 2.19.2)
を入力します。

3. 必要なバージョンを選択または入力し、Finish をクリックします。

Fuse Tooling は、選択したバージョンが利用可能で、Fuse Tooling によってサポートされるかどうかを
確認します。確認されると、Fuse Tooling は Camel バージョンを変更し、プロジェクトの更新された 
pom.xml ファイルを保存します。選択した Camel バージョンが利用できない、またはサポートされて
いない場合、エラーメッセージが表示されます。

pom.xml ファイルの <camel.version> 要素で、プロジェクトの Camel バージョンを確認できます。
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第13章 既存 MAVEN プロジェクトのインポート

概要

たとえば、アプリケーション開発のテンプレートや開始点として使用するために、既存プロジェクトの
インポートが必要な場合があります。

たとえば、New Fuse Integration Project ウィザードは、以下の Github リポジトリーを参照します。

https://github.com/apache/camel/tree/master/examples

https://github.com/fabric8-quickstarts

https://github.com/wildfly-extras/wildfly-camel-examples

https://github.com/jboss-fuse/quickstarts

プロジェクトサンプルをダウンロードしたら、これを CodeReady Studio にインポートします。

手順

既存の Maven プロジェクトをインポートするには、以下を実行します。

1. File → Import → Maven → Existing Maven Projects の順に選択し、Next をクリックします。

2. ルートディレクトリーには、ダウンロードしたサンプルプロジェクトが含まれているフォル
ダーを選択します。

3. プロジェクト一覧で、インポートするプロジェクトを確認してから Finish をクリックします。
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パート II. ルーティングコンテキストのデバッグ
Camel デバッガーには、ローカルおよびリモートで実行されているルーティングコンテキストのデバッ
グに使用する機能が多数含まれています。

ルートエディターでノードに条件付きおよび無条件のブレークポイントを設定

デバッガーの自動起動および Debug パースペクティブへの切り替え

実行中のルーティングコンテキストとの対話

ブレークポイント間の切り替えでメッセージインスタンスの変数の値を迅速に比較

対象の変数の値を確認して変更

デバッグセッション全体で追跡するために監視一覧に対象の変数を追加

ブレークポイントを無効にして再度有効化

ルーティングコンテキストランタイムでのメッセージフローをグラフィカルに追跡

コンソールログを確認して、Camel およびデバッガーアクションを追跡

注記注記

Camel デバッガーを実行する前に、ルートエディターのキャンバスに表示される対象
ノードにブレークポイントを設定する必要があります。その後、プロジェクトのルー
ティングコンテキストの .xml ファイルで Camel デバッガーを実行し、そのコンテキス
ト内のロジックエラーを見つけ、修正できます。Camel デバッガーを呼び出すと、デ
バッグモードでルーティングコンテキストが実行され、Debug Perspective が開きま
す。
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第14章 ブレークポイントの設定

概要

ブレークポイントを設定するには、ルートエディターの Design タブでプロジェクトのルーティングコ
ンテキストの .xml ファイルを開く必要があります。

Camel デバッガーは、2 種類のブレークポイントをサポートします。

無条件ブレークポイント — デバッグセッション中にブレークポイントが検出されるたびにトリ
ガーされます。

条件付きブレークポイント — デバッグセッション中にブレークポイントの指定条件が満たされ
た場合にのみトリガーされます。

注記注記

コンシューマーエンドポイントまたは when もしくは otherwise ノードにブレークポイ
ントを設定することはできません。

無条件ブレークポイントの設定

ルーティングコンテキストが Design タブのキャンバスに表示されます。

1. デバッグセッション中に状態を検査するノードを選択します。

2.  アイコンをクリックして、無条件ブレークポイントを設定します。

3. 無条件ブレークポイントを設定する各ノードで、この手順を繰り返します。

条件付きブレークポイントの設定

ルーティングコンテキストが Design タブのキャンバスに表示されます。

1. デバッグセッション中に状態を検査するノードを選択します。

2.  アイコンをクリックして、条件付きブレークポイントを設定し、Edit the condition and
language of your breakpoint… ダイアログを開きます。
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3. Language ドロップダウンメニューをクリックし、ブレークポイントをトリガーする条件を作
成するために使用する式の言語を選択します。
Fuse Tooling は、24 の式言語をサポートしています。これらの言語には、条件式を作成するた
めの変数が含まれている場合も、含まれていない場合もあります。

4. Variables をクリックし、選択した言語でサポートされる変数の一覧を表示します。
リストが表示された場合は、1 つ以上の変数を順番に選択して、ブレークポイントをトリガーす
るための条件を作成します。Condition テキストボックスに選択した変数が表示されます。

 が表示された場合には、Condition テキストボックスに式を直
接入力します。

5. 条件付きブレークポイントを設定する各ノードで、[condBpFirst] から[condBpLast] の手順を
繰り返します。

ブレークポイントの無効化

ブレークポイントを一時的に無効にしてそのままにし、後で再度有効にできます。  ボタンは、デ
バッグセッション中に無効にしたブレークポイントをスキップします。

ブレークポイントを無効にするには、キャンバスのノードを選択し、  アイコンをクリックしま
す。ブレークポイントは灰色になり、無効化されたことを示します。

無効にしたブレークポイントを有効にするには、キャンバスのノードを選択し、  アイコンをク
リックします。無効にしたブレークポイントが条件付きか無条件かに応じて黄色または赤色に変化し、
再度有効化されたことを示します。

注記注記
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注記注記

セッションのデバッグ中にブレークポイントを無効にしてから再度有効にすることもで
きます。詳細は、19章実行中のコンテキストでのブレークポイントの無効化 を参照して
ください。

ブレークポイントの削除

個々のブレークポイントまたはすべてのブレークポイントを削除できます。

個別のブレークポイントを削除するには、ルートコンテナーでブレークポイントを削除する

ノードを選択し、その  アイコンをクリックします。

特定のルートにあるすべてのブレークポイントを削除するには、対象のルートのコンテナーを

右クリックし、 
       Delete all breakpoints を選択します。

すべてのルートですべてのブレークポイントを削除するには、キャンバスを右クリックして  

       Delete all breakpoints を選択します。

関連トピック

15章Camel デバッガーの実行
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第15章 CAMEL デバッガーの実行
Camel デバッガーは、ローカルで実行中のルーティングコンテキストと、リモートで実行中のルーティ
ングコンテキストで実行できます。デバッグモードの両方で、同じ基本的な機能と機能を使用できま
す。

ローカルのデバッグ: Fuse Tooling を使用して同じ JVM で実行されているルーティングコンテ
キストでデバッガーを実行します。このモードは、Project Explorer ビューでプロジェクトの
ルーティングコンテキストを選択し、コンテキストメニューから Debug As → Local Camel
Context を選択してアクティベートされます。

リモートデバッグ: ローカルマシンまたはリモートマシン上の別の JVM で実行されているルー
ティングコンテキストでデバッガーを実行します。このモードでは、サポートされているラン
タイムサーバーがローカルマシンまたはアクセス可能なリモートマシンにインストールされて
いる必要があります。これは、リモートランタイムの接続詳細を指定するデバッグ起動設定を
作成して実行することでアクティベートされます。

注記注記

プロジェクトに Java コードが含まれている場合は、標準の Eclipse Java デバッグツール
を使用してデバッグできます。ローカルデバッグの場合は、自動的に利用できます。リ
モートデバッグの場合は、リモート Camel コンテキストおよびコンテキストおよび Java 起動オプションを起動オプションを
使用する必要があります( 「リモートで実行中のルーティングコンテキストのデバッ
グ」を参照してください)。

注記注記

Camel デバッガーを起動する前に、ルーティングコンテキストファイルでブレークポイ
ントを設定する必要があります。

15.1. ローカルで実行中のルーティングコンテキストのデバッグ

手順

1. Project Explorer ビューで、デバッグするルーティングコンテキストファイルを選択します。

2. 選択したファイルを右クリックしてコンテキストメニューを開き、Debug As → Local Camel
Context の順に選択します。
Fuse Tooling は Camel ルートをビルドし、Apache Camel を起動し、ルーティングコンテキス
トを起動し、JMX を有効にし、ルーティングコンテキストでルートを起動し、ブレークポイン
トをノードに追加し、Camel デバッガーを有効にします。

Camel デバッガーは、最初のブレークポイントヒット (メッセージの受信) でルーティングコン
テキストの実行を一時停止し、Debug パースペクティブを開くかどうかを尋ねます。
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3. Yes をクリックして Debug パースペクティブを開きます。
Debug パースペクティブが開き、実行中のルーティングコンテキストで最初に発生した最初の
ブレークポイントでルーティングコンテキストが一時停止されます。

重要重要

ブレークポイントは、デバッガーが自動的に再開した後に最大 5 分間保持され、
次のブレークポイントまたはルーティングコンテキストの最後に移動します。

注記注記

コンソールの出力を表示する場合、パースペクティブをオンにしたときに開いて
いなければ Console ビューを開きます。

注記注記
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注記注記

デフォルトでは、Debug パースペクティブには Outline ビューが表示されま
す。このビューは、実行中のルーティングコンテキストで個別のルートを切り替
える手段を提供します。ルーティングコンテキストに単一のルートが含まれてい
る場合は、Outline ビューを閉じると、他のビューを展開するためのスペースが
解放され、デバッガー出力へのアクセスと調査が容易になります。

ルーティングコンテキストを介したメッセージエクスチェンジの進捗監視

 （ステップオーバー）をクリックして、ルーティングコンテキストで実行の次のノードにジャンプ

します。  （再開）をクリックして、ルーティングコンテキストの次のアクティブなブレークポイン
トで実行を続行します。

15.2. リモートで実行中のルーティングコンテキストのデバッグ

注記注記

リモートホストにデプロイされた Fuse サーバーは、CodeReady Studio の Servers
ビューに登録できません。そのため、CodeReady Studio 内からリモート Fuse サーバー
を起動、自動的に再デプロイ、または停止することはできません。代わりに、
CodeReady Studio 外のデバッグモードで Fuse を起動する必要があります。

前提条件

次のいずれかの方法で Fuse ランタイムにアクセスします。

ローカルマシンに Fuse サーバーをインストールし、Fuse_HOME/etc/users.properties
ファイルを編集して 管理管理 ユーザーをアクティブにします。詳細は、「サーバーの追加」 を
参照してください。

リモートマシンにインストールされている Fuse サーバーにアクセスできます。admin ユー
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リモートマシンにインストールされている Fuse サーバーにアクセスできます。admin ユー
ザーの認証情報を含む接続の詳細を知っている必要があります。

新しい Fuse Integration プロジェクトを作成します。「プロジェクト名とワークスペースの指
定」 を参照してください。Fuse Integration プロジェクトで以下を行います。

Fuse サーバーランタイムのバージョンに一致する Camel バージョンを選択します。

空の Blueprint DSL プロジェクトを作成するか、Blueprint DSL で Fuse の事前定義済みテ
ンプレートの 1 つを使用します。

注記注記

必須ではありませんが、プロジェクトのルーティングコンテキストを Local 
Camel Context として正常に実行できることを確認することが推奨されま
す。詳細は、「ローカル Camel コンテキストとしてルートを実行」  を参照
してください。

注記注記

「リモートデバッグのセットアップと起動」 の例は、Fuse → Content
Based Router の事前定義済みテンプレートおよび Red Hat Fuse 6.3.0 ラン
タイムに基づいています。

In Red Hat CodeReady Studio:

Fuse サーバーを Servers ビューに追加します。詳細は、「サーバーの追加」 を参照してく
ださい。

Fuse サーバーを起動します。詳細は、「サーバーの起動」 を参照してください。

プロジェクトを Fuse Runtime サーバーに公開します。詳細は、「リソース変更時に Fuse
プロジェクトを自動公開」 を参照してください。

プロジェクトのバンドルがデプロイされ、アクティブであることを確認します。詳細
は、「プロジェクトのサーバーへの公開を確認」 を参照してください。

Fuse Runtime サーバーを停止します。詳細は、「サーバーの停止」 を参照してください。

リモートデバッグのセットアップと起動

Fuse にデプロイされたプロジェクトが停止し、サーバーが停止したら、以下のようにリモートデバッ
グを設定して起動する必要があります。

Red Hat CodeReady Studio 外のデバッグモードで Fuse を起動します。
リモートホストにデプロイされた Fuse サーバーは、CodeReady Studio の Servers ビューに登
録できないため、CodeReady Studio 外のデバッグモードで Fuse を起動する必要があります。

CodeReady Studio で、ルートエディターで開かれているプロジェクトのルーティングコンテ
キストのノードにブレークポイントを設定します。

リモートの Camel コンテキストデバッグ設定を作成し、実行します。

JMX Navigator ビューで Fuse ランタイムに接続します。

Fuse ランタイム内で稼働している Camel ルートの入力ノードの JMX Navigator ビューでテス
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Fuse ランタイム内で稼働している Camel ルートの入力ノードの JMX Navigator ビューでテス
トメッセージをドロップします。

ルートのデバッグに Camel デバッガーのツールのいずれかを使用します。

手順

リモートデバッグを設定して起動するには、以下を実行します。

1. Red Hat CodeReady Studio の外部でターミナルを開き、以下を入力します。

$ [FUSE_HOME]/bin/fuse debug

2. Fuse スプラッシュ画面が表示されるのを待ってから、CodeReady Studio の Fuse Integration
パースペクティブに戻ります。

3. ツールのルートエディターで、Design タブでプロジェクトのルーティングコンテキストを開
き、対象のノードにブレークポイントを設定します。詳細は、14章ブレークポイントの設定 を
参照してください。

4. Project Explorer ビューで、プロジェクトのルートを右クリックし、Debug As → Debug
Configurations を選択して Debug Configurations ウィザードを開きます。

5. 設定タイプペインで、Remote Camel Context または Remote Camel Context and Java のい
ずれかを選択し、  をクリックします。
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Remote Camel Context および Remote Camel Context および Java オプションの両方オプションの両方
で、で、Camel およびおよび JMX タブで設定の詳細を指定する必要があります。

Remote Camel Context およびおよび Java オプションのみの場合は、Connect タブで設定の詳細も
指定する必要があります。

注記注記

プロジェクトに標準の Eclipse Java デバッグツールを使用してデバッグする
Java コードが含まれない限り、Remote Camel Context オプションを選択しま
す。

6. 名前 フィールド にに は、新しい起動設定の名前を入力します。

7. Camel タブで Browse ボタンをクリックし、Open Resources ダイアログでプロジェクトの
ルーティングコンテキストの .xml ファイルを見つけます。

注記注記
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注記注記

Matching items ペインでファイルを選択すると、ツールはペインの下部にある
プロジェクトルートに対するファイルの場所を表示します。

8. Matching items ペインで、リストからプロジェクトのルーティングコンテキストファイルを選
択し、OK をクリックします。
このツールは、ファイルのパスを Select Camel Context file フィールドに挿入します。

9. JMX タブをクリックします。

以下のように JMX 接続の詳細を編集します。

JMX Uri EOF-EOFchange :9011/jmxrmi to :1099/karaf-root
Fuse サーバーがリモートホストで実行している場合は、localhost をリモートホストの
DNS 名または IP アドレスに置き換えます。
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JMX User psyc-psycenter admin.

JMX Password psyc-psycenter admin.

重要重要

JMX User および JMX Password に示される値
は、Fuse_HOME/etc/users.properties ファイルに保存される Fuse 管理管理
ユーザーのデフォルトです。設定が異なる場合は、それに固有の値を入力し
ます。

リモートリモート Camel コンテキストコンテキスト デバッグ起動設定を作成する場合は、完了しま
す。[debugCfgGo] に進みます。

10. Connect タブをクリックします。

Port の値を 8000 から 5005 に変更します。その他のプロパティーはそのままにしておきま
す。

11. Apply をクリックしてから Debug をクリックします。

12. JMX Navigator ビューで、Fuse [xxx] [Disconnected] をダブルクリックして接続し、そのツ
リーを展開します。

13. Project Explorer ビューで、テストメッセージを src/test/resources/data からドラッグ
し、JMX Navigator ビューの cbr-example-context/Endpoints/file/work/cbr/input フォル
ダーにドロップします。
ルーティングコンテキストで設定された最初のブレークポイントにメッセージが到達すると、
ツールは Debug パースペクティブに切り替えるように要求します。

Red Hat Fuse 7.7 Tooling ユーザーガイドユーザーガイド

148



14. Yes をクリックします。

この時点で、任意の Camel デバッガーのツールを使用して、ルーティングコンテキストをデ
バッグできます。

注記注記

リモートデバッグセッションでは、Console ビューにログ出力は表示されませ
ん。

注記注記

1 つのメッセージがルーティングコンテキストの最後に到達すると、デバッガー
は一時停止されます。デバッグを続行するには、Fuse Integration パースペク
ティブに戻し、JMX Navigator ビューの入力ノードに別のメッセージをドロッ
プします。そうするたびに、ツールは Debug パースペクティブへの切り替えを
確認するように要求します。
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関連トピック

16章Camel デバッガーの停止

Red Hat Fuse 7.7 Tooling ユーザーガイドユーザーガイド

150



第16章 CAMEL デバッガーの停止

概要

Camel デバッガーを停止する方法は、実行中のモードによって異なります。

ローカルのデバッグ(「ローカルで実行中のルーティングコンテキストのデバッグ」)

Camel デバッガーを停止するには、デバッグセッションが終了した場合にメニューバーの 

をクリックします。それ以外の場合は、  を 2 回クリックします。1 回目は現在実行中のノー
ドスレッドを終了し、1 回は Camel Context スレッドを終了します（両方とも Debug ビュー
に表示されます）。

注記注記

Camel デバッガーを終了するとコンソールも終了しますが、出力はクリアされ

ません。出力をクリアするには、Console ビューのメニューバーで  （コン
ソールをクリア）をクリックします。

リモートデバッグ(「リモートで実行中のルーティングコンテキストのデバッグ」)
Camel デバッガーを停止するには、[Remote Camel Context] スレッドまたは Debug ビュー

で [Remote Camel Context and Java] スレッドを選択してから、メニューバーの  をク
リックします。

注記注記

Camel デバッガーを終了しても、Servers ビューまたは JMX Navigator ビュー
でリモートランタイムサーバーへの接続は閉じません。

CAMEL デバッガーを閉じる

プロジェクトのデバッグが終了したら、Debug パースペクティブを閉じて、ワークベンチのスペース
を増やすことができます。

これを行うには、CodeReady Studio ツールバーの右側にある  を右クリックし、Close を
選択します。

関連トピック

15章Camel デバッガーの実行
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第17章 変数値の変更

概要

Camel デバッガーがブレークポイントに到達すると、Variables ビューにはルーティングコンテキスト
のその時点で利用可能なすべての変数の値が表示されます。一部の変数は編集可能で、値を変更できま
す。これにより、アプリケーションがプログラム状態の変更をどのように処理するか確認できます。

注記注記

すべての変数が編集可能というわけではありません。編集可能な変数のコンテキストメ
ニューには、Change Value… オプションが表示されます。

手順

変数の値を変更するには、以下を実行します。

1. 必要に応じてデバッガーを起動します。15章Camel デバッガーの実行を参照してください。

2. Variables ビューで、変更する値の変数を選択し、その Value フィールドをクリックします。

変数の value フィールドが薄い青の網掛け表示になり、編集モードであることを示します。

注記注記

または、変数を右クリックしてコンテキストメニューを開き、Change Value… 
を選択して値を編集します。

3. 新しい値を入力してから、Enter をクリックします。
Console ビューには、変数の値の変更に関する INFO レベルのログエントリーが表示されます
(たとえば、Breakpoint at node to1 is updating message header on exchangeId: ID-dhcp-
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97-16-bos-redhat-com-52574-1417298894070-0-2 with header: Destination and value: 
UNITED KINGDOM)。

4. ブレークポイントをステップピングし、メッセージが想定どおりに処理されているかどうかを
確認します。各ステップで Debug ビュー、Variables ビュー、および Console の出力を確認し
ます。

関連トピック

19章実行中のコンテキストでのブレークポイントの無効化

18章ウォッチリストへの変数の追加

第第17章章 変数値の変更変数値の変更
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第18章 ウォッチリストへの変数の追加

概要

変数をウォッチリストに追加すると、特定の変数にフォーカスして、ルーティングコンテキストを通過
する際に、値が想定どおりに変化するかどうかを確認できます。

手順

ウォッチリストに変数を追加するには、以下を実行します。

1. 必要に応じてデバッガーを起動します。15章Camel デバッガーの実行を参照してください。

2. Variables ビューで、追跡する変数を右クリックして、コンテキストメニューを開きます。

3. Watch を選択します。
新しいビューである Expressions が、Breakpoints ビューの横に開きます。Expressions
ビューには、監視される変数の名前と現在の値が表示されます。以下はその例です。
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4. [watch1] および [watch2] を繰り返し、ウォッチリストに変数を追加します。

注記注記

追加する変数は、削除されるまでウォッチリストに残ります。変数の監視を停止
するには、リストで変数を右クリックしてコンテキストメニューを開
き、Remove をクリックします。

5. Expressions ビューが開いたら、ルーティングコンテキストでステップを実行し、ウォッチリ
ストの各変数がルートの各ステップに到達した際にどのように変化するか追跡します。

関連トピック

17章変数値の変更

第第18章章 ウォッチリストへの変数の追加ウォッチリストへの変数の追加
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第19章 実行中のコンテキストでのブレークポイントの無効化

概要

Breakpoints ビューで、実行中のルーティングコンテキストのブレークポイントを無効にして再度有効
にできます。

ブレークポイントが無効になっている場合、  ボタンにより、デバッガーはデバッグセッション時に
そのブレークポイントをスキップします。

ブレークポイントビューでのブレークポイントの無効化と有効化

ブレークポイントがすべて有効な状態で、Breakpoints ビューが開きます。

ブレークポイントを無効にするには、そのチェックボックスの選択を解除します。
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無効にする各ブレークポイントについて、Console ビューに INFO レベルのログエントリーが表示さ
れ、無効になったことが示されます (例: Removing breakpoint log2)。同様に、再度有効にする各ブ
レークポイントについて、Console ビューに INFO レベルのログエントリーが表示され、有効になった
ことが示されます (例: Adding breakpoint log2)。

注記注記

無効にしたブレークポイントを再度有効にするには、チェックボックスをクリックしま
す。Console ビューに INFO レベルのログエントリーが表示され、ブレークポイントが
選択したノードに追加されたことが示されます。
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パート III. アプリケーションの監視とテスト
JMX Navigator ビューは、Fuse アプリケーションを監視およびテストする方法を多数提供します。

注記注記

Managing Fuse の説明どおりに、Fuse Console で Fuse アプリケーションを監視するこ
ともできます。
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第20章 JMX ナビゲーター
図20.1「JMX ナビゲータービュー」 に示される JMX Navigator ビューには、アプリケーションで実行
されているすべてのプロセスが表示され、監視機能とテスト機能のインタラクションが促進されま
す。Fuse Integration パースペクティブの他の領域は、JMX Navigator ビューで選択したノードに関
連する情報を表示します。JMX Navigator ビューでは、そのコンテキストメニューで、ルートトレー
スを有効にして JMS 宛先を追加するために必要なコマンドが提供されます。

図図20.1 JMX ナビゲータービューナビゲータービュー

デフォルトでは、JMX Navigator ビューはローカルマシンで実行されているすべての JMX サーバーを
検出し、以下のカテゴリーに一覧表示します。

ローカルプロセス

サーバー接続
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ユーザー定義の接続

注記注記

サーバーの JMX URL を使用すると、他の JMX サーバーを追加できます。詳細
は、「JMX サーバーの追加」 を参照してください。

20.1. JMX でのプロセスの表示

概要

JMX Navigator ビューには、一連のツリー内の既知のプロセスがすべて一覧表示されます。各ツリー
のルートは JMX サーバーです。

一覧の最初のツリーは、ローカルマシンで実行しているすべての JMX サーバーが含まれる特別な
Local Processes ツリーです。JMX サーバーの 1 つに接続し、含まれるプロセスを確認する必要があり
ます。

ローカル JMX サーバーでのプロセスの表示

ローカル JMX サーバーのプロセスに関する情報を表示するには、以下を行います。

1. JMX Navigator ビューで Local Processes を展開します。

2. Local Processes で、最上位エントリーのいずれかをダブルクリックして接続します。

3. エントリーの横に表示される  アイコンをクリックし、JVM で実行されているコンポーネン
トの一覧を表示します。

代替 JMX サーバーでのプロセスの表示

代替 JMX サーバーのプロセスに関する情報を表示するには、以下を実行します。

1. JMX Navigator ビューに JMX サーバーを 「JMX サーバーの追加」 します。

2. JMX Navigator ビューで、エントリーの横にある  アイコンを使用してサーバーのエント
リーを展開します。JVM で実行されている JMX サーバーのコンポーネント一覧が表示されま
す。

20.2. JMX サーバーの追加

概要

JMX Navigator ビューで、ツリーの Local Processes ブランチのにローカル JMX サーバーの一覧が表
示されます。他のマシンにデプロイされたコンポーネントを表示する場合は、特定の JMX サーバーに
接続する必要がある場合があります。

JMX サーバーを追加するには、追加するサーバーの JMX URL を知っている必要があります。

手順

JMX サーバーを JMX Navigator ビューに追加するには、以下を行います。
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1. JMX Navigator ビューで、New Connection  をクリックします。

2. Create a new JMX connection ウィザードで Default JMX Connection を選択します。

3. Next をクリックします。

4. Advanced タブを選択します。

5. Name フィールドに、JMX サーバーの名前を入力します。
名前には任意の文字列を指定できます。これは、JMX Navigator ツリーのエントリーにラベル
を付けるために使用されます。

6. JMX URL フィールドに、サーバーの JMX URL を入力します。

7. JMX サーバーに認証が必要な場合は、Username フィールドおよび Password フィールドに
ユーザー名とパスワードを入力します。

8. Finish をクリックします。
新しい JMX サーバーが、User-Defined Connections ツリーにブランチとして表示されます。
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第21章 コンポーネントの JMX 統計情報の表示

概要

このツールは、Fuse コンポーネントによって報告されるすべての JMX 統計情報を収集し、Properties
ビューに表示します。この統計情報により、インテグレーションアプリケーションで何が起こっている
かについて重要な洞察を得ることができます。

JMX 統計情報は、Properties、Processor、Profile の 3 つのカテゴリーに分類されます。

手順

Fuse コンポーネントの統計情報を表示するには、以下を行います。

1. JMX Navigator ビューで、コンポーネントのノードを見つけます。
下位コンポーネントを見つけるには、ツリー上でノードを展開する必要がある場合がありま
す。

2. 統計情報を確認する Fuse コンポーネントのノードを選択します。

3. Properties ビューを開きます。

4. Properties ページには、選択したコンポーネントの JMX プロパティーが表示されます。

5. Processors をクリックし、選択したコンポーネントのエクスチェンジメトリクスを確認しま
す。

6. Profile をクリックして、選択したノードとそのサブノードのメッセージメトリクスを確認しま
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6. Profile をクリックして、選択したノードとそのサブノードのメッセージメトリクスを確認しま
す。
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第22章 メッセージの参照

概要

分散環境でアプリケーションをデバッグする際の重要なツールは、アプリケーションの JMS 宛先およ
びルートエンドポイントに格納されているすべてのメッセージを確認します。ツールは以下を参照でき
ます。

JMS 宛先

JMS ルーティングエンドポイント

Apache Camel ルーティングエンドポイント

SEDA ルーティングエンドポイント

ルーティングエンドポイントの参照

Mock ルーティングエンドポイント

仮想マシンルーティングエンドポイント

DataSet ルーティングエンドポイント

手順

メッセージを参照するには、以下を行います。

1. JMX Navigator ビューで、参照する JMS 宛先またはエンドポイントを選択します。
メッセージの一覧は Messages View に表示されます。

2. Messages View で、検査する個別のメッセージを選択します。

メッセージの詳細とコンテンツが Properties ビューに表示されます。
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関連トピック

「ルーティングコンテキストを介したメッセージのトレース」

第第22章章 メッセージの参照メッセージの参照
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第23章 ルートのトレース
ルートをデバッグするには、以下の 2 つの問題のいずれかを解決する必要がある場合があります。

メッセージが適切に変換されない。

メッセージが宛先エンドポイントに到達しない。

ルートを介して 1 つ以上のテストメッセージをトレースすることは、このような問題の原因を見つける
最も簡単な方法です。

ツールのルートトレース機能を使用すると、メッセージがルートを通過するパスを監視し、メッセージ
がプロセッサーからプロセッサーに渡されるときにどのように変換されるかを確認できます。

Diagram View はルートをグラフィカル表示します。これにより、メッセージが通過するパスを表示で
きます。ルート内の各プロセッサーでは、ルートの起動後に処理されたすべてのメッセージの平均処理
時間 (ミリ秒単位) と、ルートの起動後に処理されたメッセージ数も表示されます。

Messages View には、JMX Navigator ツリーで選択した JMS 宛先またはルートエンドポイントによっ
て処理されたメッセージが表示されます。Messages View で個別のメッセージトレースを選択する
と、Properties ビューにメッセージの詳細な情報とコンテンツが表示され、Diagram View で関連ノー
ドが強調表示されます。

ルートを使用したメッセージのトレースには、以下のステップが含まれます。

1. 「ルートトレース用テストメッセージの作成」

2. 「ルートトレースの有効化」

3. 「ルーティングコンテキストを介したメッセージのトレース」

4. 「ルートトレースの無効化」

23.1. ルートトレース用テストメッセージの作成

概要

ルートトレースは、あらゆる種類のメッセージ構造で機能します。Fuse Message ウィザードは空の 
.xml メッセージを作成し、任意のメッセージ構造を設定することができます。

注記注記

テストメッセージを保存するフォルダーが存在しない場合は、メッセージを作成する前
に作成する必要があります。

テストメッセージを格納する新規フォルダーの作成

新規フォルダーを作成するには、以下を実行します。

1. Project Explorer ビューで、プロジェクトルートを右クリックしてコンテキストメニューを開
きます。

2. New → Folder を選択して New Folder ウィザードを開きます。
プロジェクトルートが Enter or select the parent folder に表示されます。
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3. プロジェクト階層のグラフィカル表示でノードを展開し、親フォルダーとして使用するノード
を選択します。

4. Folder name フィールドに新規フォルダーの名前を入力します。

5. Finish をクリックします。
新規フォルダーが Project Explorer ビューの選択した親フォルダーの下に表示されます。

注記注記

新規フォルダーが表示されない場合は、親 foler を右クリックし、Refresh を選
択します。

テストメッセージの作成

テストメッセージを作成するには、以下を実行します。

1. Project Explorer ビューで、プロジェクトを右クリックしてコンテキストメニューを開きま
す。

2. New → Fuse Message を選択して New File ウィザードを開きます。

3. プロジェクト階層のグラフィカル表示でノードを展開し、新しいテストメッセージを保存する
フォルダーを選択します。

4. File name フィールドにメッセージの名前を入力するか、デフォルト (message.xml) を受け入
れます。

5. Finish をクリックします。
XML エディターで新しいメッセージが表示されます。

6. メッセージの内容 (ボディーとヘッダーテキストの両方) を入力します。

注記注記

入力したヘッダーテキストによっては、No grammar constraints (DTD or XML 
Schema) referenced in the document という警告が表示される場合がありま
す。この警告は無視しても問題ありません。

関連トピック

「ルーティングコンテキストを介したメッセージのトレース」

23.2. ルートトレースの有効化

概要

ルーティングコンテキストでメッセージをトレースする前に、ルーティングコンテキストのルートト
レースを有効にする必要があります。

手順

ルーティングコンテキストでトレースを有効にするには、以下を実行します。

1. JMX Navigator ビューで、トレースを開始する実行中のルーティングコンテキストを選択しま
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1. JMX Navigator ビューで、トレースを開始する実行中のルーティングコンテキストを選択しま
す。

注記注記

コンテキストで任意のルートを選択し、コンテキスト全体でトレースを開始でき
ます。

2. 選択したルーティングコンテキストを右クリックしてコンテキストメニューを開き、Start
Tracing を選択してトレースを開始します。
コンテキストメニューで Stop Tracing Context が有効になっている場合、トレースはすでにア
クティブです。

関連トピック

「ルーティングコンテキストを介したメッセージのトレース」

「ルートトレースの無効化」

23.3. ルーティングコンテキストを介したメッセージのトレース

概要

ルーティングコンテキストで何が起こるかを確認する最善の方法は、停止ごとにメッセージに対して何
が起こるかを監視することです。このツールは、実行中のルーティングコンテキストにメッセージをド
ロップし、メッセージが通過するパスを追跡するメカニズムを提供します。

手順

ルーティングコンテキストを介してメッセージをトレースするには、以下を実行します。

1. 「ルートトレース用テストメッセージの作成」 の説明に従って、テストメッセージを 1 つ以上
作成します。

2. Project Explorer ビューで、プロジェクトの Camel コンテキストファイルを右クリックしてコ
ンテキストメニューを開き、Run As → Local Camel Context (Tests なしなし) を選択します。

注記注記

プロジェクトの包括的な JUnit テストを作成していない場合は、これを Local
Camel Context として実行しないでください。

3. 「ルートトレースの有効化」 の説明に従って、実行中のルーティングコンテキストのトレース
を有効にします。

4. Project Explorer ビューから、テストメッセージの 1 つを JMX Navigator ビューのルーティン
グコンテキスト開始点にドラッグします。

5. JMX Navigator ビューで、トレース対象のルーティングコンテキストを選択します。
ツールは、Messages View に、トレースされたコンテキストの各段階でメッセージを表すメッ
セージインスタンスを設定します。

Diagram View には、選択したルーティングコンテキストがグラフィカル表示されます。
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6. Messages View で、メッセージインスタンスの 1 つを選択します。
Properties ビューには、メッセージインスタンスの詳細と内容が表示されます。

Diagram View では、選択したメッセージインスタンスに対応するルートステップが強調表示
されます。ルートステップが処理ステップである場合、ツールは既存のパスにタイミングと処
理のメトリクスをタグ付けします。

7. 必要に応じて、この手順を繰り返します。

関連トピック

「ルートトレース用テストメッセージの作成」

「ルートトレースの有効化」

「ルートトレースの無効化」

23.4. ルートトレースの無効化

概要

ルーティングコンテキストでルートのデバッグが完了したら、トレースを無効にする必要があります。

重要重要

トレースを無効にすると、トレースが停止し、ルーティングコンテキスト内のすべての
ルートのトレースデータがフラッシュされます。つまり、過去のトレースセッションは
確認できなくなります。

手順

ルーティングコンテキストのトレースを停止するには、以下を実行します。

1. JMX Navigator ビューで、トレースを無効にする実行中のルーティングコンテキストを選択し
ます。

注記注記

コンテキストで任意のルートを選択し、コンテキストのトレースを停止できま
す。

2. 選択したルーティングコンテキストを右クリックしてコンテキストメニューを開き、Stop
Tracing Context を選択します。
Start Tracing がコンテキストメニューに表示される場合、そのルーティングコンテキストに対
するトレースは有効になっていません。

関連トピック

「ルートトレースの有効化」

「ルーティングコンテキストを介したメッセージのトレース」
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第24章 JMS 宛先の管理
JMX Navigator ビューを使用すると、Red Hat Fuse の実行中のインスタンスで JMS 宛先を追加または
削除できます。

重要重要

これらの変更は、ブローカーの再起動後は維持されません。

24.1. JMS 宛先の追加

概要

新しいシナリオをテストする場合は、新しい JMS 宛先をブローカーの 1 つに追加すると便利です。

手順

JMS 宛先をブローカーに追加するには、以下を実行します。

1. JMX Navigator ビューの宛先を追加するブローカーノードで、Queues の子または Topics の
子を選択します。

2. 選択したノードを右クリックしてコンテキストメニューを開き、Create Queue または Create
Topic のいずれかを選択します。

3. Create Queue または Create Topic のダイアログボックスで、新しい宛先の名前を入力しま
す。

4. OK をクリックします。

5. Queues または Topics の子を右クリックし、Refresh を選択します。
Queues または Topics 子のの下にある JMX Navigator ビューに新しい宛先が表示されます。

関連トピック

「JMS 宛先の削除」

24.2. JMS 宛先の削除

概要

フェイルオーバーのシナリオ、または障害処理に関連するその他のシナリオをテストする場合は、JMS
宛先を簡単に削除できると便利です。

手順

JMS 宛先を削除するには、以下を実行します。

1. JMX Navigator ビューの Queues または Topics の子で、削除する JMS 宛先を選択します。

2. 選択した宛先を右クリックしてコンテキストメニューを開き、Delete Queue/Topic を選択し
ます。
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関連トピック

「JMS 宛先の追加」

第第24章章 JMS 宛先の管理宛先の管理
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第25章 ルーティングエンドポイントの管理
JMX Navigator ビューを使用すると、ルーティングエンドポイントを追加または削除できます。

重要重要

これらの変更は、ルーティングコンテキストの再起動後は維持されません。

25.1. ルーティングエンドポイントの追加

概要

新しいシナリオをテストする場合には、新しいエンドポイントをルーティングコンテキストに追加する
ことをお勧めします。

手順

エンドポイントをルーティングコンテキストに追加するには、以下を実行します。

1. JMX Navigator ビューのルーティングコンテキストノードで、エンドポイントを追加する
Endpoints の子を選択します。

2. 選択したノードを右クリックしてコンテキストメニューを開き、Create Endpoint を選択しま
す。

3. Create Endpoint ダイアログで、新しいエンドポイントを定義する URL を入力します (例: 
file://target/messages/validOrders)。

4. OK をクリックします。

5. ルーティングコンテキストノードを右クリックし、Refresh を選択します。
新しい宛先は、Endpoints ノードの JMX Navigator ビューで、エンドポイントのタイプに対応
するフォルダーに表示されます (例: file)。

関連トピック

「ルーティングエンドポイントの削除」

25.2. ルーティングエンドポイントの削除

概要

フェイルオーバーのシナリオ、または障害処理に関連するその他のシナリオをテストする場合は、ルー
ティングコンテキストからエンドポイントを削除できると便利です。

手順

ルーティングエンドポイントを削除するには、以下を実行します。

1. JMX Navigator ビューで、削除するエンドポイントを選択します。

2. 選択したエンドポイントを右クリックしてコンテキストメニューを開き、Delete Endpoint を
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2. 選択したエンドポイントを右クリックしてコンテキストメニューを開き、Delete Endpoint を
選択します。
ツールがエンドポイントを削除します。

3. 削除したエンドポイントをビューから削除するには、Endpoints ノードを右クリック
し、Refresh を選択します。
エンドポイントは JMX Navigator ビューから消えます。

注記注記

プロジェクトを再実行することなくエンドポイントのノードを Project Explorer
ビューから削除するには、ノードを右クリックして Delete を選択し、明示的に
削除する必要があります。ビューから削除するには、プロジェクト表示を更新し
ます。

関連トピック

「ルーティングエンドポイントの追加」

第第25章章 ルーティングエンドポイントの管理ルーティングエンドポイントの管理
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第26章 実行中のルートの編集

概要

プロジェクトのルーティングコンテキストを変更せずに、実行中のルートへの変更を試すことができま
す。

これを行うには、以下を行います。

JMX Navigator ビューで、実行中のルーティングコンテキストの Edit Routes オプションを有
効にします。
これにより、ルートエディターでその in-memory モデル (Remote CamelContext:
<camelContextId>) が開きます。

ルートエディターで、ルーティングコンテキストの in-memory モデルを変更します。同時に、
Camel デバッガーとそのすべての機能を使用するために、関連するノードにブレークポイント
を設定できます。
in-memory インメモリーモデルを編集して、ノードの追加、削除、または再配置、既存ノード
のプロパティーの追加または削除、既存ノードに設定されているプロパティー値の変更を行え
ます。実行中のコンテキストを更新して Debug パースペクティブに結果を表示するには、in-
memory モデルに加えた変更を保存する必要があります。

JMX Navigator ビューで、実行中のルーティングコンテキストにメッセージをドロップする
か、タイマー、ActiveMQ、ファイル、またはその他の継続的な入力ノードからメッセージが到
着するのを待ちます。

Debug パースペクティブでは、結果を評価し、Camel デバッガーを使用してルーティングコン
テキストの詳細を把握します。

実行中のルートの変更および結果の評価

1. JMX Navigator ビューで、編集するルートが含まれるルーティングコンテキストを選択しま
す。

2. 選択したルーティングコンテキストを右クリックしてコンテキストメニューを開き、Edit
Routes を選択します。
ルートエディターがルーティングコンテキストの in-memory モデル (Remote CamelContext:
<contextId>) を開き、コンテキスト内のすべてのルートを表示します。以下はその例です。
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注記注記

<contextId> は、プロジェクトのルーティングコンテキストの xml ファイルの 
camelContext 要素の ID です。Fuse → Content Based Router のビルトインテ
ンプレートをベースとするこの例では、ID は cbr-example-context です。

3. 2章ルートエディターを使用したルーティングコンテキストの編集 の説明に従ってルートを編
集し、File → Save を選択して in-memory モデルに加えた変更を保存し、実行中のルーティン
グコンテキストを更新します。

4. 14章ブレークポイントの設定 の説明に従って、関連するノードにブレークポイントを設定しま
す。

5. JMX Navigator ビューで、実行中のルーティングコンテキストの入力ノードにメッセージをド
ロップします。
プロジェクトにテストメッセージが含まれていない場合は、「ルートトレース用テストメッ
セージの作成」 の説明に従って作成できます。

6. Yes をクリックし、Debug パースペクティブに切り替えます。

7. Camel デバッガーで、通常どおり (15章Camel デバッガーの実行 を参照) ブレークポイントを
介してメッセージをステップし、変更によって生成される結果を確認します。
Camel デバッガーは、Edit Routes モードでも通常のデバッグモードと同じように動作するた
め、メッセージがルーティングコンテキストを通過している間、Camel デバッガーの任意の機
能を使用できます。

注記注記

メッセージがルーティングコンテキストの最後に到達すると、デバッガーが停止
します。デバッグを続行するには、Fuse Integration パースペクティブに戻
し、JMX Navigator ビューの入力ノードに別のメッセージをドロップします。
そうするたびに、ツールは Debug パースペクティブへの切り替えを確認するよ
うに要求します。
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注記注記

ルート編集セッション中に、実行中のルーティングコンテキストへの接続が失わ
れる可能性があります。この場合は、JMX Navigator ビューに次のように表示
されます: Local Processes → maven[xxxx][Disconnected]。セッションを続行
するには、実行中のルーティングコンテキストに再接続し、JMX Navigator
ビューでこれを選択してから Edit Routes を再度選択する必要があります。

ルート編集セッションの終了

1. Debug パースペクティブの Debug ビューで、Remote Camel Debug - camelContext--
<contextId>--xxxxxxxxxxxxxxxxxx.xml [Remote Camel Context] スレッドを選択し、メ

ニューバーの  をクリックしてデバッグセッションを終了します。

2. コンソールコンソール ビューのメニューバーで  をクリックし、ルーティングコンテキストを終了しま
す。

3. コンソール出力をクリアする場合は、Console ビューのメニューバーの  をクリックしま
す。

4. Fuse Integration パースペクティブに切り替え、ルートエディターで Remote CamelContext:

<contextId> タブの  をクリックし、ルーティングコンテキストファイルのメモリー内モデ
ルを閉じます。

関連トピック

2章ルートエディターを使用したルーティングコンテキストの編集

パートII「ルーティングコンテキストのデバッグ」
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第27章 ルーティングコンテキストの管理
JMX Navigator ビューを使用すると、実行中のルーティングコンテキストを一時停止および再開でき
ます。

27.1. ルーティングコンテキストの一時停止操作

概要

このツールを使用すると、JMX Navigator ビューでルーティングコンテキストの操作を一時停止でき
ます。コンテキスト操作を一時停止すると、コンテキストのすべてのルートが正常にシャットダウンさ
れますが、操作を再開できるようにメモリーにロードされた状態を維持します。

手順

ルーティングコンテキストの操作を一時停止するには、以下を実行します。

1. JMX Navigator ビューで、プロジェクトの Camel Contexts ノードを展開し、一時停止する操
作のルーティングコンテキストを選択します。

2. 選択したルーティングコンテキストを右クリックしてコンテキストメニューを開き、Suspend
Camel Context を選択します。

注記注記

コンテキストメニューに Resume Camel Context が表示される場合、コンテキ
ストの操作はすでに一時停止されています。

関連トピック

「ルーティングコンテキストの再開操作」

27.2. ルーティングコンテキストの再開操作

概要

ツールを使用すると、JMX Navigator ビューで一時停止されたルーティングコンテキストの操作を再
開できます。コンテキストの操作を再開すると、コンテキスト内のすべてのルートが再開され、メッ
セージを処理できるようになります。

手順

ルーティングコンテキストの操作を再開するには、以下を実行します。

1. JMX Navigator ビューで、プロジェクトの Camel Contexts ノードを展開し、操作を再開する
ルーティングコンテキストを選択します。

2. 選択したコンテキストを右クリックしてコンテキストメニューを開き、Resume Camel
Context を選択します。

注記注記
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注記注記

コンテキストメニューに Suspend Camel Context が表示される場合、コンテキ
ストとそのルートは実行されています。

関連トピック

「ルーティングコンテキストの一時停止操作」
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パート IV. コンテナーへのアプリケーションの公開
Fuse Integration プロジェクトをサーバーコンテナーに公開するには、最初にサーバーとそのランタイ
ム定義をツールの Server リストに追加する必要があります。その後、プロジェクトをサーバーランタ
イムに割り当て、その公開オプションを設定できます。
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第28章 サーバーの管理
Servers ビューを使用すると、Red Hat CodeReady Studio 環境でサーバーを実行および管理できま
す。

注記注記

Camel プロジェクトを Red Hat Fuse に公開するための詳細な手順については、29
章Fuse Integration プロジェクトのサーバーへの公開 を参照してください。

28.1. サーバーの追加

概要

ツールを使用してサーバーを管理するには、サーバーを Servers リストに追加する必要があります。追
加すると、サーバーは Servers ビューに表示されます。ここから、サーバーに接続して Fuse
Integration プロジェクトを公開できます。

注記注記

Red Hat Fuse サーバーを追加する場合は、その installDir/etc/users.properties ファイ
ルを編集し、user=password,role の形式でユーザー情報を追加して、ツールがサーバー
への SSH 接続を確立できるようにすることが推奨されます。

手順

新しいサーバーを Servers ビューに追加する方法は 3 つあります。

Servers ビューで No servers are available. Click this link to create a new server… をクリッ
クします。

注記注記

このリンクは、サーバーが定義されていない場合にのみ Servers ビューに表示さ
れます。プロジェクトを最初に作成したときにサーバーを定義して追加した場合
は、Servers ビューにそのサーバーが表示されます。

Servers ビューで右クリックしてコンテキストメニューを開き、New → Server の順に選択しま
す。

メニューバーで File → New → Other → Server → Server の順に選択します。

Define a New Server ダイアログボックスで、新しいサーバーを追加します。

1. Red Hat JBoss Middleware ノードを展開して、使用可能なサーバーオプション一覧を公開し
ます。
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2. 追加するサーバーをクリックします。

3. Server's host name フィールドで、デフォルト (localhost) を受け入れます。

注記注記

localhost のアドレスは 0.0.0.0 です。

4. Server name フィールドで、デフォルトを使用するか、ランタイムサーバーの別の名前を入力
します。

5. Server runtime environment で、デフォルトを使用するか、Add をクリックしてサーバーのラ
ンタイム定義ページを開きます。
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注記注記

サーバーがマシンにインストールされていない場合は、Download and install
runtime をクリックしサイトのダウンロード手順に従って、ここでサーバーをイ
ンストールできます。サイトによっては、ダウンロードプロセスを続行する前
に、有効なクレデンシャルの提供が必要なこともあります。

6. インストール Name のデフォルトを使用します。

7. Home Directory フィールドに、サーバーランタイムがインストールされているパスを入力す
るか、Browse をクリックして検索し、選択します。

8. Execution Environment の横にあるドロップダウンメニューからランタイム JRE を選択しま
す。
一覧に目的のバージョンが表示されない場合は、Environments をクリックして、表示される
一覧からバージョンを選択します。選択した JRE バージョンがマシンにインストールされてい
る必要があります。

注記注記

必要な Java バージョンについては、Red Hat Fuse Supported Configurations  を
参照してください。

9. Alternate JRE オプションはそのままにしておきます。

10. Next をクリックしてサーバーのランタイム定義を保存し、その Configuration details ページ
を開きます。
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11. SSH Port のデフォルト (8101) を受け入れます。
ランタイムは SSH ポートを使用して、サーバーの Karaf シェルに接続します。このデフォルト
がご自分のセットアップに対して正しくない場合は、サーバーの
installDir/etc/org.apache.karaf.shell.cfg ファイルを確認して正しいポート番号を検出できま
す。

12. User Name フィールドに、サーバーへのログインに使用する名前を入力します。
Red Hat Fuse では、これは Red Hat Fuse の installDir/etc/users.properties ファイルに保存さ
れているユーザー名です。

注記注記

/etc/users.properties ファイルのデフォルトのユーザーがアクティベートされて
いる場合 (アンコメント)、[servCnfigDetails] に記載のとおり、ツールは User
Name および Password フィールドにデフォルトユーザーの名前およびパスワー
ドを自動入力します。

ユーザーが設定されていない場合は、user=password,role のフォーマットを使用してその
ファイルにユーザーを追加するか (例: joe=secret,Administrator)、karaf jaas コマンドセット
を使用して設定できます。

jaas:realms: レルムを一覧表示します。

jaas:manage --index 1: 最初の (サーバー) レルムを編集します。

jaas:useradd <username> <password>: ユーザーと関連するパスワードを追加します。

jaas:roleadd <username> Administrator: 新規ユーザーのロールを指定します。

jaas:update: 新しいユーザー情報を使用してレルムを更新します。

サーバーに対して jaas レルムがすでに選択されている場合は、コマンド 
JBossFuse:karaf@root>jaas:users を実行してユーザー名を検出できます。

13. Password フィールドには、サーバーにログインする際に User name で必要なパスワードを入
力します。
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14. Finish をクリックしてサーバー設定の詳細を保存します。
サーバーランタイムが Servers ビューに表示されます。

サーバーノードを展開すると、サーバーの JMX ノードが公開されます。

28.2. サーバーの起動

概要

設定済みサーバーを起動すると、ツールはサーバーのリモート管理コンソールを Terminal ビューで開
きます。これにより、アプリケーションのテスト中にコンテナーを簡単に管理できます。

手順

サーバーを起動するには、以下を実行します。

1. Servers ビューで、起動するサーバーを選択します。

2.  をクリックします。

Console ビューが開き、コンテナーの起動中は待機するように求めるメッセージが表示さ
れます。以下はその例です。

注記注記

リモートコンソールを開くためのユーザー名とパスワードを適切に設定しな
かった場合は、ダイアログボックスが開き、適切な認証情報の入力が求めら
れます。「サーバーの追加」を参照してください。

コンテナーが起動すると、Terminal ビューが開き、コンテナーの管理コンソールが表示さ
れます。

稼働中のサーバーが Servers ビューに表示されます。

稼働中のサーバーは、Server Connections の JMX Navigator ビューにも表示されます。
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注記注記

サーバーがツールと同じマシン上で稼働している場合、そのサーバーは
Local Processes の下にもエントリーがあります。

28.3. 稼働中のサーバーへの接続

概要

設定済みのサーバーを起動すると、Servers ビューと、Server Connections ノードの JMX Navigator
ビューに表示されます。サーバーを表示するには、Server Connections ノードを展開する必要がある
場合があります。

稼働中のサーバーで Fuse プロジェクトアプリケーションを公開およびテストするには、まず接続する
必要があります。Servers ビューまたは JMX Navigator ビューのいずれかで、稼働中のサーバーに接
続できます。

注記注記

Servers ビューと JMX Navigator ビューは、サーバー接続に関して同期されます。つま
り、Servers ビューのサーバーに接続すると、JMX Navigator ビューでもサーバーに接
続され、その逆も同様に接続されます。

Servers ビューで稼働中のサーバーへの接続

1. Servers ビューで、サーバーランタイムを展開して JMX[Disconnected] ノードを公開しま
す。

2. JMX[Disconnected] ノードをダブルクリックします。

JMX Navigator ビューで稼働中のサーバーへの接続

1. Server Connections ノードの JMX Navigator ビューで、接続するサーバーを選択します。
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2. 選択したサーバーをダブルクリックします。

接続されたサーバーにインストールされているバンドルの表示

1. Servers ビューまたは JMX Navigator ビューで、サーバーランタイムツリーを展開して
Bundles ノードを公開し、これを選択します。

2. このツールは、Properties ビューに、サーバーにインストールされているバンドルの一覧を表
示します。

Properties ビューの Search ツールを使用し、わかっている場合は Symbolic Name または
Identifier でバンドルを検索できます。記号名または識別子を入力すると一覧が更新され、現在
の検索文字列に一致するバンドルのみが表示されます。

注記注記

または、Terminal ビューで osgi:list コマンドを実行し、Red Hat Fuse サーバー
ランタイムにインストールされているバンドルに関する生成されたリストを表示
することもできます。ツールは、osgi:list コマンドが表示する OSGi バンドルに
異なる命名スキームを使用します。

プロジェクトの pom.xml ファイルの <build> セクションで、バンドルのシンボ
リック名およびそのバンドル名 (OSGi) が maven-bundle-plugin エントリーに
一覧表示されます。詳細については 「プロジェクトのサーバーへの公開を確
認」 を参照してください。
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28.4. サーバーからの接続解除

概要

アプリケーションのテストが終了したら、サーバーを停止せずに接続を解除できます。

注記注記

Servers ビューと JMX Navigator ビューは、サーバー接続に関して同期されます。つま
り、Servers ビューのサーバーからの接続を解除すると、JMX Navigator ビューでも接
続解除されます。また、その逆も同様です。

Servers ビューのサーバーからの接続解除

1. Servers ビューで、サーバーランタイムを展開して JMX[Connected] ノードを公開します。

2. JMX[Connected] ノードを右クリックしてコンテキストメニューを開き、Disconnect を選択
します。

JMX Navigator ビューのサーバーからの接続解除

1. JMX Navigator ビューの Server Connections で、接続を解除するサーバーを選択します。

2. 選択したサーバーを右クリックしてコンテキストメニューを開き、Disconnect を選択します。

28.5. サーバーの停止

概要
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Servers ビュー、または Terminal ビューのサーバーのリモートコンソールで、サーバーをシャットダ
ウンできます。

Servers ビューの使用

サーバーを停止するには、以下を実行します。

1. Servers ビューで、停止するサーバーを選択します。

2.  をクリックします。

リモートコンソールの使用

サーバーを停止するには、以下を実行します。

1. サーバーのリモートコンソールをホストしている Terminal ビューを開きます。

2. Ctrl+D を押します。

28.6. サーバーの削除

概要

設定済みサーバーの処理が終了した場合、またはサーバーを誤って設定した場合は、サーバーとその設
定を削除できます。

まず、Servers ビューまたは JMX Navigator ビューからサーバーを削除します。次に、サーバー設定
を削除します。

サーバーの削除

1. Servers ビューで、削除するサーバーを右クリックしてコンテキストメニューを開きます。

2. Delete を選択します。

3. OK をクリックします。

サーバーの設定の削除

1. メニューバーで、CodeReady Studio → Preferences → Server の順に選択します。

注記注記

Linux および Windows マシンでは、Window → Preferences の順に選択しま
す。

2. Server フォルダーを展開し、Runtime Environments を選択して Server Runtime
Environments ページを開きます。

3. 一覧で、Servers ビューから以前に削除したサーバーのランタイム環境を選択し、Remove を
クリックします。

4. OK をクリックします。
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第29章 FUSE INTEGRATION プロジェクトのサーバーへの公開
Eclipse 公開メカニズムを使用して、Fuse Integration プロジェクトをサーバーランタイムにデプロイし
ます。これを行うには、サーバーを Fuse Integration パースペクティブの Servers ビューに定義およ
び追加する必要があります。詳しい手順を示すデモについては、以下を参照してください。

概要

サポート対象サーバーを、割り当てられた Fuse プロジェクトを自動的に公開するか、publish コマンド
を手動で呼び出した場合にのみ公開するように設定できます。

Servers ビューに追加された各サーバーランタイムには、その設定、接続、および公開の詳細が含まれ
る独自の Overview ページがあります。

Publishing を展開して、サーバーランタイムの公開オプションとデフォルト設定を公開する必要がある
場合があります。

Never publish automatically  — プロジェクトを手動で公開する場合は、このオプションを選択
する必要があります。

重要重要

また、サーバーの Add and Remove ページで、If server started, publish
changes immediately オプションを無効にする必要があります (詳細については
「Fuse プロジェクトの手動公開」 を参照)。

Automatically publish when resources change  —  [default] Fuse プロジェクトへの変更を保存
するときに、その Fuse プロジェクトを自動的に公開または再公開する場合は、このオプション
を有効にします。プロジェクトの公開速度は、Publishing interval (デフォルトは 15 秒) によっ
て異なります。

Automatically publish after a build event — Fuse プロジェクトの場合、Automatically publish
when resources change と同じように機能します。

リソース変更時に FUSE プロジェクトを自動公開
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サーバーランタイムのデフォルトの公開オプションは、Automatically publish when resources change
です。

1. 必要に応じて、Fuse プロジェクトを公開するサーバーランタイムを起動します。詳細
は、「サーバーの起動」 を参照してください。

2. Servers ビューで、サーバーランタイムをダブルクリックして Overview ページを開きます。

3. Publishing を展開し、Automatically publish when resources change を選択します。

4. 公開サイクルの間隔を増減するには、必要に応じて Publishing interval (in seconds) の横にあ
るラジオボタンをクリックします。

5. Servers ビューでサーバーランタイムを右クリックし、コンテキストメニューを開き、Add
and Remove を選択します。

公開に使用できるすべてのリソースが Available 列に表示されます。

6. リソース (この場合は CBRroute Fuse プロジェクト) をサーバーランタイムに割り当てるに
は、以下を実施します。

ダブルクリックします。または
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これを選択して Add をクリックします。
選択したリソースは Configured 列に移動します。

この段階で、割り当てられたリソースが実際に公開される時間は、サーバーランタイムが
実行されているかどうか、および Publishing interval の設定によって異なります。ただ
し、サーバーが停止している場合は、サーバー起動後にプロジェクトを手動で公開する必
要があります (詳細については、「Fuse プロジェクトの手動公開」 を参照してください)。

7. If server started, publish changes immediately オプションをクリックして有効にします。
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このオプションを使用すると、Finish をクリックすることで設定したプロジェクトが即座に公
開されます。サーバーランタイムの Overview 要要 ページの Automatically publish when
resources change オプションを使用すると、ローカルプロジェクトに加えられた変更が保存さ
れるたびに設定済みのプロジェクトが再公開されます。

8. Finish をクリックします。
プロジェクトが Servers ビューのサーバーランタイムノードに表示され、サーバーランタイム
のステータスが [Started,Publishing…] と報告されます。

公開が完了すると、サーバーランタイムとプロジェクトのステータスは
[Started,Synchronized] と報告されます。
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注記注記

サーバーランタイムの場合、synchronized は、サーバーのすべての公開済みリ
ソースが、ローカルの対応する公開済みリソースと同じであることを意味しま
す。公開済みリソースの場合、Synchronized は、ローカルの対応するリソース
と同じであることを意味します。

FUSE プロジェクトの手動公開

1. 必要に応じて、Fuse プロジェクトを公開するサーバーランタイムを起動します。詳細
は、「サーバーの起動」 を参照してください。

2. Servers ビューで、サーバーランタイムをダブルクリックして Overview ページを開きます。

3. Publishing を展開し、Never publish automatically を選択します。

4. File → Save をクリックして、公開オプションの変更を保存します。

5. Fuse プロジェクトがすでにサーバーランタイムに割り当てられている場合は、If server
started, publish changes immediately のオプションが無効であることを確認します。

a. Servers ビューで、サーバーランタイムを右クリックしてコンテキストメニューを開きま
す。

b. Add and Remove… をクリックしてサーバーの Add およびおよび Remove ページを開きます。

c. If server started, publish changes immediately オプションが有効になっている場合は無効
にします。

d. [finish] に進みます。

6. Fuse プロジェクトがサーバーランタイムに割り当てられていない場合は、ここで割り当てま
す。

a. 「リソース変更時に Fuse プロジェクトを自動公開」  の [startAssignResource] から
[stopAssignResource] に従います。

b. If server started, publish changes immediately オプションは有効にしないでください。

7. Finish をクリックします。
プロジェクトが Servers ビューのサーバーランタイムノードに表示され、サーバーランタイム
のステータスが [Started] と報告されます。

8. Servers ビューで、プロジェクトのノードを右クリックします。この例では、CBRroute Fuse
プロジェクトを選択してコンテキストメニューを開きます。
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9. Full Publish を選択します。
公開操作中に、サーバーランタイムとプロジェクトのステータスは [Started,Republish] と報
告されます。

公開が完了すると、サーバーランタイムとプロジェクトの両方のステータスが
[Started,Synchronized] と報告されます。

注記注記

このツールは Incremental Publish オプションをサポートしませ
ん。Incremental Publish をクリックすると、完全公開になります。

プロジェクトのサーバーへの公開を確認

Fuse プロジェクトをサーバーランタイムに公開した後、サーバーに接続し、プロジェクトのバンドル
がインストールされていることを確認できます。

1. サーバーランタイムに接続します。詳細は、「Servers ビューで稼働中のサーバーへの接続」
を参照してください。

2. Servers ビューで、サーバーランタイムツリーを展開して Bundles ノードを公開し、これを選
択します。
このツールは、Properties ビューに、サーバーにインストールされているバンドルの一覧を表
示します。
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3. プロジェクトのバンドルを検索するには、リストの下部までスクロールするか、Properties
ビューの Search ボックスにバンドルの Symbolic Name を入力します。バンドルの Symbolic
Name は、作成時にプロジェクトに付与した名前です。

注記注記

または、Terminal ビューで osgi:list コマンドを実行し、Fuse サーバーランタ
イムにインストールされているバンドルに関する生成されたリストを表示するこ
ともできます。ツールは、osgi:list コマンドが表示する OSGi バンドルに異なる
命名スキームを使用します。

プロジェクトの pom.xml ファイルの <build> セクションで、バンドルのシンボ
リック名およびそのバンドル名 (OSGi) が maven-bundle-plugin エントリーに
一覧表示されます。以下に例を示します。
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付録A FUSE INTEGRATION パースペクティブ
Fuse Integration パースペクティブを使用して、インテグレーションアプリケーションの設計、監視、
テスト、および公開を行います。

以下の方法で Fuse Integration パースペクティブを開くことができます。

新しい Fuse Integration プロジェクトを作成する場合 (1章新しい Fuse Integration プロジェクト
の作成 を参照)、ツールは Fuse Integration パースペクティブに切り替わります。

CodeReady Studio ツールバーの右側にある  をクリックします。ツールバーで  アイコ

ンが利用できない場合は、  をクリックし、利用可能なパースペクティブの一覧から Fuse
Integration を選択します。

Window → Perspective → Open Perspective → Fuse Integration の順に選択します。

Fuse Integration パースペクティブは、9 つのメインエリアで設定されます。

Project Explorer ビュー
ツールが認識するすべてのプロジェクトを表示します。各プロジェクトを設定するすべての
アーティファクトを表示できます。Project Explorer ビューでは、Camel Contexts ノードに
プロジェクトのすべてのルーティングコンテキストの .xml ファイルも表示されます。これによ
り、プロジェクトに含まれるルーティングコンテキストファイルを見つけて開くことができま
す。Project Explorer ビューの各ルーティングコンテキストの .xml ファイルに、コンテキスト
内で定義されたすべてのルートが表示されます。マルチルートコンテキストの場合、キャンバ
スで特定のルートにフォーカスできます。
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ルートエディター
主な設計時ツールを提供し、以下の 3 つのタブで設定されます。

Design: ルートを構築する大きなグリッドエリアと、エンタープライズ統合パターン (EIP)
および Camel コンポーネントを選択してキャンバスに接続し、ルートを形成するためのパ
レットが表示されます。

キャンバスは、ルートエディターのワークベンチであり、多くの作業を行う場所です。接
続された EIP および Camel コンポーネント (キャンバスに配置されるとノードと呼ばれま
す) で設定される 1 つ以上のルートがグラフィカル表示されます。

キャンバスでノードを選択すると、Properties ビューに選択したノードに適用されるプロ
パティーが表示され、それを編集できるようになります。
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Palette には、ルートを構築するために必要なすべてのパターンと Camel コンポーネント
が含まれており、それらは機能 (Components、Routing、Control
Flow、Transformation、Miscellaneous) に基づきグループ化されます。

ソースソース
ルートエディターのキャンバスに構築されたルートの .xml ファイルの内容を表示します。

Design タブと Source タブで、ルーティングコンテキストを編集できます。Source タブ
は、設定、コメント、または Bean を編集したり、ルーティングコンテキストファイルに追
加したりする場合に便利です。コンテンツアシスト機能は、設定ファイルの使用に役立ち
ます。Source タブで Ctrl+Space を押すと、プロジェクトに挿入できる値の一覧が表示さ
れます。

設定設定
共有設定 (グローバルエンドポイント、データ形式、Bean) を簡単にマルチルートルーティ
ングコンテキストに追加する方法を提供します。詳細は、「グローバルエンドポイント、
データ形式、Bean の追加」 を参照してください。
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REST
Rest DSL コンポーネントのグラフィック表現を提供します。
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Properties ビュー
キャンバスで選択したノードのプロパティーが表示されます。

JMX Navigator ビュー
JMX サーバーと監視するインフラストラクチャーの一覧が表示されます。これにより、JMX
サーバーとそれらが監視しているプロセスを参照できます。また、Red Hat プロセスのインス
タンスも特定できます。

JMX Navigator ビューは、Fuse Integration パースペクティブのすべての監視およびテストア
クティビティーを促進します。Diagram View、Properties ビュー、および Messages View に
表示されるルートを決定します。ルートトレースの有効化、JMS 宛先の追加および削除、ルー
トの開始および一時停止を行うメニューコマンドも提供します。また、メッセージをルートに
ドラッグアンドドロップするためのターゲットでもあります。

デフォルトでは、JMX Navigator ビューには、ローカルマシンで実行しているすべての Java
プロセスが表示されます。必要に応じて JMX サーバーを追加して、他のマシンのインフラスト
ラクチャーを表示できます。

Diagram View
JMX Navigator ビューで選択したノードを表すグラフィカルツリーが表示されます。プロセ
ス、サーバー、エンドポイント、または他のノードを選択すると、Diagram View には、選択
したノードがルートとして表示され、その子と孫に分岐します。

ブローカーを選択すると、Diagram View には接続、トピック、およびキューの最大 3 つの子
が表示されます。また、設定された接続と宛先が孫として表示されます。

ルートを選択すると、Diagram View にルート内のすべてのノードが表示され、メッセージが
ルートを通過できるさまざまなパスが表示されます。また、ルートトレースが有効になってい
る場合、ルートの各処理ステップのタイミングメトリクスも表示されます。

Messages View

ルートトレースが有効になっている場合に、選択した JMS 宛先または Apache Camel エンドポ
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ルートトレースが有効になっている場合に、選択した JMS 宛先または Apache Camel エンドポ
イントを通過したメッセージが一覧表示されます。

JMX Navigator ビューで JMS 宛先を選択すると、ビューにはその宛先にあるすべてのメッ
セージが一覧表示されます。

ルートトレースを有効にすると、Messages View にはトレース開始後にルートのノードを通過
したすべてのメッセージが一覧表示されます。Messages View を設定して、対象のデータのみ
を好みの順序で表示できます。

Messages View のメッセージトレースを選択すると、その詳細 (メッセージの本文とすべての
メッセージヘッダー) が Properties ビューに表示されます。Diagram View では、選択した
メッセージトレースに関連付けられたルートのステップが強調表示されます。

Servers ビュー
ツールが管理するサーバーの一覧が表示されます。ランタイムステータスが表示され、それら
の追加、開始、停止、およびそれらへのプロジェクトの公開を制御できます。

Terminal ビュー
接続されているコンテナーのコマンドコンソールが表示されます。Terminal ビューでコマンド
を入力してコンテナーを制御できます。

Console ビュー
最近実行したアクションのコンソール出力が表示されます。
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付録B DEBUG パースペクティブ
Debug パースペクティブを使用して、実行中の Camel コンテキストを監視し、デバッグします。

Debug ビュー
実行中の Camel コンテキストの場合、Debug ビューにデバッグスタックが表示されます。

Camel Context at service:jmx:rmi://jndi/rmi://localhost:1099/jmxrmi/camel エントリーの下
に一覧表示される同じメッセージフロー内のブレークポイントを切り替えて、Variables ビュー
内の変数の値を確認して比較できます。

メッセージフローは一意のブレッドクラム ID で識別され、後続の各メッセージフローのブレッ
ドクラム ID は 2 ずつ増えます。たとえば、最初のメッセージフローのブレッドクラム ID が ID-
janemurpheysmbp-home-54620-1470949590275-0-1 の場合、2 番目のメッセージフローのブ
レッドクラム ID は ID-janemurpheysmbp-home-54620-1470949590275-0-3 になります。

Variables ビュー
ブレークポイントが設定されているルーティングコンテキスト内の各ノードでは、ブレークポ
イントに到達すると Variables ビューに利用可能な変数の値が表示されます。前のブレークポ
イント以降に値が変更された各変数は、黄色で強調表示されます。

編集可能な変数の値を変更して、このような変更が想定される結果を生成するか確認して、
ルーティングコンテキストの堅牢性をテストすることができます。

ウォッチリストに変数を追加することもできるため、メッセージフローの想定されるポイント
でそれらの値が想定どおりに変化するかどうかをすばやく簡単に確認できます。

Breakpoints ビュー
ルーティングコンテキストに設定されたブレークポイントの一覧が、有効/無効を含めて表示さ
れます。個々のブレークポイントを有効化または無効化するには、それらのブレークポイント
のチェックをオン (有効化) またはオフ (disabling) にします。これにより、問題のある動作をす
るルーティングコンテキストのノードに一時的にフォーカスすることができます。
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 ボタンは無効化されたブレークポイントをスキップし、ルーティングコンテキスト内の次

のアクティブなブレークポイントに移動します。一方、  ボタンは、ブレークポイントに関
係なく、ルーティングコンテキスト内の次の実行ノードに移動します。

Camel Context.xml ビュー
実行中のルーティングコンテキストファイルをグラフィカルモードで表示します。ブレークポ
イントが設定されているノードの場合、設定されているブレークポイントのタイプと、ブレー
クポイントが有効か無効かが表示されます。ブレークポイントに到達すると、キャンバス上の
対応するノードが赤で囲まれます。

ノードの設定を確認するには、Properties ビューを開き、camel Context.xml のキャンバスの
ノードを選択します。

Console ビュー
Camel デバッガーがルーティングコンテキストを実行するときに生成されるログ出力を表示し
ます。

Properties ビュー
CamelContext.xml のキャンバスで選択したノードに設定されたプロパティーを表示します。

付録付録B DEBUG パースペクティブパースペクティブ

203


	目次
	はじめに
	パート I. アプリケーションの開発
	第1章 新しい FUSE INTEGRATION プロジェクトの作成
	概要
	作業を開始する前に
	プロジェクト名とワークスペースの指定
	プロジェクトデプロイメント環境の設定
	新しいターゲットランタイムの作成 (オプション)
	プロジェクトテンプレートの選択
	MAVEN 依存関係エラーの解決

	第2章 ルートエディターを使用したルーティングコンテキストの編集
	2.1. ルートへのパターンの追加
	手順
	レイアウト方向の変更
	関連トピック

	2.2. パターンの設定
	概要
	手順

	2.3. ルートからパターンを削除
	概要
	手順
	関連トピック

	2.4. ルーティングコンテキストへのルートの追加
	概要
	手順

	2.5. ルートの削除
	概要
	手順

	2.6. グローバルエンドポイント、データ形式、BEAN の追加
	概要
	グローバルエンドポイントの追加
	グローバルデータ形式の追加
	グローバル Bean の追加
	グローバル要素の削除
	グローバル要素の編集

	2.7. ルートエディターの設定
	概要
	手順


	第3章 REST DSL コンポーネントの表示と編集
	3.1. REST DSL コンポーネントのグラフィック表現の表示
	3.2. グラフィカルビューでの REST DSL コンポーネントの編集
	3.3. REST DSL ソースコードの表示と編集

	第4章 SOAP アプリケーションを RESTFUL WEB サービスに移行
	4.1. ウィザードのワークフロー
	4.2. 前提条件
	4.3. サンプル SOAP アプリケーションを RESTFUL WEB サービスに移行

	第5章 新しい APACHE CAMEL JUNIT テストケースの作成
	概要
	前提条件
	既存の JUNIT テストケースの削除
	SRC/TEST/JAVA フォルダーの作成およびビルドパスへの追加
	JUNIT テストケースの作成

	第6章 RED HAT FUSETOOLING 内でのルートの実行
	6.1. ローカル CAMEL コンテキストとしてルートを実行
	概要
	手順
	結果
	関連トピック

	6.2. MAVEN を使用したルートの実行
	概要
	手順
	結果
	関連トピック

	6.3. ランタイムプロファイルの操作
	6.3.1. ローカル Camel コンテキストランタイムプロファイルの編集
	概要
	Local Camel Context のランタイム設定エディターへのアクセス
	camel コンテキストファイルの設定
	コマンドラインオプションの変更
	出力の送信先の変更
	関連トピック

	6.3.2. Maven ランタイムプロファイルの編集
	概要
	Maven ランタイム設定エディターへのアクセス
	Maven ゴールの変更
	Maven バージョンの変更
	出力送信先の変更
	関連トピック



	第7章 FUSE ON OPENSHIFT の使用
	7.1. RED HAT CONTAINER DEVELOPMENT KIT サーバーの追加
	7.2. CONTAINER DEVELOPMENT ENVIRONMENT (CDE) および仮想 OPENSHIFT サーバーの起動
	7.3. 新しい OPENSHIFT プロジェクトの作成
	7.4. 新規 FUSE INTEGRATION プロジェクトの作成
	7.5. FUSE INTEGRATION プロジェクトの OPENSHIFT へのデプロイ
	7.6. OPENSHIFT WEB コンソールへのアクセス

	第8章 RED HAT FUSE SAP TOOL SUITE の使用
	8.1. RED HAT FUSE SAP TOOL SUITE のインストール
	概要
	SAP ツールのプラットフォーム制限
	前提条件
	手順

	8.2. SAP 宛先接続の作成とテスト
	概要
	手順

	8.3. SAP サーバー接続の作成とテスト
	概要
	手順

	8.4. 宛先接続およびサーバー接続の削除
	概要
	手順

	8.5. 新規 SAP エンドポイントの作成
	概要
	前提条件
	手順


	第9章 データ変換のスタートガイド
	9.1. データ変換サンプルプロジェクトの作成
	9.2. CAMEL ルートへのデータ変換ノードの追加
	9.3. ソースデータ項目をターゲットデータ項目にマッピング
	9.4. 変換テストファイルの作成と JUNIT テストの実行
	9.5. 定数変数のデータ項目へのマッピング
	9.6. 式のデータ項目へのマッピング
	9.7. マップされたデータ項目へのカスタム変換の追加
	9.8. 単純なデータ項目をコレクションのデータ項目にマッピング
	9.9. マップされたデータ項目へのビルトイン関数の追加
	9.10. データ変換を使用して FUSE INTEGRATION プロジェクトを RED HAT FUSE サーバーに公開

	第10章 FUSE ONLINE インテグレーション用エクステンションの開発
	10.1. タスクの概要
	10.2. 前提条件
	10.3. カスタムコネクターの作成
	10.3.1. カスタムコネクターの Fuse Online Extension プロジェクトの作成
	10.3.2. カスタムコネクターのコードの記述

	10.4. カスタムステップの作成
	10.4.1. カスタムステップの Fuse Online Extension プロジェクトの作成
	10.4.2. カスタムステップのコードの記述

	10.5. FUSE ONLINE エクステンション JAR ファイルのビルド
	10.6. JAR ファイルを FUSE ONLINE ユーザーに提供

	第11章 新規 CAMEL XML ファイルの作成
	概要
	手順

	第12章 CAMEL バージョンの変更
	第13章 既存 MAVEN プロジェクトのインポート
	概要
	手順

	パート II. ルーティングコンテキストのデバッグ
	第14章 ブレークポイントの設定
	概要
	無条件ブレークポイントの設定
	条件付きブレークポイントの設定
	ブレークポイントの無効化
	ブレークポイントの削除
	関連トピック

	第15章 CAMEL デバッガーの実行
	15.1. ローカルで実行中のルーティングコンテキストのデバッグ
	手順
	ルーティングコンテキストを介したメッセージエクスチェンジの進捗監視

	15.2. リモートで実行中のルーティングコンテキストのデバッグ
	前提条件
	リモートデバッグのセットアップと起動
	手順

	関連トピック

	第16章 CAMEL デバッガーの停止
	概要
	CAMEL デバッガーを閉じる
	関連トピック

	第17章 変数値の変更
	概要
	手順
	関連トピック

	第18章 ウォッチリストへの変数の追加
	概要
	手順
	関連トピック

	第19章 実行中のコンテキストでのブレークポイントの無効化
	概要
	ブレークポイントビューでのブレークポイントの無効化と有効化

	パート III. アプリケーションの監視とテスト
	第20章 JMX ナビゲーター
	20.1. JMX でのプロセスの表示
	概要
	ローカル JMX サーバーでのプロセスの表示
	代替 JMX サーバーでのプロセスの表示

	20.2. JMX サーバーの追加
	概要
	手順


	第21章 コンポーネントの JMX 統計情報の表示
	概要
	手順

	第22章 メッセージの参照
	概要
	手順
	関連トピック

	第23章 ルートのトレース
	23.1. ルートトレース用テストメッセージの作成
	概要
	テストメッセージを格納する新規フォルダーの作成
	テストメッセージの作成
	関連トピック

	23.2. ルートトレースの有効化
	概要
	手順
	関連トピック

	23.3. ルーティングコンテキストを介したメッセージのトレース
	概要
	手順
	関連トピック

	23.4. ルートトレースの無効化
	概要
	手順
	関連トピック


	第24章 JMS 宛先の管理
	24.1. JMS 宛先の追加
	概要
	手順
	関連トピック

	24.2. JMS 宛先の削除
	概要
	手順
	関連トピック


	第25章 ルーティングエンドポイントの管理
	25.1. ルーティングエンドポイントの追加
	概要
	手順
	関連トピック

	25.2. ルーティングエンドポイントの削除
	概要
	手順
	関連トピック


	第26章 実行中のルートの編集
	概要
	実行中のルートの変更および結果の評価
	ルート編集セッションの終了
	関連トピック

	第27章 ルーティングコンテキストの管理
	27.1. ルーティングコンテキストの一時停止操作
	概要
	手順
	関連トピック

	27.2. ルーティングコンテキストの再開操作
	概要
	手順
	関連トピック


	パート IV. コンテナーへのアプリケーションの公開
	第28章 サーバーの管理
	28.1. サーバーの追加
	概要
	手順

	28.2. サーバーの起動
	概要
	手順

	28.3. 稼働中のサーバーへの接続
	概要
	Servers ビューで稼働中のサーバーへの接続
	JMX Navigator ビューで稼働中のサーバーへの接続
	接続されたサーバーにインストールされているバンドルの表示

	28.4. サーバーからの接続解除
	概要
	Servers ビューのサーバーからの接続解除
	JMX Navigator ビューのサーバーからの接続解除

	28.5. サーバーの停止
	概要
	Servers ビューの使用
	リモートコンソールの使用

	28.6. サーバーの削除
	概要
	サーバーの削除
	サーバーの設定の削除


	第29章 FUSE INTEGRATION プロジェクトのサーバーへの公開
	概要
	リソース変更時に FUSE プロジェクトを自動公開
	FUSE プロジェクトの手動公開
	プロジェクトのサーバーへの公開を確認

	付録A FUSE INTEGRATION パースペクティブ
	付録B DEBUG パースペクティブ

